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Using this Manual: Begin reading here! 
Don’t let this User Manual’s size intimidate you. It is not bad as it might first appear!  

Start out by reading these very short sections. They will save time and confusion when first using LandStar: 

Operating System Optimizations    13 

Keyboard tricks      13 

Entering distances      14 

Entering Azimuths/Bearings     14 

 

General System and program settings like display formats, units, significant decimal places, GNSS survey and stakeout 
default settings: 
 LandStar 8 System settings     19 

 

While the Tool tray icons meanings are not obvious, they are important for many survey functions like offset staking and 
hidden point measurements: 
 Tool tray        43 

 

Next read the task oriented How To Quick Guides in the back: 

How to: Install, Update and Provision LandStar   223 

How to: Moving data to the data collector   227 

How to: GNSS Network Rover Internal Cell Modem  229 

How To: GNSS Network Rover PDA Modem   234 

How to: GNSS Internal UHF Base    238 

How to: GNSS Internal UHF Rover    242 

 

Detailed references for the four Main menu tabs are color coded: 

Project        63 

Survey        95 

Config        167 

Tools        183 

 

These functions are often needed, but hard to find: 

Plot Deed enter a metes-and-bounds survey description convert to points and lines: 
 Details: Tools (tab): Plot Deed    201 

CORS and Base shift functions adjust autonomously surveyed points to an OPUS solution: 
 Details: Survey (tab): Base shift and CORS shift  151 

Backup everything (settings, profiles, projects, geoids) to a single file, transfer to new device: 
 Deployment backup and restore    20 

  



 4  LandStar 8 User Manual 

Table of Contents 
 

Copyright ...........................................................................2 

Acknowledgements ...........................................................2 

Using this Manual: Begin reading here! .............................3 

Table of Contents ..............................................................4 

Installing and Activating LandStar8 ....................................6 

Downloading and Deployment .......................................... 6 
LandStar 8 Licensing ........................................................... 7 
Activating a Permanent Registration code ...................... 9 
Self Service demo activation ............................................ 9 
Transferring a registration code license to another 
device ............................................................................... 10 

Operating System Optimizations ..................................... 13 
Keyboard tricks ................................................................. 13 
3-button navigation ........................................................ 14 

Entering distances ............................................................ 14 
Entering Azimuths/Bearings ............................................. 14 
Direction from Existing Points ........................................ 15 

Entering / Viewing Geographic and Projected 
Coordinates ....................................................................... 15 
LandStar 8 Program folders ............................................. 19 

LandStar 8 System settings ............................................. 19 

Side-bar details ................................................................. 19 
Deployment backup and restore ..................................... 20 
Interface style ................................................................... 22 
Audio prompt .................................................................... 22 
Warn if Base changes ....................................................... 23 
My cloud disk .................................................................... 23 
Collaborative functions in LandStar 8 ............................ 23 

Collaborative work Group using CHC Cloud .................... 25 
Upload position to CHC Cloud ......................................... 25 
Localization packages ....................................................... 25 
Record track ...................................................................... 26 
Video Help, show video help button ............................... 27 
Feedback ........................................................................... 27 
Remote support ................................................................ 27 
Activate software / About ................................................ 27 
Software settings .............................................................. 28 
Keyboard shortcut ........................................................... 28 
Share method .................................................................. 28 
Auto Ok ............................................................................ 28 
Units ................................................................................. 29 
Decimals .......................................................................... 32 
Coordinates ..................................................................... 32 
GNSS settings .................................................................. 33 

Survey (tab of GNSS settings)........................................... 34 
Topographic point survey settings ................................. 34 
Continuous survey settings............................................. 37 
Control point survey settings ......................................... 37 
Common GNSS Survey settings ...................................... 38 

Stakeout (tab of GNSS settings) ....................................... 39 
Display settings ................................................................. 41 
CAD settings .................................................................... 42 

Tool tray .......................................................................... 43 

Add text to map ............................................................... 43 
Attributes ......................................................................... 43 
CAD view .......................................................................... 43 
Center GPS position ........................................................ 43 
Delete ............................................................................... 43 
Delete last point .............................................................. 43 
Edit last point ................................................................... 44 
Enter a point (to stakeout) .............................................. 44 
Point stakeout ................................................................. 44 
Line stakeout ................................................................... 44 
Roading Stakeout ............................................................ 44 
Quick access..................................................................... 45 
Explode Block ................................................................... 45 
Export DXF ....................................................................... 45 
Export Surface staked report .......................................... 45 
Follow (rotate) ................................................................. 45 
Full view ........................................................................... 45 
Import DXF ....................................................................... 45 
Invert line direction ......................................................... 45 
Layers ............................................................................... 45 
Nodes list ......................................................................... 45 
Online map ...................................................................... 46 
Region list ........................................................................ 46 
Snap.................................................................................. 46 
Offset stakeout ................................................................ 46 
Offset survey (hidden point survey) ............................... 46 
Open road (project) file .................................................. 47 
Pan to (center map at) .................................................... 47 
Panel (surface stakeout) ................................................. 47 
Point list ........................................................................... 47 
Point Survey ..................................................................... 47 
Redraw ............................................................................. 48 
Regions ............................................................................. 48 
Reverse line ..................................................................... 48 
Save object....................................................................... 48 
Survey boundary ............................................................. 48 
Zoom In ............................................................................ 48 
Zoom Out ......................................................................... 48 

IMU settings and status .................................................... 48 

Work layers, Map files, Online map ................................ 49 

Instrument Select & Status information ......................... 49 

Instrument select .............................................................. 49 
Instrument status.............................................................. 49 
Instrument information .................................................. 50 
Sky Plot and Satellites information ................................. 50 
Quality .............................................................................. 51 
GNSS Base information ................................................... 51 

Main menus and program functions ............................... 52 

Project (tab) ...................................................................... 53 
Survey (tab) ....................................................................... 55 
Config (tab) ........................................................................ 58 



LandStar 8 User Manual 5  

Tools (tab) ......................................................................... 59 

Function Details ............................................................... 63 

Details: Project (tab) > Projects ....................................... 63 
Sharing Projects ............................................................... 63 
Project backups ............................................................... 64 

Details: Project (tab) > Coordinate system...................... 64 
Coordinate system utilities ............................................. 67 

Details: Project (tab) > Singe point localization .............. 68 
Details: Project (tab) > Point list ...................................... 70 
3-dot button .................................................................... 73 
Switch list style ................................................................ 77 
Point properties and attributes ...................................... 77 

Details: Project (tab) > Point list > Points to stake (tab) . 78 
Details: Project (tab) > Codes ........................................... 80 
Edit or Delete an existing code ....................................... 81 
Create a New Code ......................................................... 81 
Code library functions ..................................................... 82 

Details: Project (tab) > Layers > Work layers, Map files, 
Online map ........................................................................ 82 
Work layers (tab) .............................................................. 83 
Map files (tab) ................................................................. 83 
Online map (tab) ............................................................. 84 

Details: Project (tab) > Import ......................................... 85 
Details: Project (tab) > Export .......................................... 86 
Details: Project (tab) > Surfaces ....................................... 90 
Details: Survey (tab) > Map Survey .................................. 95 
Back .................................................................................. 95 
Status ............................................................................... 95 
Point Names .................................................................... 95 
Antenna Height ............................................................... 96 
Point Code ....................................................................... 96 
Point / Line ....................................................................... 96 
Quick code panel ............................................................. 97 
Sharing CODES and Quick Code buttons assignments .. 97 
Survey mode .................................................................... 97 
Start measurement ......................................................... 98 
Information panel ........................................................... 98 
Offset survey (hidden point survey) ............................... 99 
Point survey: Distance + Azimuth ................................. 100 
Point survey: Alignment Offset ..................................... 101 
Point survey: Distance-Distance Intersection .............. 103 
Point Survey: Turned angle + distance (with skew) ..... 105 
Point survey: ΔX + ΔY + ΔZ ............................................ 107 

Details: Survey (tab) > Point (text) Survey ..................... 108 
Details: Survey (tab): Visual survey ................................ 108 
Details: Survey (tab): Control survey ............................. 113 
Control survey operation ............................................... 113 
Details: Survey (tab): Verified survey............................. 115 
Verified survey operation ............................................... 116 
Adding additional measurement groups to a Verified 
survey ............................................................................. 120 

Verified survey screen details ........................................ 121 
Back ................................................................................ 121 
Status ............................................................................. 121 
Point Names .................................................................. 121 
Antenna Height ............................................................. 121 
Point Code ..................................................................... 121 

Real-time plot ................................................................ 122 
Start / stop measurements ........................................... 122 
Information panel .......................................................... 122 

Details: Survey (tab): Point Stakeout ............................. 123 
Storing the results of the Stakeout ............................... 124 

Auto description for staked points ................................ 125 
Visual Stakeout ................................................................ 126 
Additional methods to begin staking out a point ........ 127 

Offset Staking a Point ..................................................... 130 
Details: Survey (tab): Line/Arc stakeout ........................ 131 
Line / arc stakeout settings ........................................... 134 
Station and Offset.......................................................... 134 
To line ............................................................................. 135 
Node ............................................................................... 136 

Details: Survey (tab): Surface stakeout .......................... 137 
Details: Survey (tab): Area survey .................................. 139 
Details: Survey (tab): CAD View ..................................... 142 
Details: Survey (tab): Site calibration ............................. 146 
Details: Survey (tab): Base shift and CORS shift ............ 151 
Base shift ........................................................................ 152 
Removing Base shift ...................................................... 154 

CORS shift ........................................................................ 154 
Details: Survey (tab): Sideslope stakeout ...................... 155 
Details: Survey (tab): Foundation stakeout ................... 157 
Details: Survey (tab): Continuous survey ....................... 160 
Details: Survey (tab) Cross-section survey ..................... 162 
Getting Started with Cross-section Surveying ............. 162 

Details: Config (tab): Instruments profile ...................... 167 
Details: Config (tab): Connect to instruments ............... 169 
Details: Config (tab): GNSS rover ................................... 171 
Details: Config (tab): GNSS base .................................... 174 
Base setup procedure ..................................................... 177 
Details: Config (tab): GNSS static observation recording
 ......................................................................................... 178 
Details: Config (tab): Instrument info ............................ 179 
Details: Config (tab): Activate instrument ..................... 179 
Details: Config (tab): Update .......................................... 180 
Details: Config (tab): Advanced ...................................... 180 
Details: Config (tab): NFC / Wi-Fi ................................... 182 
Details: Tools (tab): Map adjustment ............................ 183 
Details: Tools (tab): Volume computation ..................... 185 
Details: Tools (tab): Area computation .......................... 188 
Details: Tools (tab): Inverse ............................................ 190 
Details: Tools (tab): Angle conversion (DMS.s  D.ddd 
 GON) ........................................................................... 190 
Details: Tools (tab): Parameter calculation, 3 or 7- 
parameter ........................................................................ 191 
Details: Tools (tab): Point to line distance ..................... 193 
Details: Tools (tab): Offset distance ............................... 193 
Details: Tools (tab): Deflection ....................................... 195 
Details: Tools (tab): Rotation .......................................... 195 
Details: Tools (tab): Intersection .................................... 196 
Details: Tools (tab): Bisect angle .................................... 198 
Details: Tools (tab): Divide line ....................................... 199 
Details: Tools (tab): Point average ................................. 200 
Details: Tools (tab): Plot Deed ........................................ 201 
Plotting deed descriptions, a complicated example .... 204 

Details: Tools (tab): Transformation .............................. 210 



 6  LandStar 8 User Manual 

Align matching points ................................................... 211 
Manual Entry ................................................................. 213 

Details: Tools (tab): Area subdivision ............................ 216 
Details: Tools (tab): Calculator ....................................... 217 
Details: Tools (tab): Ruler ............................................... 218 

Building GIS Datasets in LandStar ................................. 219 

How to: Install, Update and Provision LandStar ............ 223 

Direct download from iGage.com ................................ 223 

How to: Moving data to the data collector ................... 227 

How to: GNSS Network Rover Internal Cell Modem ..... 229 

Retransmit correction data ........................................... 233 

How To: GNSS Network Rover PDA Modem ................. 234 

How to: GNSS Internal UHF Base .................................. 238 

Start from Point list or Previous position ..................... 241 

How to: GNSS Internal UHF Rover ................................ 242 

Installing and Activating LandStar8 
LandStar 8 is a 64-bit Android application. 

It should run on any Android device with Operating System Android version 7 or higher, however users may be 
disappointed with Android OS versions older than version 10.  

The LandStar application should automatically adjust to most screen sizes. 

For use with a visual receiver, like the CHC i89 and i93, verify Visual Survey operation prior to deployment with a new 
device or use dealer recommended hardware. Visual survey functions require 5 GHz Wi-Fi and are enhanced by high 
resolution displays and high-speed processors. 

Downloading and Deployment 
LandStar 8 is too large to distribute in Google Play.  

A distribution manager is used to distribute LandStar. The distribution manager will also update LandStar to the latest 
version.  

It is also possible to download the program APK from a trusted source. See [ Direct download from iGage.com 

] on Page 223 for an example. 

In Google Play, search for CHCNav. Look for the CHCNav Installation Manager: 

  

The publisher’s name will be ‘Shanghai Huace Navigation Technology Ltd.’ 
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Once the manager is installed, open the CHCNAV Installation Manager: 

  

Click on the LandStar  button and follow the onscreen instructions. 

If LandStar is already installed but a newer version is available, an update to the latest version will be suggested. 

Once the download and installation has completed, start LandStar. The desktop icon: 

  

Should be available on one of the device screens. If not, swipe up, find LandStar, click-and-hold then place a shortcut 
anywhere on the device desktop. 

When LandStar runs the first time, the following permissions may be requested: 

 Camera needed to read QR codes containing projection information. Required to take pictures to attach to 
points as media.  

 Files needed to store projects, import/export files. 

 Location needed to use the internal data controller GPS for position. 

 Music, audio needed to voice information during collection (Fixed, Float, Connection lost). 

 Nearby devices needed to connect to GNSS receivers by Bluetooth and Wi-Fi. 

 Notifications needed to notify when running in the background. 

 Phone the IMEI number of the cellular radio is used for device identification. 

 Photos, Videos needed to store and attach media to measurements. 

LandStar may not be able to run if any of the requested permissions are denied. 

When LandStar runs the first time, it will notify you that there are no localization files in use. Click on the appropriate 
package (in the USA select ‘United States’) to download and install one. The localization packages include projections 
and Geoids. 

LandStar 8 Licensing 
LandStar 8 will run in demo mode until it is activated. Most functions other than connection to a GNSS receiver or Total 
Station are available in the unlicensed Demo mode. It is possible to use an unlicensed demo copy to process Visual 
surveys and import and export work products. 
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30-day trial licenses are also available by self-service, see [ Self Service demo activation ] on Page 9 for step-by-step 
instructions. 

To permanently activate LandStar 8, buy a Registration Code (formally called a Precode) from an authorized dealer. The 
Registration Code can only be used on one device at a time. A Registration Code can only be deployed on a lifetime total 
of 5 devices; however, the code can be freely transferred between these 5 devices an unlimited number of times. The 
Deployment Backup and Restore tool [ Deployment backup and restore ] described on Page 20 makes transferring 
entire deployments by a single file possible. 

Click on the profile head  at the top-left corner to display the System settings panel. Drag the panel up and click on 
Activate software/About at the bottom of the left menu: 

  

Click on the Inactive link: 

  

If you have an existing account, click on Existing account at the screen bottom, you need only enter your email address 
there is no need to fill in details. 

If LandStar has not previously been registered, click on Activate by email, fill the requested information, then click on 
Register: 
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If registering a new account, after clicking on Register:  

  
Check your email, click on the link in the email to complete the account activation process. 

An email address is needed so that notices of license transfers can be sent when a license is released. Your Company 
name and Phone number are needed to aid in troubleshooting license transfer issues. 

Activating a Permanent Registration code 
After activating by email, enter the Registration Code (previously called PreCode): 

Click on the Apply button to the right of Permanent registration code: 

  

Then enter the Registration code: 

  

Click OK. If the code is not installed on another device, LandStar will be activated. 

Self Service demo activation 
LandStar8 Demos expire after 30-days. 

After activating by email, click the apply button to the right of Temporary code: 

  

LandStar will contact the server and bind a 30-day demo code for your device. 

Don’t neglect evaluating the demo as it is VERY difficult to extend a demo on a device and it is difficult to do multiple 
demos associated with the same email address. 
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Transferring a registration code license to another device 
A LandStar license can only be activated on one device at a time. A purchased license can be transferred to a total of 5 
(five) devices over the registration code’s lifetime. Please be careful when using transfers to not needlessly waste them, 
only five are possible.  

Consider using a demo code to evaluate new devices. 

IMPORTANT 

Before transferring LandStar to a new device, consider backing up EVERYTHING to a single Deployment backup 
file. These Deployment backups include all settings, instrument profiles, existing jobs. 
See [ Deployment backup and restore ] on Page 20. 

To transfer a license to a new device, on the device that currently holds the license, verify that it has internet 
connectivity, then go to the side menu by sliding the menus all the way to the right: 

  

Click on Activate software/About 
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Click on Activated. The license dialog is shown: 

  

Click on the Unbind license button, then wait.  

After a few seconds you will see Unbind successful. 

  

The license server will send an email with a copy of the Registration code, verifying that the license is available to move 
to another device. The Registration code can now be transferred to another device. 

If a device is destroyed or lost while a Registration code is bound to the device, get a picture of the damaged device 
showing the device’s serial number, and a copy of a police report if available. Then contact your dealer. You will need to 
fill out a certification that the device is lost, retired and will never be in service again. The factory will need the original 
Registration code and the email it was associated with. It may take a day or two for the license to be released.  
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Operating System Optimizations 
After installing LandStar, make the following operating system changes to prevent LandStar from freezing or losing 
permissions when running in the background, or after a few weeks of non-use. 

Click and hold on the program icon on the desktop, then click the  App info button: 

  

Under Permissions, disable Pause app activity if unused: 

  
This will prevent the operating system from automatically removing permissions and cached files if LandStar is not used 
regularly. The removal of some permissions may result in LandStar being unable to start. 

Under Mobile data & Wi-Fi enable background usage of mobile Background data and Unrestricted data usage: 

  

Under App battery usage change battery usage to Unrestricted. This allows LandStar to continue to communicate with 
receivers and devices when another application is opened or while using the phone: 

  

Keyboard tricks 
The Google keyboard GBoard is highly recommended for use with LandStar. GBoard can be downloaded and installed from 
the Google PlayStore if the device has GMS (Google Mobile Services). 
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When entering a field that is primarily numeric, a numeric keyboard like this may be shown: 

  

If you need to click a letter (like ‘m’ to switch a measurement to Meters), click on the space button: 

  

and the keyboard will expand to alphanumeric entry: 

  

Unit override is commonly required when the Project Horizontal distance units are set to Feet to enter a metric survey rod 
height like “2m”. 

3-button navigation 
Enabling soft buttons on the bottom of the screen: 

  

will help navigation through large entry forms as there will be a dedicated key to collapse the keyboard.  

Turn on the bottom navigation buttons from the Android setup by searching for 3-button navigation which is under System 
> Gestures > System navigation. 

Entering distances 
A project always has current Horizontal and Vertical distance unit settings. (Some USA states define Horizontal distance as 
US Survey Feet and Vertical distance as International Feet.) 

Override the current default units by appending a letter to a distance: 

 2642.54i   force International Feet 

 2642.54f   force US Survey Feet 

 2.06m   meters 

 20.14c   20 chains 14 links 

Distance can also be entered as the inverse horizontal distance between two points. For example: 

 1001,1002  the distance from point 1001 to 1002 

 1001,1002/4  ¼ the distance from point 1001 to 1002 

Entering Azimuths/Bearings 
In the USA, for both rectangular and metes-and-bounds surveys it is common to describe courses by Quadrant Bearing 
angle and distance.  

Because it is difficult to compute the reciprocal of azimuth angles in Deg-Min-Sec.sss, Quadrant Bearings are commonly 
used where the angle is described as the angle East or West of North or South. This has the benefit of just exchanging the 
N/S and E/W to describe a line ‘going the other way.’  
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The blue vector above describes a course: 

 336 5 36.11 degrees 423.542 feet  

In the United States this course is described as: 

 N 023:54:23.89 W 423.542 feet  

Reversing the direction is simple, just exchange the first direction N with S and the trailing W with E: 

 S 023:54:23.89 E 423.542 feet  

Note: most users specify bearings to the nearest arc-second; however, when working with long distances or many courses, 
many significant digits of seconds will be needed to carry angular resolution to exactly match distant coordinates. 

If Bearing is selected under Software settings, then Quadrant Shortcuts can be used: 

 NE = 1  SE = 2  SW = 3  NW = 4 

to enter a bearing. For example: 

entering:  423.542389 results in:  N 023:54:23.89000 W 

The first character”4” is the quadrant shortcut. 

If Bearings are selected in the System Settings for direction entry, you can override bearing entry with an Azimuth by 
adding an ‘a’ for azimuth: 

 274.4512a =>  N 085:14:48.0000 W 

Direction from Existing Points 
When entering an Azimuth or Bearing, use any two points as a direction reference by putting a ‘,’ comma between the 
point numbers: 

 1001,1002  bearing from PN 1001 to PN 1002 

It is also possible to include simple math operators * / + - to build angular equations: 

 1001,1002+90 add a right-angle turn right to the bearing from 1001 to 1002 

 1001,1002-90 add a right-angle turn left to the bearing from 1001 to 1002 

Entering / Viewing Geographic and Projected Coordinates 
The following discussion is intended for users in the Unites States of America. It will have limited application to users in 
other regions. 

Geographic coordinates are unprojected coordinates, typically expressed in Latitude Longitude Height or Earth-centered-
earth-fixed (ECEF) coordinates. Coordinates also have a reference frame realization with an EPOCH date. 

NAD83 2010.0000 is a plate fixed realization for North America. For NAD83 we express a point’s Geographic coordinates as 
the point’s position on a specific date (EPOCH January 1, 2010) which is in the past. Even if the point moves because of 
crustal motion, the position is constant because it expressed on a date before the motion occurred. 

WGS84 is a general grouping of several realizations. ITRF 2014 (EPOCH:xxxx.xxxx) is the current realization of WGS84 used 
in the USA and is generally expressed with a fractional year measurement-date making the coordinates dynamic. In other 
words: WGS84 / ITRF dynamic coordinates change slightly every day.  

An example of a fractional year EPOCH date is August 19, 2023 12:40 which translates to 2023.6315. 

Prior to the NGS using ITRF2014, IGS08 was a commonly used realization in the USA. There have been many other 
reference frames in widespread use over the years and by different geospatial communities. 

There is a variable offset between ITRF2014 and NAD83 based on location and time. In the USA, the NGS tool HTDP 
(Horizontal Time Dependent Position) tool is used to approximate the difference at a location, for a specific time. (See 
https://geodesy.noaa.gov/TOOLS/Htdp/HTDP-user-guide.pdf for additional information on HTDP.) 

https://geodesy.noaa.gov/TOOLS/Htdp/HTDP-user-guide.pdf
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You have probably seen both Latitude-Longitude-Height and Earth-center-earth-fixed coordinates, with both fixed plate 
NAD83 coordinates and dynamic ITRF coordinates on NGS OPUS solution reports. Here is an example: 

REF FRAME: NAD_83(2011)(EPOCH:2010.0000)              ITRF2014 (EPOCH:2023.6315) 
 
         X:     -1587260.290(m)   0.004(m)          -1587261.270(m)   0.004(m) 
         Y:     -4561961.646(m)   0.014(m)          -4561960.346(m)   0.014(m) 
         Z:      4153956.508(m)   0.000(m)           4153956.384(m)   0.000(m) 
 
       LAT:   40 53  8.48450      0.008(m)        40 53  8.50067      0.008(m) 
     E LON:  250 48 55.76674      0.008(m)       250 48 55.70899      0.008(m) 
     W LON:  109 11  4.23326      0.008(m)       109 11  4.29101      0.008(m) 
    EL HGT:         1714.481(m)   0.010(m)              1713.716(m)   0.010(m) 
 ORTHO HGT:         1728.614(m)   0.065(m) [NAVD88 (Computed using GEOID18)] 

The left-hand column has NAD83 plate fixed coordinates, the right-hand column has ITRF2014 EPOCH 2023.6315 dynamic 
WGS84 coordinates. The top 3-lines have ECEF coordinates, the bottom 4-lines have Latitude-Longitude Height 
coordinates. 

Two heights are shown for the NAD83 position: an Ellipsoid Height and an Orthometric Height. Only an Ellipsoid height is 
shown for the right-hand column ITRF2014 coordinate. Ellipsoid heights are generally combined with Latitude Longitude 
coordinates. GNSS receivers measure and report Ellipsoid heights.  

Orthometric heights are derived from GNSS collected Ellipsoid heights using a GEOID separation file. Orthometric heights 
also have an associated vertical datum. In the example above GEOID18 was used to compute the Orthometric height and 
the result is a NAVD88 approximation. 

It is important to remember that in Ellipsoid space, water does not necessarily flow downhill. The GEOID separation file 
includes the effects of gravity so that in Orthometric space, water will flow downhill.  

In LandStar, projected coordinates (Northing and Eastings) are always entered, grouped, and shown with Orthometric 
heights: 

  

Geographic coordinates (Latitude and Longitude) are always entered and shown with Ellipsoid heights: 

  

GNSS Base receivers are always loaded with the Ellipsoid height of the antenna L1 phase center. 

Because the transformation between Ellipsoid and Orthometric heights requires a Geoid difference, LandStar will request 
that a Geoid file be selected if an attempt to load a coordinate system is made without a Geoid: 

  

When presented with this question, always pick the current GEOID file applicable to the project location (GEOID18). Do not 
proceed without loading a GEOID or LandStar will be unable to convert from Orthometric heights to Ellipsoid heights and 
Orthometric heights will be replaced by the Ellipsoid value. No additional warning will be given. 

In the USA, because CORS Servers and local bases are nearly always configured with NAD83 2010.0 coordinates, there is no 
difference between WGS84 and NAD83 Local coordinates.  
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There is no ‘built-in’ datum transformation in any of the USA predefined coordinate systems: 

  

In other (non-USA) locations, there may be 7-parameter or Helmert translations defined in the coordinate system 
definitions. For these areas, GNSS Bases are initialized with WGS84 coordinates, and the coordinate definition includes a 
transformation to place the Rover coordinates on a local datum or reference frame. 

When using LandStar in the USA, there is no difference between the Local and WGS84 coordinates. Thus, WGS84 
Lat/Lon/H coordinates will EXACTLY match the Local Lat/Lon/H coordinates. 

When looking at a surveyed point or entering a base position several possible formats are available: 

  

  

WGS84 Lat/Lon/H  Ellipsoid Height 
WGS84 ECEF X/Y/Z  Ellipsoid Height 
Local Lat/Lon/H  Ellipsoid Height 
Local ECEF X/Y/Z  Ellipsoid Height 
Local N/E/Elev  Orthometric Height 

Normally Local Northing, Easting, Orthometric elevations will be best for Storing and Staking points: 

  

GNSS bases are best configured with Local Latitude, Longitude, Ellipsoid Height coordinates.  
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Using OPUS Solution positions to start a Base 

If starting from a NGS OPUS solution, favor a Geodetic (Latitude, Longitude, Ellipsoid Height) position: 

  

The best measurement entry format is: 

  

If working in US Feet or International Feet be sure to enter an “M” after the Ellipsoid Height, as shown above, Elevations 
are always in Meters on an NGS OPUS solution. 
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LandStar 8 Program folders 
LandStar stores program data in two places on the Android device. The primary folders are: 
 \Internal shared storage\CHCNAV 
 \Internal shared storage\system_prj_backup 

Within these folders there are several addition folders: 

\Internal shared storage\CHCNAV 
 .\Cache  OEM, Mainboard firmware for GNSS devices 
 .\Config  Fonts, Codes, Geoids, Prisms, Working modes, Coordinate systems 
 .\Download files downloaded from the Cloud 
 .\Projects Projects, each project is stored in a folder 

Projects can be continuously backed up to the folder: 
 \Internal shared storage\system_prj_backup 
within this folder there will be a separate folder for each job. Within the job folder there may be multiple ZIP files 
containing snapshots of the job. These previous versions can be restored from the Project menu. See [ Project backups ] on 
Page 64 for additional information on Project backups.

LandStar 8 System settings 

From the Main menu click on the Side bar  button in the upper-left corner. This shortcut button allows quick access to 
System and Software Settings from any of the main menu tabs. 

  

It is also possible to directly view the Side-bar by clicking the Tool tray Quick access button allowing access 
to System settings without leaving most survey menus. 

The System settings panel provides access to Software settings (a sub-set of the System settings), interface styles and 
program defaults. 

Side-bar details 

 

See [ Software settings ] on Page 28 for details on Software settings. 
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Deployment backup and restore 

 

Deployment backup archives all the:  

• project groups 

• projects 

• LandStar settings 

• Device and Instrument profiles 

• Menu item positions 

• Import and Export profiles 

• GEOID Files 

• defaults 

• map tiles 

• pictures 

• Visual survey jobs 

• Plus everything else… 

to a single compressed file. This single file can then be moved to a different device and restored.  

If provisioning a new device, read about License transfer here [ Transferring a registration code license to another 
device ] on Page 10. 

From the Side-Bar click on Deployment backup and restore. 

  

The Backup list of existing deployment backups will be shown: 
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Click New to build a new backup: 

  
Give the backup a descriptive Name, choose to Backup application settings, choose to Backup projects.  

Then click Next. 

  

Check all of the Project groups to backup or Select all to include all Project groups. 

Finally click Start backup: 

   

Depending on the size of the projects the compression could take a long time (over five minutes.) 

After the backup completes, it will be listed in the Backup list: 

  



 22  LandStar 8 User Manual 

Slide the backup entry to the right: 

  

to reveal:  Delete,  Information,  Cloud,  Share,  Restore. 
When the backup is complete, the resulting file will be placed in the folder: 
 .\Internal shared storage\system_prj_backup 

It will be named: 
 settings07212023-20230921125156-Config-Projects.szip 
the entered Name followed by a hyphen and the date, time and included components. The file will have an .szip extension, 
however it is a standard ZIP compressed file. 

Use the  Restore from file button to open a backup that has been transferred to a random location on the 
device, typically the Download folder. 

Interface style 

  

LandStar has two interface styles: 

   

 Classic     Simple 

The Classic style has 4 tabs: Project, Survey, Config and Tools. Menu buttons can be hidden under the  More button. The 
Simple style has one primary menu which expands primary functions to lists of functions. Both menu styles can be further 
customized by modifying button positions and hiding entire functions. 

This User Manual shows only the Classic style interface. 

Audio prompt 
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Audio prompts for events like Fix, Float, Autonomous, Connection, Disconnection, Receiving NTRIP data can be disabled, 
announced with a Ding or Voiced: 

  

Warn if Base changes 

  

Enable to issue a warning if the broadcast position of the current Base changes. This can happen if there are two bases on 
the same UHF frequency, or if the network generates a new base after a GNSS rover makes a substantial location change. 

My cloud disk 

  

Collaborative functions in LandStar 8 
The CHC Cloud is a cloud based, collaborative work group and storage function. Operation relies on communication with a 
selectable server based in Europe or Asia. The services are SSL encrypted; however unencrypted files are stored on the 
endpoint servers. For this reason, cloud services may not be suitable for confidential work. 

If LandStar is not currently logged into the CHC Cloud, clicking on any collaborative function: 

  

will request a login to the cloud service: 

  

Click on Change server: 

  

Change the server to the European server. Then click OK. 

Click to Login and use Cloud services. 
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Storage 

The following predefined storage locations are available from the CHC Cloud: 

  

Web interface to CHC Cloud 

Login to the CHC Cloud web interface for access to files from a desktop: 
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Crew mapping: 

  

Collaborative work Group using CHC Cloud 

  

Once logged into the cloud, LandStar Workgroups can be created or joined. 

Workgroups share a common file repository where Projects, imported files, exported files, custom Coordinate systems, 
Code libraries, Roading files, and Base / Rover configuration files can be stored and shared. 

Workgroups are assigned a unique Group ID by the server when they are created and are protected by a Password: 

  

Upload position to CHC Cloud 

 

Uploads GNSS position By Distance or By Time to the CHC Cloud: 

  
The uploaded position can be viewed in real-time via the web interface. 

LandStar must be logged into the CHC Cloud to use this functionality. 

Localization packages 

 

Localization packages can hold region specific Geoids, profiles, and projections.  
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For the USA: 

  

Click on the  Download button, then confirm YES: 

  

Depending on the speed of the internet connection it could take a while for the download to complete: 

  

When the download is complete, the package file will automatically be decompressed and installed. 

Record track 

  

Enable to continuously record the GNSS position to the local device: 

  

A .CSV file named with the year, month day, hour, minute: 
 YYYY-MM-DD HH-MM-SS.csv 

is created in the project folder: 
 /storage/emulated/0/CHCNav/Projects/_projectname_/ 

Each line entry includes: 
 no., latitude, longitude, H, East, North, elevation, time 

The first line of the file includes a header description of the file contents. 
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Video Help, show video help button 

  

In some regional markets, extensive recorded video collections are available for context sensitive video help.  

When Show video help for float button is enabled, one of these icons will be shown on most screens: 

   

Feedback 

  

Click on Feedback to send suggestions directly to the LandStar developers: 

  

Remote support 

  

Allows access to the built-in remote support application. 

Activate software / About 

  

Displays the current software version and allows access to the licensing activation and transfer tools. See [ LandStar 8 
Licensing ] on Page 7 for more information. 
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Software settings 
Click on Software settings. The device settings menu is shown: 

  

Each of these setting items is described below. 

After making changes to the settings, click Save as default if you would like the modified settings to be used when new 
projects are created. 

Keyboard shortcut 

  

If a device has hardware buttons, functions can be assigned to them. The assignable buttons will be a subset of these: 

 NONE, Enter/OK, Volume Up, Volume Down, Left, Right 

Share method 

  

Set the Share method to Share by Android system function unless the CHC Cloud will be used. 

See [ Collaborative functions in LandStar 8 ] on Page 23 for additional information. 

Auto Ok 

  

Enable Auto Ok to save keystrokes as you use LandStar. If you have difficulties with accidental tapping, or want to manually 
approve all changes, disable Auto Ok. 
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Units 
Controls the display, accepted input and units used in LandStar: 

  

Angle 

Sets the display of Angle values: 

  

Set to dd:mm:ss.ssssss for operation in the USA. The GONS alternative is used in Europe. 

Azimuth display mode 

Set the method for directional display. When set to Bearing allows the use of Quadrant bearings. 

  

Set to Bearing = Quadrant Bearings (USA and Canada); Normal = Azimuth. 

Azimuth input mode 

Set the method for directional inputs: 

  

dd.mmssssss (USA) allows quick entry with a single decimal point. If Azimuth display mode = Bearing, then also accepts 
Quadrant shortcuts. See [ Entering Azimuths/Bearings ] on Page 14. 
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Lat/Lon input mode 

Determines the required entry type for Latitude and Longitude: 

  

Use dd.mmssssss (USA), DD:MM:SS.ssss requires the inclusion of ‘:’ separators. 

Lat/Lon display mode 

Set the method for display of Latitude and Longitude: 

  

Either dd°mm’ss.ssss” or dd:mm:ss.sss are typical in the USA. 

Horizontal Distance 

Sets the default units for horizontal distance measurements: 

  

When entering distances, the default units can be overridden with: 
 i international feet 
 f US Survey feet 
 m meters 
 c chains 

Vertical Distance 

Sets the default units for vertical distance measurements. 

  

Note: Many US States use US Survey feet for Horizontal and International feet for Vertical distances. 
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Area unit 

Sets the default units for area measurements: 

  

Typically, Acres or Square Yards for the USA. 

Volume unit 

Sets the default units for volume measurements: 

  

Typically, Cubic Feet, Cubic Yards or Acre-feet are used in the US.  

Note: the difference between cubic International Feet and cubic US Feet is very small: 
 10,000.000 cubic Meters = 353.144.55 cubic USFeet  = 13,079.428 cubic USYards = 
      353,146.67 cubic iFeet  = 13,079.506 cubic iYards 

Station 

Sets the default display for alignment stationing, sometimes called ‘chainage’: 
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Where the Format can be:  

  

In the USA, stationing is typically shown as 100-foot increments with format K+00.00: 
 12,345.67 feet is shown as: K123+45.67 

Decimals 

  

These settings control the number of decimal places used to display values. The settings shown above should be 
reasonable for most applications in the US. 

Coordinates 

  

Set the Coordinate order to North, East for use in the US and Canada.  
Most other countries and most CAD packages use East (E), North (N). 
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GNSS settings 

  

These GNSS settings are also accessible from most of the survey menus by clicking the  Setup button. There are 
separate settings for Topographic point survey, Continuous survey, Control point survey and Verified survey. 

The available tabs are dependent on the survey method from where Settings is launched from. For example, if you enter 
from Map survey then these tabs are available: 

 

while when entering from Point stakeout an additional Stakeout tab is available: 

 

entering Settings from Surface stakeout adds an additional Surface stakeout tab: 

 

finally, entering from the Side menu, Software settings, GNSS: 

 

Settings are organized on tabs. 
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Survey (tab of GNSS settings) 

Topographic point survey settings 

  

Topographic points are non-critical GNSS measurements. Typically, speed of acquisition is favored over long averages. 
Control survey and Verified survey methods provide for long averages with multiple device resets to generate high 
confidence coordinates. See [ Details: Survey (tab): Control survey ] on Page 113, and [ Details: Survey (tab): Verified survey 
] on Page 115 for additional information for taking critical GNSS measurements. 

LandStar8 has two topographic modes:  Quick (1 epoch) and  Topographic (length set by Measurements) controlled 
by the Survey type button on the survey screen. The Quick mode shares tolerance settings with the Topographic mode, 
except for the Measurements time. 

Horizontal tolerance (HRMS): the highest receiver reported HRMS that is allowed to be stored without user override. 
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Vertical tolerance (VRMS): the highest receiver reported VRMS that is allowed to be stored without user override. 

Diff age: the longest allowed correction latency allowed without operator override. Normally the latency will be 1 or 2 
seconds for UHF and network servers. Values higher than 10 indicate that the communication link is down. 

MAX PDOP: the highest allowed PDOP. Usually PDOP’s are less than 2.5, PDOP higher than 3 is worrisome. 

Store fixed solutions only: only allow FIXED RTK solutions. Reject FLOAT, DGPS and Autonomous solutions. 

Auto increment name interval: after a topographic measurement is made, the point name increments by this value. 
Usually, 1 or 10. 

Measurements: sets the measurement averaging time in seconds for Topographic mode, typically 5-seconds. Quick mode is 
1-epoch. 

Pole stability warning: while measurements epochs are collected, if the horizontal range of measurements exceeds this 
tolerance, the user will be given a warning and the opportunity to escape and not store the measurement. 

Confirm before saving: a measurement summary will be shown at the conclusion of averaging. The user can confirm and 
store or escape without storing the measurement. 

Use quick codes enables/ disables the Quick code portion of the surveying and stakeout menus. 

Quick codes disabled: 

  

Quick codes enabled with 6 Quick code pages: 

  

Results in this Survey screen with room for 54 code buttons: 

  
Long-press and hold on a Code button to assign a code. Then click on a quick code button to automatically set the Code 
and take a measurement. See [ Quick code panel ] on Page 97 for additional information. 

Add matching CAD layer when a new code is entered: when enabled creates a new CAD layer with a matching name to the 
new Code, assigned to the measurement. 

Prompt when using a new line code will confirm when the code assigned to a line is changed to the previous line code: 

  

Log PPK data when enabled assigns start and stop flags at the beginning and end of RTK average measurements, with the 
RTK point name, in recorded observation files (RINEX) for subsequent post-processing. 
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Show average report after measure displays a measurement report after each measurement that averages more than one 
epoch of data: 

  

Log epoch coordinate adds detailed epoch data for all averaged measurements to the file average-result.avr located 
in the Project folder. 

Show E-Bubble displays the receiver’s electronic bubble on survey screens. This is only applicable to receivers with an e-
Bubble or an IMU like the i50, i80, i70. I90, i93, i73, i70, i83, iG8 or iG9. 

Automatic photographing records a forward-facing photograph and downward-facing photograph using the built-in 
cameras on the Visual receiver for every measurement (Survey and Stakeout) attaching the photographs to the stored 
point as Multimedia: 

  

Depending on the [ Multimedia settings ] see Page 78; the stored photographs will include the Name, Latitude, Longitude, 
Northing, Easting, Date and Time superimposed on the lower right corner of the image: 

  

Automatic photographing is only available on Visual receivers like the i89 and i93. The Visual receiver must be connected 
by Wi-Fi to the Android device. 

Record GNSS Vector adds ECEF Base to Rover deltas, variances, and covariances to stored measurements when enabled. 
Enabled this option if you plan to export Trimble .JXL files or RW5 files. Enabling this option may result in slightly increased 
power consumption on the Android device. 
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Continuous survey settings 

  

Continuous surveying stores measurements continuously based on time interval or distance traveled. This can be useful for 
storing the centerline of a road from a moving vehicle. 

Store fixed solutions only: only allow FIXED RTK solutions. Reject FLOAT, DGPS and Autonomous solutions. 

Auto increment name interval: after a topographic measurement is made, the point name increments by this value. 
Usually, 1 is used for continuous surveying. 

Mode: the trigger condition for taking another measurement. 

Time: time interval in seconds. 

Distance 2D: Horizontal distance of travel. 

Distance 3D: 3D distance of travel. 

Distance 2D or delta H: 2D horizontal or delta H triggers. 

Control point survey settings 
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The Control point survey takes repeated measurements averages, resetting the receiver between groups, waiting for a new 
fixed solution. If HRMS/VRMS and group range tolerances are not met, the control survey waits for better conditions. See [ 
Details: Survey (tab): Control survey ] on Page 113 for more information on Control point surveying. 

Control point survey is intended to be used in open canopy on important points. A tripod or bipod must be used for a 
control survey as the measurement acquisition will not finish if the receiver moves during the relatively long acquisition 
period. 

Verified point survey is like the Control point survey, except the Verified survey will continue to run when tolerances are 
not met and points can be observed during multiple sessions, on multiple days. The Verified survey allows the user to reject 
averaged groups after collection, while Control survey requires that all groups meeting the tolerance limits be included in 
the results. See [ Details: Survey (tab): Verified survey ] on Page 115 for more information on Verified point surveying. 

A measurement group is comprised of several point averages that are themselves averaged epochs. 

Number of passing measurements: measurement groups will continue to be collected until this number of groups passes 
all tolerance settings. 

Points per measurement group: the number of multi-epoch averaged points per group. 

Number of epochs per point: the number of epochs averaged to make a point in the group. 

Group horizontal range tolerance: the horizontal range of multi-epoch points in a group must be less than this tolerance. 

Group vertical range tolerance: the vertical range of multi-epoch points in a group must be less than this tolerance. 

Epoch maximum HRMS: the receiver reported HRMS must be less than this tolerance for epochs to be accumulated. 

Epoch maximum VRMS: the receiver reported VRMS must be less than this tolerance for epochs to be accumulated. 

Wait after fixed: the receiver’s OEM engine will be reset between each group. The survey will wait for the receiver to fix, 
plus this additional time for the receiver to settle down. A minimum of 15 seconds is recommended. 

Max PDOP: epochs will not be stored if this PDOP is exceeded. Normal PDOP’s are less than 2.5, so a setting of 3 may be 
reasonable. 

Percent of Pass: the minimum number of passing points. 

Common GNSS Survey settings 
All of the GNSS Survey methods share these additional settings. 

  

Auto increment name interval: after a topographic measurement is made, the point name increments by this value. 
Usually, 1 or 10. 

Create a new code with the same name layer: if the user types in a new code and stores a measurement with the code, 
enabling this option will create a matching layer and place the point on the layer. 

Log PPK data: write Time Tagging data (the point name) into the static observation file that is being recorded in the 
receiver’s memory. 

Show E-Bubble: enables the E-Bubble on the display screen. This is only applicable to receivers with an e-Bubble or an IMU 
like the i50, i80, i70. I90, i93, i73, i70, i83, iG8 or iG9. 
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Stakeout (tab of GNSS settings) 

  

  

The settings on the Stakeout tab of GNSS settings control the operation of the stakeout screens: Point stakeout, Line/Arc 
stakeout, Surface stakeout, Road stakeout, Sideslope stakeout. 

Point name prefix: prepended to the staked point name. For example, when staking a point name 1001, the stored 
measurement after staking the default name for the new point will be “STK1001”. See [ Auto description for staked points ] 
on Page 125 for additional information. 

Target station as a point name: if staking a line or polyline, use the station along the line as the point name: “K1+12.345” 

Display point name, code input box: disable to hide the point Name and Code boxes from the map screen. This results in a 
larger map area. 

Stakeout tolerance 1, 2, 3: There are three circles displayed around the staked point: 
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The outside ring is tolerance 3, the middle ring is tolerance 2 and the solid inside ring is tolerance 1. When storing a staked 
measurement, if the current position is outside of the center ring (tolerance 1) a warning message is displayed. 

Distance to switch to Visual Stakeout (Near): using a receiver with visual stakeout cameras (for example the i93), when 
staking a feature, when closer than the Near tolerance, visual stakeout will automatically switch to the bottom camera on 
the receiver. 

Distance to switch to Visual Stakeout (Far): using a receiver with visual stakeout cameras (for example the i93), when 
staking a feature, when within the Far tolerance, but further than the Near tolerance, visual stakeout will automatically 
switch to the forward-facing camera on the receiver. 

Auto zoom: the map image will automatically zoom in closer as the measurement approaches the staked point. 

Use PDA compass: uses the internal compass of the PDA (tablet) to compute the direction to the target point when 
enabled. If disabled, use the GPS track to determine the direction to the target point. 

Remove staked points from list after staking: When staking points, it is possible to stake from the Points to stake list, which 
is the right-hand column of the Point list: 

  

Enable Remove staked points from list after staking to automatically remove points from the Points to stake list so that 
they are only staked once. 

Previous/Next skip staked points: all the points in the Point list have an internal Staked attribute. When you stake a point, 
the point is marked as staked. Enabling this option will skip staked points when using the Next, Last and Auto nearest 

buttons: . You can still select staked points by manually typing in the point name or selecting from 
the Point list. 

Stakeout survey points: when disabled only points in the Points to stake may be staked. When enabled all points are 
eligible for staking. 

Search for the nearest point from the stakeout list only: when enabled, only points in the Points to stake list are considered 
when looking for the nearest point. Disable to consider all known points. 

Navigation text size: select the smallest size that is comfortable to read, this will maximize the remaining screen available 
for map display. 

Use auto description controls automatically populated descriptions for staked points. See [ Auto description for staked 
points ] on Page 125 for additional information. 
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Display settings 

  

These settings are found under Software settings: Display settings: 

Snap Settings: enable snap modes for picking points, lines, centers. These snaps are used in CAD, storing and staking points 
from survey menus: 

Node: snap to a point 

End: snap to the end of a line or vertices of a polyline. 

Midpoint: snap to the middle of a line segment. 

Center: snap to the center of a circle. 

Intersection: snap to the intersection of two lines. 

Nearest: snap to the nearest point on a line. 

Perpendicular: The point at a 90-degree angle. 

Any: allows snapping to an open location anywhere on the map. 
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The  tool is useful for picking with the Any snap. Click-and-hold on the  tool to quickly modify the Snap 
settings. See [ Snap ] on Page 46. 

CAD settings 
Background color: choose dark or light background colors on the CAD and map staking screens. 

Display line width: when enabled the layer or drawing’s line width is honored. If disabled, lines are drawn 1-pixel wide. 

Display line style: when enabled the layer or drawing’s line style is honored. if disabled, lines are drawn sold. 

Display line nodes: enable to show polyline vertices. 

Layers: click on the line to view the Layer list. Additional information is available in the next section. 

Display surveyed points: uncheck to hide measured points. 

Display entered points: uncheck to hide points that have no GNSS or TS measurement data. These are typically imported, 
hand entered or calculated points. 

Display points to be staked: disable to hide points in the Stake list. 

Points size (without code): display size for points that do not have a known code. 

Points color (without code): display color for points that do not have a known code. 

Point name: show point names in CAD and map survey. Click the color box to set the color. 

Point elevation: show point elevation in CAD and map survey. Click the color box to set the color. 

Point code: show point codes in CAD and map survey. Click the color box to set the color. 

Line name: show Line names in CAD and map survey. Click the color box to set the color. 

Text size: the size of text in Text boxes drawn on maps and CAD. 

Display coordinates after point selection: show the N, E, Z of points when they are selected in CAD or for stakeout: 

Disabled: 

  

Enabled 

  

GNSS position symbol and color: choose the symbol type, size and color. Click on the symbol to select from these symbols 
and sizes: 

  

Click on the color bar to select a color for the GNSS position display. 
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Tool tray 
The Map survey, Point survey, Control survey, Verified 
survey, Point stakeout, Surface stakeout, Sideslope 
stakeout, Area survey and Hydro survey all have a user 
defined tool tray that aligns to the left side of the map 
panel: 

  

The tools in the Tool tray and the tool ordering are fully 
programable by the user. 

The only permanent tool is the Setup button .  

Clicking the bottom tray button  collapses the tray 

to the top of the map area. Once collapsed, clicking  
restores the tool tray.  

If the tray has more tools than can be displayed, drag the 
tool tray up or down to view hidden tools. 

To configure the tray, click on the Setup button  then 
select the Tools tab: 

  

To add an Unselected tool, click on it in the left Unselected 

tray, then click the  button to move it to the Selected 

tray. The  button will move the highlighted icon from 
the Selected tray to the Unselected tray. 

The tools in the Selected tray can be reordered by click-
holding and dragging them up or down. 

Not all the tools are available in all the survey menus, and 
some of the tools are always shown when in specific survey 
methods. 

Add text to map 

  

Click on the map, then enter a text screen to add a text 
note on the map. The size of the added text is dependent 
on the zoom level when the text is added. 

Attributes 

  

View the attributes of the currently selected object (point, 
line, polyline, alignment.) 

CAD view 

  

Switch directly to the CAD view. This is the same action as 
clicking the CAD view main Survey menu icon: 

  

After using CAD view, clicking back will return to the 
previous survey menu. 

Center GPS position 

   

Continuously centers the map at the current GPS position, 
when enabled (orange colored.) 

Delete 

  

Delete the currently selected object from the map. 

Delete last point 

  

Delete the last measurement. This is useful for quickly 
removing the last measured point and perhaps replacing it 

with a new measurement.  might also be useful 
for just changing a few attributes of the last measurement. 
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Edit last point 

  

Allows direct editing of the last surveyed point’s properties: 

  

Useful for adding Multimedia (Pictures, Video, Audio) 
resources to measurements. See also [ Point properties and 
attributes ] on Page 77 for additional information. 

Enter a point (to stakeout) 

 

This tool is available in both Point, Line/Arc stakeout and 
Road stakeout. 

Point stakeout 

  

Enter a new point, then stake it out. Optionally add the 
newly staked point to the Point list. 

Check Save to Point list to add the newly entered point into 
the Point list. The point is not added to the Stakeout list.  

Line stakeout 

  

When staking a line or polyline from Line/Arc stakeout, click 
the Enter point tool to stake a station along the current 
line. 

Roading Stakeout 

When staking a line from Road stakeout, clicking the Insert 
point tool allows manually entering or staking a random 
point, or to enter/stakeout a station and offset from the 
current centerline. 

Entering a point with coordinates: 
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Entering a point at a Station + Offset: 

  

Quick access 

   
Opens the side panel for Quick access to Software settings 
and system settings 

  

Click the Quick access button again to collapse back to Map 
survey.  

The Quick access button and the staking from survey ability 
makes it possible to use LandStar as a single menu 
application. 

Explode Block 

  

If an imported DXF with blocks exists Explode will break 
every block into the original, ungrouped entities. 

Export DXF 

  

Exports all the points, lines, objects in the current project to 
a DXF file. 

Export Surface staked report 

   Export surface staked report 

This tool is automatically added to the Tool tray when in 
Surface stakeout mode. Clicking it writes two files: 

 .csv containing: Name, Northing, Easting, Design 

elevation, elevation, DeltaH, Date_time 

 .txt containing: Name, Northing, Easting, Design 

elevation, elevation, DeltaH, Date_time 

Follow (rotate) 

    

Continuously rotate the map alignment to match the PDA’s 
internal compass direction. When disabled, grid North is 
always up. 

Full view 

  

Zoom to the full extent of the drawing and points. 

Import DXF 

  

Import a DXF drawing into the current project. The drawing 
should have the same projected coordinate system and 
units as the current project. Also available from the Project 
(Main menu tab) > Import function. 

Invert line direction 

  

Invert the direction of the selected line. 

Layers 

  

Displays the Layers dialog. See [ Work layers, Map files, 
Online map ] on Page 49 for additional information. 

Nodes list 

  

Available from the Line/Arc stakeout menu, lists the nodes 
of the currently staked line/polyline. Each segment 
endpoint and center are listed. 
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Select a node then click Stakeout to immediately stake the 
node. 

Select a node then click Save to save the node or all nodes. 

Online map 

  
Control the map screen background map: 

  

Read about the Map files and Online map tools in the Layer 
manager. See [ Work layers (tab) ] on Page 82. 
It is possible to download project map coverage for offline 
use and control the map transparency for better visibility. 

See [ Online map (tab) ] on Page 84 for details. 

Region list 

  Region list 

Always added to the Tool tray when using the Area survey. 
Allows deletion and export of defined areas and regions. 
See [ Details: Survey (tab): Area survey ] on Page 139 for 
additional information. 

Snap 

  

Allows selection of points, object endpoints, midpoints, 
random locations by using the large circle to move the 
arrow using your fingertip, with the small arrow point 
picking features that would be difficult to click on directly 
with your finger. 

  

Long press on the Snap tool  (on the Toolbar) to directly 
display the Snap to object menu: 

  

Snap settings are also available from Settings > Display: 

  

Offset stakeout 

  

Available from Point stakeout. Allows the stakeout of a 
location that is not in the Point list, but that can be 
described by an offset from an existing point or object. 

See the Point stakeout section of this manual for details on 
Offset stakeout. 

Offset survey (hidden point survey) 
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Available in Map Survey and Point survey. Allows storing a 
measurement that cannot directly occupied. 

See Map survey for additional information. 

Open road (project) file 

  

Open a saved roading project. 

Pan to (center map at) 

  

Center the map at a position from the Point list , or a 
manually entered Northing and Easting. 

  

Panel (surface stakeout) 

  

Displays a large balloon window with the Cut/Fill to the 
current stakeout surface. Available in Surface stakeout. See 
[Details: Survey (tab): Surface stakeout ] on Page 137 for 
additional information. 

 
Fill, within Surface Stakeout Tolerance 

 
Fill, outside of Surface Stakeout Tolerance 

The background color will be green for FILL and red for 
CUT. 

The bar color will be  red if the Surface stakeout > 

Tolerance is exceeded and  white if the tolerance is met. 

Point list 

 

Switch to the Point List: 

  

Select a point in the list, then slide it right to reveal Delete, 
Map, Stakeout and Edit functions: 

  

Click on the stake button:  to begin a stake operation 
on the selected point. 

See [ Details: Project (tab) > Point list ] on Page 70 for 
additional information. 

Point Survey 

  

Switch directly to the text-based Point Survey tool. This is 
the same action as clicking the Point survey main Survey 
menu icon: 
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Redraw 

  

Regenerate the current map view. 

Regions 

  

Shows the list of regions in the current project. Part of the 
Area survey tool. Regions can be defined by taking a series 
of measurements around an area feature. The 2D & 3D 
area, 2D & 3D perimeter and a description of the area are 
shown in the region with a colored boundary and 
transparent interior color. 

Reverse line 

  Reverse line 

Clicking  reverses the direction of the active line, this 
tool is automatically added to the Tool tray when staking a 
Line, arc or polyline. 

Save object 

  

Select a drawing line or polyline object, save it to the Line 
list with a name. Selecting a point, then Sav object will 
duplicate it to a new point. 

Survey boundary 

  

Allows the description of a polyline boundary around the 
project. 

Once defined, a voice warning will announce when the 
receiver leaves the project boundary. 

Zoom In 

  

Zooms in to 50% of the current map coverage at the center 
location. 

Zoom Out 

  

Zooms out to double the coverage at the center location. 

 

IMU settings and status 
On survey screens that have a possibility of using IMU Tilt correction, if the connected receiver supports IMU an IMU 
Settings screen will be available. 
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Use IMU enables and disables the IMU (Tilt correction). The IMU (Tilt Correction) is always disabled for the Control survey 
and Verified survey method. The IMU adds additional measurement uncertainty, and it is reasonable to disable the IMU 
when storing and staking important boundary or control monuments for higher accuracy. 

Show IMU button turns the survey menu screen IMU control button:  on an off. 

Frequency of output will be automatically set to the highest frequency supported by the receiver and the connection 
method. 

The Info section includes detailed information on the tilt, tilt direction and the compensated Pole-tip location in 
Lat/Lon/Ellipsoid height and Northing/Easting which is derived from: 
 Receiver Phase Center + L1 offset + Instrument Height + Tilt + Direction 

Work layers, Map files, Online map 
Controls Layer visibility, color, fill, line type; background map layers, online maps, downloads cached maps from online 
sources. 

See [ Work layers, Map files, Online map ] on Page 49 for more information. 

Instrument Select & Status information 
A Status line is included at the top of most LandStar screens: 

  

The  Instrument select button allows quick instrument selection. 
Each of the other icons is clickable and links to additional detailed instrument status information. 

Instrument select 
The top line of most menus and functions includes the Instrument select button: 

  

Click the  Instrument select button: 

  

Then choose from GNSS Rover, GNSS base or TPS (Total Station). 

Finally select the desired Instrument profile from the profile list and click Accept. 

Instrument status 

  

Clicking icons on the top receiver information bar 

 displays status information about the 
currently connected receiver. Each of these screens are 
also available from the main menu Config (tab) > 
Instrument info tool. 
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Instrument information

Click  to display detailed instrument information: 

  

These icons link to additional functions: 

  add registration information to the receiver. 

  update the receiver or OEM board firmware. 

  link to the receiver configuration menu. 

Sky Plot and Satellites information 

   

This icon continuously displays the number of satellites In 
Use / Tracked.  

Click  to show the detailed Sky Plot information screen: 

  

Each constellation is shown on separate tabs at the bottom 
with colored bars indicating relative signal to noise values. 
Higher is better. The color mapping for each constellation 
is: 

 GPS GLONASS BDS Galileo QZSS 

BLUE L1 L1 B1 E1 L1 

GREEN L2 L2 B2 E2 L2 

RED L5 L3 B3 E5 L5 

Click the next  column to display the satellite 
information in table format: 
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Quality 

Click  or  to display the receiver solution quality 
status: 

  

H is the ellipsoid height. Elevation is the projected 
orthometric height (assuming a GEOID is loaded).  

Accuracy is a computed mathematical 1-sigma error 
estimation for the Horizontal and Vertical positions.  

DIFF age is the age of received corrections and typically 
should be 0, 1 or 2 seconds. 

GNSS Base information 

Click the  GNSS base tab to show the current 
position of the base in use. 
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Main menus and program functions 
LandStar has many functions grouped into four tabs of Main menu items: 

: 

        
 Project menu tab                   Survey menu tab                   Configuration menu tab        Tools (COGO) menu tab: 

Click and hold on function buttons, then drag them to change the button positions and order. 

Not all the functions will be needed for most users. Hide the unneeded functions under the  More button by clicking-

and-holding the unneeded function button until red minus signs  appear in the function button corners. 

Then click the minus circles of all the functions you want to hide: 

  >      >  
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To add the hidden function buttons back to the main menu tab, click the  More button: 

  

Then click the  button of the functions to move them back to the primary screen. 

Each of the available functions is summarized in the following section with links to additional, detailed information. 

Project (tab) 
The main menu Project tab holds the project data related functions. 

  Open an existing project or make a New project. Existing projects can be used as a Reference base for 
Coordinate system, Codes library, Project settings, Control points, Entered points, and Stakeout points.  
See [ Details: Project (tab) > Projects ] on Page 63. 

  Select or modify the Coordinate system that is used to convert Lat/Lon/Ellipsoid Height to projected 
Northing, Easting and Orthometric heights. The coordinate system includes the Ellipsoid, Projection 
type and parameters, Transformation (7-parameters, 3-parameters, Hemert, Datum Grid), Horizontal 
adjustment (Plane, Single point), and a Vertical adjustment (GEOID + Constand, Surface or Inclined 
plane.) LandStar includes predefined coordinate systems for 1,000’s of worldwide projections or you 
can enter a new projection manually.  
See [ Details: Project (tab) > Coordinate system ] on Page 64. 

  Allows projected coordinates at the Grid base elevation to be moved up to Ground using a Combined 
Scale Factor comprised of a Projection Grid Scale Factor and Ellipsoidal reduction factor and a rotation 
about a base Reference point. Arbitrary Ground coordinates (like 10,000, 10,000) can be associated 
with the base point. The resulting basis-of-bearings can match the underlying coordinate system (State 
Plane Coordinates), align the reference axis with Geodetic (True) North, or be manually set to an 
arbitrary alignment.  
See [ Details: Project (tab) > Singe point localization ] on Page 68. 
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  Displays the Point list which itemizes all Entered, Control, Reference points in the project. The Points to 
stake list is an itemized list of points that need to be staked.  
See Details: Project (tab) > Point list ] on Page 70. 

  Manage the Code list. Codes are used to classify points and include a Code Name; Type: Point, Line; 
Description; Display symbol, size; Layer; Line type, width, fill, and transparency. Codes are intertwined 
with Layers and new Codes can optionally generate a matching Layer. Codes can have specific drawing 
attributes or inherit the attributes from their associated Layer. Tools are available to import, save and 
share the Code list.  
See [ Details: Project (tab) > Codes ] on Page 80. 

  Manage the drawing layers. Points, lines and other objects are all associated with a drawing Layer. 
Layers can be ON-visible or OFF-hidden, which allows the CAD view to be simplified for specific tasks. 
Layers attributes include Color, Line width, Fill color, Opacity, and Line type. The Layer manager also 
includes the stack of background maps (Map files) and the Online map manager. See [ Details: Project 
(tab) > Layers > Work layers, Map files, Online map ] on Page 82. 

  Import data in a variety of formats (Text, DXF, DWG, SHP, KML, KMZ, TIFF, MBTILES (Global Mapper), 
Jmtitles (CHCNav), WFSDB (CHCNav), JPG, INS) to the Entered Point list, Control point list, Points to 
stake list and the CAD view.  
The Text file importer allows the generation of custom file formats containing: Name, Code, Northing, 
Easting, (orthometric) Elevation, Longitude, Latitude, (ellipsoid) Height, Description, and skipped items. 
The text file importer understands: .CSV, .TXT, .DAT, .XLS and .XLSX file formats with comma, semicolon, 
space and multi-space delimiters.  
The format ‘USA: P,N,E,Z,D’ is the correct format for 99% of applications in the USA. 
See [ Details: Project (tab) > Import ] on Page 85 for details. 

  Export data writes output files in text or standard formats in a variety of styles. The formats ‘USA FULL: 
P,N,E,Z,C,D’ or ‘USA: P,N,E,Z,D’ are the correct format for 99% of applications in the USA. 
See [ Details: Project (tab) > Export ] on Page 86 for details. 

  Surfaces can be used in Volume calculations and staked for Cut/Fill. The Surfaces manager allows direct 
import from CASS triangulation files, HC triangulations files, 3D DXF (.dxf) files and LandXML (.xml) files 
or surfaces can be created from a single point or a list of points that define a surface. Breaklines and 
boundaries are also supported for developed surfaces. The Surface manager allows granular control of 
the triangle networks used to approximate a surface. See [ Details: Project (tab) > Surfaces ] on Page 90 
for detailed information. 
Once a surface is defined or imported, use the Survey: Stake surface tool to stake them. See [ Details: 
Survey (tab): Surface stakeout ] on Page 137 for more information. 

  The Features list shows all Points, Lines and Polygons in the current project that have GIS attributes. 
Assign GIS features to a Code, then when a point or line is collected with the matching Code, attribute 
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entry will be enforced. The Features list allows editing the associated data, directly from the listing. See 
[ Building GIS Datasets in LandStar ] on Page 219 for help adding GIS features to Codes. 

  Lines / Arc list shows all the named lines and polylines in the current project. Stake these objects by 

sliding the line to the right, then clicking on the  blue stake button. Editing an object will display 
starting + ending coordinates, 2D + 3D length, ▲Elevation, bearing/azimuth, and slope. Manually enter 
line segments using the Add button at the bottom of the list.  

  This is a list of the recorded Visual survey tasks. Use this function to process the images and to snap 
additional target points. 
See the [ Visual survey Images list ] section on Page 112. 

  The Roads tool allows import of Centerline and Cross-section definitions. Roads list catalogs the 
available Roads and allows one road file to be activated. Each Road can have Station numbering 
equations, Horizontal alignments, Vertical alignments, Cross-section templates, Cross-section template 
positions, Super-elevations, Width lists, Side slope templates, and Side slope template positions.  
Roads is covered in a separate User Manual. 

Survey (tab) 
The main menu Survey tab organizes survey related tasks. 

  Survey (store) Point locations with direct or offset measurements and includes mapping backgrounds. 
Optionally group Points into Line, Polyline and Arc objects.  
See [ Details: Survey (tab) > Map Survey ] on Page 95. 

  Point survey is like Survey point; however, the interface is greatly simplified for a text-based 
representation. Fewer Tools are available.  
See [ Details: Survey (tab) > Point (text) Survey ] on Page 108 

  Visual survey records pictures with the camera built into a receiver while moving along a path. The 
resulting pictures can be processed in the data collector, then points can be picked and stored from the 
images. A vision enabled receiver like the i93 is required.  
See [ Details: Survey (tab): Visual survey ] on Page 108 

  The Control survey tool automates acquiring multiple groups-of-averages, automatically resetting the 
GNSS engine between groups, and performing statistical combination of the measured epochs.  
See [ Details: Survey (tab): Control survey ] on Page 113. 

  The Verified survey tool automates acquiring multiple groups-of-averages, automatically resetting the 
GNSS engine between groups, performing statistical and graphical analysis of the results to reject bad-
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FIX and average good-FIXED measurements.  
The intended use of the Verified survey tool is to acquire very reliable coordinates under extremely 
heavy canopy where the receiver is expected to encounter many bad fixes. 
See [ Details: Survey (tab): Verified survey ] on Page 115. 

  ‘Staking out a point’: using assisted navigation to move to a point’s known coordinates so the location 
can be marked by a stake, flagging, paint, whiskers, or other monument. Point stakeout provides a 
horizontal position and the deviation (cut/fill) to a target elevation. After setting a monument, typically 
the ‘set’ location is stored as an ‘as staked’ position for verification. 
Offset staking allows staking a point that is offset from the selected point.  
Visual staking displays the target point superimposed on a live picture from the receiver. 
See [ Details: Survey (tab): Point Stakeout ] on Page 123. 

  Line/Arc stakeout allows the selection of a line, arc, polyline, object to stake. The line can then be 
staked to the nearest point on the line, endpoints, node points, random and even stations along the 
staked object. Offsets can be added by Left, Right, Ahead, and Behind. Visual staking is supported for 
receivers with internal cameras (like the i93.) 
See [ Details: Survey (tab): Line/Arc stakeout ] on Page 131. 

  Surface stakeout accepts a surface to stake, then displays the cut or fill required to move the receiver 
up or down to the design surface. The delta is updated continuously as the receiver moves around. 
Surfaces can be defined by a single point; by three or more points (technically two-points would work, 
however an unintentional tilted-plane will result); importing a CASS triangulation file, a 3D DXF File or a 
LandXML file. 
See [ Details: Survey (tab): Surface stakeout ] on Page 137 for additional details. 

  Area survey allows the collection of polygons representing the edges of a region. During collection 
either 2D or 3D area and 2D or 3D perimeter length are displayed. Once a region is complete, it will be 
displayed with 2D/3D area and perimeter. The areas can be exported to a PDF report showing the area   
and DXF drawing file. 
See [ Details: Survey (tab): Area survey ] on Page 139 for additional information. 

  CAD View switches to a CAD style interface with a rich set of drawing, editing and measuring functions. 
Also available from the Tool tray and called by viewing shortcuts throughout the LandStar program. 
See [ Details: Survey (tab): CAD View ] on Page 142 for additional details. 

  Road stakeout is covered in a separate User Manual. 

  Site calibration allows modification of the underlying coordinate system so that Measurements (GNSS 
points) best match record (Known point) data. Horizontal and vertical calibrations can be combined or 
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handled separately. Site calibration makes the GPS receiver use local coordinates. 
See [ Details: Survey (tab): Site calibration ] on Page 146 for additional information. 

    
Base shift and CORS shift are nearly identical functions. While Base shift works for a single base while 
CORS shift works for all future bases and is targeted towards CORS network corrections where the 
BaseID will change over time and distance. 
See [ Details: Survey (tab): Base shift and CORS shift ] on Page 151 for additional information. 

  Automates staking a vertical profile perpendicular along a centerline (line or polyline). The profile can 
have multiple profile strings (segments with varying slope and width) and is mirrored on both sides of 
the centerline. The centerline might also be used to grade a slope against a building foundation. 
See [ Details: Survey (tab): Sideslope stakeout ] on Page 155 for additional information. 

  Foundation stakeout automates the design and staking of sloped pit walls around a foundation. At an 
offset distance, a sloping surface is defined which intersects with the undisturbed ground surface. The 
top edge of pit, wall slopes and building bottom can then be staked and excavated. 
See [ Details: Survey (tab): Foundation stakeout ] on Page 157 for additional information. 

  Hydro survey is a map survey method that shows the current position with a Waypoint plan detailing 
the desired hydrographic survey route. An Echosounder (Hydrolite DFX, Hydrolite TM, NMEA DPT, 
MNEA DBT are supported) provides Depth which is combined with the receiver position and HI vertical 
offset from the receiver to the sonar transponder to store derived bottom surface elevations at regular 
intervals. 

  Continuous survey allows automatic collection of measurements based on traveled distance or 
incremental time. Measurements can be triggered by Time, 2D distance traveled, 3D distance travel or 
2D delta and height delta.  
See [ Details: Survey (tab): Continuous survey ] on Page 160 for additional information. 

  Cross-section survey allows quick point survey at evenly or randomly spaced cross sections along a 
centerline alignment. This survey tool displays the location relative to a cross-section station enabling 
quick navigation to the left, centerline, and right offset points. Extra measurements along the cross-
section lines may also be stored.  
In addition to the stored points, Station and offset information is available for all measurements 
collected using the Cross-section survey, including points stored at random stations, along with a DXF 
file that details every cross-section measurement. 
See [ Details: Survey (tab) Cross-section survey ] on Page 162 for details. 
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Config (tab) 

  Instruments profile combines the Bluetooth/Wi-Fi Connection (Connect to instruments) with a Rover, 
Base, TS/RTS instrument configuration (GNSS Rover, GNSS Base) to form a complete instrument 
definition. 

Instrument profiles can be quickly selected and applied using the  Instrument select button. 
See [ Details: Config (tab): Instruments profile ] on Page 167 for more information. 

  LandStar connects to GNSS receivers, Total stations and Peripherals (Laser Rangefinder, Pipeline 
detectors, Echosounders) by Bluetooth. Most modern GNSS receivers also support a Wi-Fi connection. 
See [ Details: Config (tab): Connect to instruments ] on Page 169for details. 

  GNSS Rover configures the connected device as a Rover and includes the UHF Radio / Internal modem / 
PDA connection settings to provide RTK corrections.  
See [ Details: Config (tab): GNSS rover ] on Page 171 for details. 

  GNSS Base configures the connected device as a Base and includes Internal UHF Radio / External Radio 
/ Receiver Cell Network settings to provide RTK corrections. Also does the Base setup putting a 
coordinate in the receiver. 
See [ Details: Config (tab): GNSS base ] on Page 174 for details. 

  Receivers can store static observation data for processing in desktop tools like CGO2, online tools like 
NGS OPUS and be used for UAV post-processing. GNSS static recording allows control of the receiver’s 
recording settings. 
See [ Details: Config (tab): GNSS static observation recording ] on Page 178 for details. 

  The Instrument info tool provides extensive information about the currently connected receiver. 
See [ Details: Config (tab): Instrument info ] on Page 179 for details. 

  Receivers can be temporarily activated or be geofenced with different options based on location. 
Activate instrument allows the user to enter a new activation code. 
See [ Details: Config (tab): Activate instrument ] on Page 179 for details. 

  Receivers have firmware sets for the main board, the OEM GNSS engine, the cellular modem, and the 
UHF radio. It may be possible to automatically update a receiver using online resources. 
See [ Details: Config (tab): Update ] on Page 180 for details. 
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  The Advanced functions include: configuring the NMEA output for the Bluetooth channel, the RS232 
Serial port and a special Raw TELNET port (1212) accessible via the Wi-Fi port; the receiver Elevation 
mask setting, the Position output frequency, an OEM GNSS engine reset, the APN for the cellular 
modem and a NFC/Wi-Fi function that may allow connection to some receivers by Wi-Fi or Bluetooth 
more easily. 
See [ Details: Config (tab): Advanced ] on Page 180 for details. 

  Some receivers include NFC transponders. It may be possible to read the Bluetooth ID, MAC and PIN 
and the Wi-Fi SSID, MAC and password via NFC. 
See [ Details: Config (tab): NFC / Wi-Fi ] on Page 182 for details. 

Tools (tab) 

  Map adjustment allows vector maps (DXF, DWG, SHP, KML and KMZ, WFSDB files) to be georeferenced 
with multiple affine points. This function will not adjust raster images. 
See [ Details: Tools (tab): Map adjustment ] on Page 183 for details. 

  Compute the Volume, Surface area and cut/fill balance of two surfaces or a surface and a reference 
elevation, then and create a Volume report 
See [ Details: Tools (tab): Volume computation ] on Page 185 for details. 

  Area accepts an ordered list of points and computes the area enclosed by them. The points can be 
selected from the Point list, from the Map or entered as a range of points. 
See [ Details: Tools (tab): Area computation ] on Page 188 for details. 

  The Inverse tool computes distance and bearing between two points or a series of points (Traverse 
style). 
See [ Details: Tools (tab): Inverse ] on Page 190 for details. 

  The Angle conversion tool is useful for converting Degrees Minutes Seconds to decimal degrees, 
decimal minutes, decimal seconds, radians and Gons; and vice-versa. 
See [  ] on Page 190 for details. 

  Parameter calculation accepts matched sets of GNSS points (with underlying Lat/Lon/Height data) and 
Known points (projected values). After selecting a transformation style, verify residuals, and compute 
best-fit translation coefficients, the translation can be entered into the current project’s coordinate 
system. 
See [ Details: Tools (tab): Parameter calculation, 3 or 7- parameter ] on Page 191 for details. 
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  Computes the nearest point on a line to a specified point. Returns the Station, the Offset distance left 
or right, the nearest point can be saved to the Point list or directly staked out. 
See [ Details: Tools (tab): Point to line distance ] on Page 193 for details. 

  Compute the angle of a point offset from the endpoint of a line to the line. 
See [ Details: Tools (tab): Offset distance ] on Page 193 for details. 

  Compute the Deflection angle of a point offset from the endpoint of a line to the line. 
See [ Details: Tools (tab): Deflection ] on Page 195 for details. 

  Rotate a point around another point, a specified angle. Create a new point at the new location. 
See [ Details: Tools (tab): Rotation ] on Page 195 for details. 

  Intersection accepts point pairs defining two lines, the intersection of the lines between these points 
are computed. If there is no direct intersection, the lines are extended.  
See [ Details: Tools (tab): Intersection ] on Page 196 for details. 

  Place a point on the line bisecting an existing angle, specifying the offset from the center vertices. 
See [ Details: Tools (tab): Bisect angle ] on Page 198 for details. 

  Divide line will divide the distance between two points into even segment lengths (By distance) or a 
whole number of segments (By segments). Point protection can automatically Skip points that already 
exist at the same location as the calculated points. 
See [ Details: Tools (tab): Divide line ] on Page 199 for details. 

  Choose several existing points to average. Show the residuals for each added point and allow adding 
and removing points from the average before storing a new Point average. 
See [ Details: Tools (tab): Point average ] on Page 200 for details. 

  Directly enter a Metes and Bounds survey or a Bearing Distance traverse with lines and arcs. Plot deeds 
from legal descriptions. Includes a Curve Calculator and provisions for arc tangent bearings or cord 
bearings. 
See [ Details: Tools (tab): Plot Deed ] on Page 201 for additional information. 
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  Translate, rotate, scale points and objects based on a multi-point alignment or manually entered offset, 
rotation and scaling information. 
See [ Details: Tools (tab): Transformation ] on Page 210 for additional information. 

  Subdivide an existing closed polygon into two parcels. Supports: parallel by two-points, perpendicular 
by two-points and hinge-point. 
See [ Details: Tools (tab): Area subdivision ] on Page 216 for additional information. 

  A simple Calculator for simple computations. 
See [ Details: Tools (tab): Calculator ] on Page 215 for details. 

  Displays a ruler that shows centimeters only. 
See [ Details: Tools (tab): Ruler ] on Page 218 for details.
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Function Details 

Details: Project (tab) > Projects 
Open an existing project from the Project list or make a 
new project. 

Available from the Project (tab) > Projects button: 

  >  

  

Click on  Time ascending and  Time 
descending to sort by the time the project was last used, 
not the creation time. 

Click on  to search for projects by name. 

Initially new projects will be placed in the Default Project 
group folder. Click on  

  

to make a new Project group or select another group: 

  

Sharing Projects 
From the Project list, slide a project entry to the right: 

  

Click the  Share project button. If the project has Visual 
survey images, image inclusion will be prompted: 

  

Check Share visual survey images to include image sets. 
Enabling image inclusion will generate very large projects. 

The current project will be compressed to a single ZIP file. 
Share the file, typically by email or Google Drive if images 
are included, to another device or user. 
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On the receiving device, use the 3-Dot button in the project 
list: 

  

Then click Load from file to browse for the project file and 
restore it as a local project. 

Project backups 
LandStar automatically backs up projects at a defined 
interval and optionally each time you exit. These backups 
are ZIP compressed collections of project data and settings, 
they are stored in a separate folder from the primary 
project (to help protect against inadvertent deletion.) 

Click the  3-Dot button to change the automatic Backup 
settings or to Restore a project: 

  

Load from file allows browsing device memory for a shared 
project file.  

Backup settings: 

  
sets the automatic project backup interval. Backups are not 
deleted, even if the job they are protecting is deleted, so if 
you inadvertently delete a job, the backup should/will 
remain. Restore project from local will restore a backup 
into the currently selected project folder. 

By default, project backups are stored in the root folder: 
 /system_prj_backup 
outside of the normal CHCNav folder hierarchy. Within the 
project backup folder there will be a subfolder for each job, 
within the job subfolder there will be one or two 
compressed .ZIP files holding the project’s files. 

When making a New project: 

  

Enter a project Name and assign an Operator name. 

Optionally pick a Reference project to inherit the 
Coordinate System, Code library and Project settings, 
Control points, Entered points, Stakeout points from: 

  

If a Reference project is not used, select a Coordinate 
system for the new project. See the following entry [ 
Details: Project (tab) > Coordinate system ] for more 
Coordinate system details.  

 

Details: Project (tab) > Coordinate system 
Select or modify the Coordinate system that is used to convert Lat/Lon/Ellipsoid Height to projected Northing, Easting and 
Orthometric heights.  

From the main menu Project (tab) click on the Coordinate system button: 

  >  

The Coordinate system dialog is shown with these 5 tabs: 
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Ellipsoid                            Projection                        Datum trans                    Horz. Adjustment             Vert. adjustment 

LandStar has thousands of predefined coordinate systems. 
There are too many to pick from a single list. Instead 
LandStar maintains a Common coordinate system list that 
you can copy systems to from the giant Pre-defined 
coordinate systems list. You can also add User defined 
systems to the Common coordinate system list. 

The predefined coordinate systems fully implement the 
State Plane systems; however, they do not specify a Geoid. 
When you copy a predefined system to the Common list, 
you should always specify the correct Geoid. 

Click on  From lib to access the Common 
coordinate system list. Initially there will be no systems 
listed: 

  

Click on  Pre defined then set the Region to United 
States. 

  

The default Area will be NAD83(2011): 

  

If you are looking for a special County zone, 
change the Area: 
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A list of Area specific zones will be shown. 

  

Drag the list down and select the correct SPC Zone for the 
Project area: 

  

Finally click Select.  

If additional zones are regularly used, repeat as needed to 
add them into the Common coordinate list: 

  

To add a Geoid into an existing Common coordinate system 

list entry, highlight one projection then click  
Select: 
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Select the Vert adjustment tab: 

  

then use the dropdown to choose a Geoid file to use. 
Currently Geoid2018US is appropriate for the continental 
Unites States. If the Geoid you need is not available make 
sure you have installed the localization package. See [ 
Localization packages ] on Page 25. 

Change the Name of the system to include the Geoid: 

  

Click on  Save to lib to save the coordinate system 
with the Geoid included as a Common coordinate system. 

Finally click  Accept. 

  

The zone will be available, with the Geoid applied in the 
Common coordinate system list: 

  

To delete a Common coordinate system, slide the Common 
coordinate system to the right,  

  

then click on the  Delete button to remove it. 

Coordinate system utilities 

From the coordinate definition screen, click on the  
button: 

  

then Create QR code to display a QR code: 
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Which can be scanned by other devices using the Scan QR 
code tool: 

  

Use broadcast RTCM will wait for the next RTCM 
transformation parameters broadcast as Message Type 
1021 – 1028 and build a coordinate system. This option is 
extremely uncommon. 

Click Lock to freeze the coordinate system and password 
protect it from inadvertent changes: 

  

Export writes the current coordinate system to a Trimble 
.dc file. Most field software programs import Trimble .dc 
files directly. 

Load from file will import: 
 Trimble DC (.dc) 
 Trimble JXL (.jxl) 
 Trimble CAL (.cal) 
 Leica LOC (.loc) 
coordinate system definition files. 

 

Details: Project (tab) > Singe point localization 
Allows projected coordinates at the Grid base elevation to be moved up to Ground using a Combined Scale Factor 
comprised of a Projection Grid Scale Factor and Ellipsoidal reduction factor and a Rotation about a base Reference point. 
Arbitrary Ground coordinates (like 10,000, 10,000) can be associated with the base point. The resulting basis-of-bearings 
can match the underlying coordinate system (State Plane Coordinates), align the reference axis with Geodetic (True) North, 
or be manually set to an arbitrary alignment. 

Begin from the Project (tab) > Projects button: 

  >  

Slide the Use single point localization to the right: 
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A single menu will be shown: 

  

Define the Project BNSS Base Point by picking from CAD 

with the  CAD button, making a new measurement at 

the current position with the  Begin measurement 
button, or select an existing GNSS measurement  from 
the Point list. 

Next enter the Project Base Local Coordinate that the 
receiver should read when placed at the GNSS Base Point. 
Either type the coordinate in, select a Known point from 

 CAD or, select a Known point from the  Point List. 

Choose a Basis of Bearings from Geodetic (True North), 
Grid North (matches the current Coordinate system 
projected grid), or Manual entry.  

If manual Rotation entry is used, extreme precision is 
required to match distant coordinates. The: 

  

> button can be used to match the exact bearing between 
two existing points in the project. 

Click the  Calculate button to automatically 
compute the Elevation Scale Factor, the Grid Scale Factor at 
the GNSS Base Point, a Combined Scale Factor and an 
appropriate Rotation. 

Click  Accept,  

  

then Apply to install the results into the current Coordinate 
system.  

Check-in on the GNSS Base point using Stake point, the 
receiver’s coordinates should exactly match the Known 
point entry. 

The resulting Horizontal adjustment will be fully described 
on the Project > Coordinate system > Horizontal 
adjustment (tab);: 

  

The computed Vertical adjustment will be fully described 
on the Project > Coordinate system > Vertical adjustment 
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(tab): 

  

Clicking the  button from the Coordinate system allows 
sharing, Locking, Exporting and Loading the complete 
system: 

  

To disable the Single point localization, return to the menu 
and slide the Use single point localization slider to he left: 

  

When the coordinate system is changed, all projected 
coordinates of points with underlying GNSS values will 
automatically be updated. 

 

Details: Project (tab) > Point list 
Available from the Project (tab) > Projects button: 

  >  

The Point list organizes 3 types of points:  

 Survey points that are measured with GNSS or TS/RTS. 

 Enter points that are imported, or hand entered. 

 Control points that are treated as high precision control points. 

 Base points that are associated with Base locations. 

When entering the Point list screen, the Project name is shown at the top with the total number of points in parentheses 
(19). There are two tabs, the Points tab contains all the points in the project, the Points to stake tab contains a list of points 
to be staked. While it is not necessary to use the Points to stake list, it does help keep design points separate from 
surveyed points. 
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It is possible to drag-over rows in the Point list to select ranges of points. Click on the top or bottom item to select, hold, 
then drag up or down. 

The left-hand column has an icon representing the type of point: 

  Entered 

  Averaged 

  Base 

  Rover 

  Imported 

  Entered Control point 

  Surveyed Control point 

  Staked 

  COGO computation result. 

  Verified point survey, multiple measurement survey. 

 

The width of the list is usually wider than the screen, drag/slide it left and right to view all the columns.  

Click the  3-dot button in the upper right corner, then 
select Switch list style to change to the paragraph display 
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style for points: 

  

Click the  3-dot button in the upper right corner to 
change the displayed columns and their order. The default 
columns are: 

 Name The point Name or Number, names can 
contain spaces. 

 Code The Code associated with the point. 
Codes can be coupled to Layers and 
automatic drawing automation. 

 Description Descriptions can be any length. Most 
survey screens do not have a dedicated 
Description entry box, enter a Code 
followed by a question mark ‘?’ (the 
Code escape character’ and whatever 
follows the ‘?’ will be placed into the 
Description. 

 North The point Northing in the project units. 
Can be modified by 3-dot > Coordinate 
type. 

 East The point Easting in the project units. 
Can be modified by 3-dot > Coordinate 
type. 

 Elevation The point orthometric Elevation in the 
project units. Can be modified by 3-dot 
> Coordinate type. 

 Type The type of point: Base, Survey, 
Entered, or Control. 

 2D dist The horizontal distance from the 
current point to the next point in the 
grid. 

 3D dist The 3D distance from the current point 
to the next point in the grid. 

 Time The Date - Time the point was entered 
or acquired. 

The following columns are also available for display: 

 Solution Fixed, Float, DGPS, Autonomous 

 Antenna Height The Vertical HI of the GNSS receiver or 
prism. 

 ▲Elevation The elevation change, from the current 
point to the next point in the list. 

 Satellites The number of satellite vehicles used 
for the measurement. 

 PDOP The PDOP while the measurement was 
acquired. 

 Picture Displays the name of the picture. 

 Bearing The azimuth or bearing from the 
current point to the next point in the 
list. 

When a line is slid to the left, additional options are shown 
depending on the type of point: 

 Base  Base 

points can be shown in  CAD view 

and they can be  edited. Base 
points cannot be deleted as they may 
have Rover points associated with 
them. 

 Rover  Rover 

points can be  deleted, shown in 

 CAD view, immediately  

staked, and they can be  edited. 

The  Import button launches the file import tool, 
see [ Details: Project (tab) > Import ] on Page 85 for details. 

The  Export button launches the file export tool, 
see [ Details: Project (tab) > Export ] on Page 86 for details. 

The  Add button allows manual entry of a new 
point. 
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3-dot button 

At the top right corner of the screen there is a  3-dot 
button (the kebab menu): 

  

The items on the 3-dot menu are: 

Coordinate type 

Click the  3-dot button, select Coordinate type 

  

Change between Coordinate display types for the grid. See [ 
Entering / Viewing Geographic and Projected Coordinates ] 
on Page 15 for additional information. 

Multi-select 

Click the  3-dot button, select Multi-select to add 
checkboxes to the left of every line, allowing multiple 
points to be selected at once for Deletion or to Reset 

stakeout state (see the 3-Dot button): 

  

Recycle bin 

Click the  3-dot button, select Recycle bin to view the 
deleted points. When points are deleted, they are moved 
to the Recycle bin: 

  

It is easy to restore the points in the Recycle bin, or to 
permanently delete them. 
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Custom Display 

Click the  3-dot button, select Custom display to select 
the Point list columns and reorder them for display: 

  

Highlight an item, then use the Up and Down buttons to 
move it up and down in the list. 

Set point(s) elevation 

Click the  3-dot button, select Set point elevation to 
select one, or more, or all points to set the elevation of: 

  

Click Next: 

  

After a Surveyed point’s elevation is edited, it will change to 
an Entered point. 
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Adjust point(s) elevations 

Click the  3-dot button, select Set point elevation to 
select one, or more, or all points to adjust the elevation of: 

  

Click Next: 

  

After a Surveyed point’s elevation is edited, it will change to 
an Entered point. 

Set code to points 

Click the  3-dot button, select Set code to points to add 
checkboxes to each point, check the points to assign a Code 
to: 

  

Click Next: 

  

Select a new Code, then click OK to set the Code of the 
highlighted points. 

Set antenna height 

Click the  3-dot button, select Set antenna height to add 
checkboxes to each point, check the points to change the 
antenna height of: 
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Click Next: 

  

Edit the Antenna type and the vertical Antenna height (HI). 
Click OK, the antenna parameters are updated, and a new 
point elevation is applied to the selected points. 

Shift GNSS base 

Click the  3-dot button, select Shift GNSS base.  

  

Use the drop-down list to choose the Base to move. It is 
also possible to change the Base Antenna type and Antenna 
height along with the new base position.  

The new Known point for the selected base can be 

retrieved from  CAD, making a new measurement at the 

current GNSS  Start measurement, picking from 

another point in the  Point list or hand entering a new 
point. To hand enter, choose the position type: 

  

Local Northing, Easting, orthometric Height: 

  

or Latitude, Longitude, Ellipsoid Height: 

  

Click on Accept to apply the new Base parameters which 
will shift all the GNSS points that were collected with the 
selected base. 

Show / Hide GNSS base points. 

If the GNSS Bases are shown in the Point list, Click the  3-
dot button, select Hide GNSS base points to remove them. 

  

If the GNSS Bases are not shown in the Point list, Click the 

 3-dot button, select Show GNSS base points to add them 
to the list them. 

  

Sort newest to top/bottom 

By default, the point list order is first to last click the  3-
dot button, select Sort newest to top to reverse the list.  

If the newest point is sorted to the top, click the  3-dot 
button, select Sort first to top to reverse the order. 

Reset stakeout state 

Click the  3-dot button, select Reset stakeout state to 
mark all points as un-staked. This makes them eligible for 
staking with Stake nearest operations which automatically 
exclude previously staked points. 
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Data statistics 

Click the  3-dot button, select Data statistics to show a 
short summary of the Points list: 

  

Switch list style 

Click the  3-dot button in the upper right corner, then 
select Switch list style to toggle between the line display 
style and the paragraph display style for points. 

Line display style: 

  

Paragraph style: 

  

Point properties and attributes 
Points in the Point list can have several attributes besides 
position, Code, Name and Description. An Enter point type 
will have simple properties, while a Surveyed GNSS point 
will have many additional Survey properties and Quality 
properties. 

  
 Entered point 

  
 GNSS Surveyed point 
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 Additional Quality properties for a GNSS point 

It is possible to assign GIS Fields, Attributes and assign 
Values in the field based on the point’s Code: 

  

See [ Building GIS Datasets in LandStar ] on Page 219 for 
information on GIS Point Attributes. 

Multimedia (Pictures, Video and Sound Recording) can also 
be attached to any point: 

  

Click the  Multimedia settings button and check all the 
photo description checkboxes: 

  

to automatically label photos with the Name, Latitude (B), 
Longitude (L), Northing (N), Easting (E) and timestamp 
information: 

  

 

Details: Project (tab) > Point list > Points to stake (tab) 
The right-hand tab of the Point list holds a 2nd list of points: 
Points to stake. These points might be selected points from 

the left-hand Point list. They might be Imported from a 
separate file, or they might be snapped from line work in 
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CAD.  

  

Once an important list has been generated, Export it for 
future use. The Export function: 

  

Allows filtering exported points by measurement Time, 
Name, Code and Description. 

Drag an entry to the right: 

  

Then click on the  Stakeout button, to directly enter 
the Stake point routine. Once the point is stored, or the 

Next / Last button is pressed, the 
point will be marked as Staked in the Stakeout count 

column: 

  

Then the next un-staked point in the Points to stake list will 
be targeted. 

The  3-dot button in the upper right corner accesses 
these settings: 

  

Coordinate type 

Changes between Coordinate display types for the 
displayed values. See [ Entering / Viewing Geographic and 
Projected Coordinates ] on Page 15 for additional 
information. 

Multi-select 

Allows multiple points or all points to be selected and 
subsequently deleted. Also allows drag-over-past selection 
of multiple items. 

Sort 

Allows reordering of the Points to stake entries: 

  

Highlight one or more lines, then use the Up and Down 
button to change the staking order. Click on the Back 
button to exit Sort. 
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Switch list style 

Toggle between one row per point and one paragraph per 
point displays: 

  
 Line list style 

  
 Paragraph list style 

Reset stakeout state 

Sets the Stakeout count back to 0 (zero), which makes the 
points eligible for stakeout again. 

 

Details: Project (tab) > Codes 
Codes are used to classify points and include a Code Name; Type: Point, Line; Description; Display symbol, size; Layer; Line 
type, width, fill, and transparency. Codes are intertwined with Layers and the entry of a new Codes can optionally generate 
a name-matching Layer.  

Codes have specific drawing attributes or inherit the attributes from their associated Layer.  

Codes can be organized into multiple Groups (Categories). 

Tools are available to import, save and share the Code list. The Quick code button assignments are also stored with the 
Code list: see [ Quick code panel ] on Page 97 for information about the Quick code panel; see [ Sharing CODES and Quick 
Code buttons assignments ] on Page 97 for information on sharing code lists with the Quick code panel assignments. 

To manage the available Code list, from the Project tab click 
on Codes: 

  >  

An empty Code list will be shown: 

  

From this menu it is possible to delete codes, edit codes, 

create new codes. The  button on the upper right corner 
allows 
 Importing Code libraries. 
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 Loading code libraries from text files, Carlson FCL files, 
Trimble FXL files. 
 Saving Code libraries for reuse in other projects. 
 Sharing Code libraries by email, Google Drive or other 
sharing methods with other users. 

When Importing or Saving code libraries, the Quick code 
panel layout is included in the library file. 

Edit or Delete an existing code 
Click on or slide-right an existing Code row: 

  

Item options to  Delete or  Edit the Code will appear 
on the left of the row: 

  

Click  Delete, then confirm: 

  
to delete a single Code. 

Click  Edit to change the properties of a Code. 

Create a New Code 
Click the New button to create a new Code. A matching 
Layer can be built with the new code: 

  

 

  
 New Code with new Layer 

Or a new Code can be created without a matching Layer, 
possibly referencing an existing layer: 

  
 New Code without Layer 

Enter a unique Name for the new Code. 

Drawing type can be Point or Line. 

The Description is a text prompt for the Code. 

The Symbol can be selected by clicking on the Symbol box 
then choosing from one of the 100’s of included symbols, 
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or imported from a .dxf file. The Symbol size ranges from 1 
to 9. 

if Color by layer is enabled, then the symbol color is 
inherited from the Layer. Otherwise, the symbol color can 
be chosen from a color wheel. 

If  Create a layer with the same 
name is checked then the Line type, Line width, Fill color 
and Transparency can be entered and a new Layer with the 
following properties and the same name as the Code will be 
created: 

There are several possible Line types: Continuous, 
Dashed, Dot, Center, Arrow_Continuous. Possible Line 
width: Normal, Thin, bold. 

The Fill color and Transparency is for closed polygons 
built with Line attributes. 

GIS Attributes allow features (like a serial number, 
diameter, invert) to be recorded and associated with 
objects when acquired. See [ Building GIS Datasets in 
LandStar ] on Page 219 for detailed additional information. 

Code library functions 

Click the  button on the upper right corner: 

  

Import from code library will import an existing LandStar 
code library.  

Load from file imports a Code list from a custom .csv file, a 
Carlson FCL (.fcl) file or a Trimble FXL (.fxl) code list.  

The custom file can include any of these field types, in 
the listed order: 

  

Save code library saves the current Code library to a named 
file. 

To cloud pushes a copy of the current Code library to the 
CHCNav cloud. 

Share sends a copy of the current Code library to any of the 
device sharing options, for example as an attachment to 
email. 

 

Details: Project (tab) > Layers > Work layers, Map files, Online map 
The Layers menu has three tab sections: 

 Work layers associated with objects: points, lines, polylines, … 

 Map files: DXF, DWG, SHP, KML, KMZ, TIFF, MBTiles, JMTiles, WFSDB, JPG 

 Online Maps: Google satellite, Bing satellite, OSM and others 

The Online Maps selection allows downloading map tiles covering the entire project area for offline use. Downloaded maps 
are added to the Map files tab and the transparency can be adjusted to make the image more compatible with overlaying 
survey plotting. 

You can also reach the Layers menu from: 

 Project > Layers 

 Software settings > Display settings > Layers 

  side-bar button optionally available in many survey screens 

Available from the Project (tab) > Projects button: 

  >  
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Work layers (tab) 

  

This tab allows you to edit the properties of all the layers 
associated with features.  

 button allows you to select multiple layers for deletion. 

click to toggle the layer visibility (show/hide) 

Click on the  symbol to slide the layer to the right 
allowing deletion and editing: 

  

It may be safer to just click on the line which only displays 
the edit tool: 

  

Then click on the pencil  to edit the properties of the 
selected layer. 

  

These Layer properties can be modified: 

Name: the name of the layer. 

Layer color: the color of the layer. 

Line width: Normal, thin, and bold are available. 

Fill color: if a closed shape (polygon) is defined on the layer, 
it will be filled with this color. 

Transparency: change the opacity of the polygon fill to 
allow other elements to be seen. 

Line type: select a simple line style: continuous, dashed, 
dotted, center line-dot, line with arrows. 

Map files (tab) 
Use the Map files tab to attach both vector drawings and 
raster images from several sources to a project: 

 DXF/DWG CAD drawings 

 SHP  shapefiles 

 KML/KMZ  Google line and point files 

 TIFF  GeoTiFF raster images 

 MBTILES Mapbox tile sets often exported by 
QGIS 

 JMTILES Map cache tiles downloaded from 
online sources. 

 WFSDB Downloading WFS maps generates 
WFSDB tiles. 

 JPG JPG image files with JGW world file. 

 INS  polylines 

Once a map file is attached to your project, it is possible to 
change the opacity of the image. Click on a Map file, slide it 
to the right: 
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Click on the transparency button  to set the layer 
transparency: 

  

then click OK. 

Click on the  button to view the layer: 

  

 75% transparent 

  
 0 % transparent 

Online map (tab) 
The Online map tab allows control of the live online map 
backgrounds available from several sources. Selecting a 
source will automatically download map tiles as needed to 
create background coverage for your visible area and zoom 
level. 

Once downloaded, the map tiles are kept with the project 
forever. 

From this menu, it is simple to download background maps 
onto your device to eliminate the need for internet data 
while surveying. 

  

Click on a map source, then slide it to the right: 

  

then click on the download button  
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Adjust the map coverage, then click Download. 

  

Select a reasonable layer name, Min level and Max level. 
Click OK to begin downloading tiles. Converted tiles are 
stored in the JMTiles format. 

  

Wait for the download to complete. Before you leave the 
Online map tab, uncheck the downloaded map layer: 

  

The Online map is displayed on top of the downloaded map 
and will occlude any transparency settings you make. The 
downloaded map will now be listed on the Map files tab: 

  

 

Details: Project (tab) > Import 
Import data in a variety of formats (Text, DXF, DWG, SHP, KML, KMZ, TIFF, MBTILES (Global Mapper), Jmtitles (CHCNav), 
WFSDB (CHCNav), JPG, INS) to the Entered Point list, Control point list, Points to stake list and the CAD view.  

The Text file importer allows the generation of custom file formats containing: Name, Code, Northing, Easting, 
(orthometric) Elevation, Longitude, Latitude, (ellipsoid) Height, Description, and skipped items. The text file importer 
understands: .CSV, .TXT, .DAT, .XLS and .XLSX file formats with comma, semicolon, space and multi-space delimiters.  

The format ‘USA: P,N,E,Z,D’ is the correct format for 99% of applications in the USA. 

Available from the Project (tab) > Projects tab: 

  >  

There are two tabs: Text file and Other formats. Choose 
Other formats for .DXF/.DWG, .SHP, .KML/.KMZ, .TIFF, 
MBTiles, Jmtiles, WFSDB, .JPG and .INS files. 

The most common file type is .TXT with the format: 
 PointName, Northing, Easting, Elevation, Code, 
Description 

It is possible to build import file profiles for any text file. 

  

First choose the Point type to import. Entered points are 
design points, Control points are typically site control points 
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and Points to stake are placed in the Points to stake list as 
staking targets: 

  

There are several default Format types: 

  
Or you can use Add format to define custom profiles. 

Default file Extensions include: 

  

Clicking on Add format presents a list builder: 

  

The Selected column defines the expected fields and order. 

If you attempt to import points with Point names that 
already exist, LandStar will prompt with replacement Point 
names or you can choose to Override (replace) the existing 
points: 

  

 

Details: Project (tab) > Export 
Export data writes output files in text or standard formats in a variety of styles. The formats ‘USA FULL: P,N,E,Z,C,D’ or 
‘USA: P,N,E,Z,D’ are the correct format for 99% of applications in the USA. 

Available from the Project (tab) > Projects tab: 
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  >  

Use the  Format button to choose or define (see the Import function above) an export Format and filetype. 

It is possible to choose the types of points to export: 
 Survey surveyed measurements. 
 Enter entered, imported and COGO result points. 
 Control entered or measured Control points. 
 Base Base points that were used during the project. 

Filter -Measurement time allows a sub-set of points by acquisition date to be exported. For example, only points measured 
Today can be selected for output. 

  

Enabling Filter - Keyword: 

  

allows selection by matching Name, Code, Description or just the points measured with a particular Base. Setting a few 
characters for Name will match any Name that starts with the entered characters. For example: Name = ‘P’ will match P12, 
P101, P240, and Pnt100. 
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Click Next to choose a directory location to place, and a Name for the exported file: 

  

Enabling Share: 

  

will prompt for an Operating System share method: 

  

which allows sharing by email, text messages, Google Drive and other supported methods. 

OS Sharing is controlled by the Share method setting, see [ Share method ] on Page 28 for additional information. 

Other formats Export 

LandStar directly exports projects to these additional formats: 

DXF CAD Drawing Exchange Files 

DWG CAD Drawing files 

SHP GIS Shape file 

KML Keyhole Markup Language: exports projects directly into Google Maps 

KMZ Compressed KML, useful for embedding pictures with point and line objects. 
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Detailed result CSV text formatted file containing detailed measurement point information with all 
attributes like coordinates, estimated errors, GNSS related information. 

Survey report 
(HTML) 

HTML formatted file containing detailed measurement point information with all 
attributes like coordinates, estimated errors, GNSS related information. 

Point stakeout 
result 

Includes target points, measured points, and stakeout errors. 

Attribute  
data 

CSV text formatted report containing measured points, line coordinates, and user-
defined GIS attributes. 

Attributes data  
(Excel) 

Attribute data report in Excel format. 

Pipeline survey 
 report 

Pipeline survey report, including the location and burial depth of the pipeline. 

Hydro survey 
report 

Hydro survey report, including measurement coordinates and water depth. 

Polish Cadastral survey reports used in Poland. 

RAW A GPS measurement data exchange file format used in Turkey. 

MosGoGeo-Raw A GPS measurement data exchange file format used in Russia. 

Measurement 
report 

Point survey report for averaged points 

Area report Area survey report, includes both a PDF file and a DXF file. 

Verified survey 
report 

Lists Verified points with all measurement group’s tabulated data. 

Star*Net report 
(.dat) 

.DAT style StarNet import data file. 

Star*Net report 
(.GPS) 

.GPS style StarNet data file. 

Trimble JXL (.jxl) Trimble style XML data file with GNSS vectors for importing into TBC. 
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If exporting StarNet or .JXL files, it is best to enable Record GNSS Vector under Settings > Survey: 
 

  

Details: Project (tab) > Surfaces 
Surfaces can be used in Volume calculations and staked for Cut/Fill. The Surfaces manager allows direct import from CASS 
triangulation files, HC triangulations files, 3D DXF (.dxf) files and LandXML (.xml) files or surfaces can be created from a 
single point or a list of points that define a surface. Breaklines and boundaries are also supported for developed surfaces. 
The Surface manager allows granular control of the triangle networks used to approximate a surface. 

Once a surface is defined or imported, use the Survey: Stake surface tool to stake them. See [ Details: Survey (tab): Surface 
stakeout ] on Page 137 for more information. 

The Surface manger is launched from: 

  >  
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If no surfaces have been defined yet, the manager list will be empty: 

  

Click Open to import an existing surface file: 

  

CASS triangulation files are generated by the South Surveying CASS tool. HC triangulation files (.hctx) are LandStar exported 
surfaces. 3D DXF are standard .dxf files with 3D points from which surfaces are built, LandXML are .xml files with developed 
surfaces. 

Click New to generate a new surface from points available in the Points list: 
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By default, generated triangles are optimized. You can change this behavior by clicking the  3-Dot button on the upper 
right, then Disable triangle-optimization: 

  
Leaving it enabled is reasonable for most point sets. 

Give the new surface a descriptive Name. Points can be selected by: 

  

Selecting from the Point list by checkbox, selecting from the CAD view map, or by specifying a Range points: 

  

If you specify a range of points, you must enter <space><hyphen><space> as the name separator. LandStar names can 
include the hyphen (minus-sign) character. 

Breaklines can be specified by selecting existing lines from the CAD view. Boundaries can be selected by choosing existing 
boundaries from the CAD view. Typically, both will be left unspecified. 

Surface stye can be Wireframe (default) or Shade. The surface color can be manually specified or automatically defaulted 
to the layer color for the first point. 

Click OK to compute a triangular network from the included points, breaklines and boundaries: 

  

The buttons in the Tool tray on the left allow editing of the developed surface: 

  2D, 3D or Map view. 3D allows tilting and spinning the surface. 

  Zoom to view the extents of the surface. 
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  Automatically filter the points used in the network by side length ratio and internal angle ratio: 

  
The Minimum angle and Longest/shortest ratio settings may change the resulting triangles.  

   
 Longest/shortest=10 Longest/shortest=20 
The difference between automatic and manually optimized surfaces typically is very small. 

  Manually add a triangle between two points: 

   

  Manually delete a triangle. 

  Flip the triangle direction: 

  

  Manually add new triangles. 

  Switch from Wireframe to Shaded and choose the Surface color: 
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 Wireframe  Shaded 

   Toggle the Point name and Point elevation on and off: 

  >   >  

Once a surface has been defined in the Surface manager, drag the entry to the right: 

  

to  Delete,  Share to CHCCloud,  Share to Gmail, Messages …,  Change Wireframe/Shading options or  
View. 
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Details: Survey (tab) > Map Survey 
Available from the Survey, Map survey button: 

  >  

Map Survey provides point and line survey with an optional background map. 

  

By utilizing the Quick access tool button  it is possible to perform nearly every survey and stakeout function from this 
single Map Survey screen. 

Back 

Clicking on the Back button  returns to the Main Survey menu. 

Status 
The top Status line: 

  

Is described here: [ Instrument Select & Status information ] on Page 49. 

Point Names 

Points are collected and organized by Point Name. The Point Name box:  holds the name for the 
next point that will be stored next. The Name automatically increments by the Auto increment name interval which can be 
found under Settings: Survey (tab) | Store. 

Some users prefer to use numeric names only: 1001, 1002, 1003. Some users prefer to use names like WTR1, WTR2, WTR3. 
Any format is fine. Names can include numbers, letters, and many symbols other than the space character.  

Since it is possible to enter distances, azimuths and bearings using Point Name Math: “1001,1002/3” (one third the 
distance from point 1001 to 1002) it may be simpler to keep Names simple.  



 96  LandStar 8 User Manual 

Antenna Height  

Clicking  opens the Antenna height menu: 

  

You can enter alternate units, if your range pole is 2 meters and your project units are iFeet or USFeet, enter “2M” which 

will convert to “6.562 USft”. You may need to click the  button to switch from a numeric only keyboard to an alpha-
numeric keyboard. 

The Antenna height menu keeps the 10 most-recently-used antenna heights so that you can quickly switch between 
standard heights. 

Point Code 

Clicking in the Code area  allows you to use a keyboard to enter a point Code. Codes can include 
numbers, letters, spaces and these symbols “@#$_&-+”; other symbols are not allowed. As you type a Code, matching 
Codes will be displayed in a picklist. 

Clicking the down arrow  displays a list of known values from the current Code list.  

You can use the question mark “?” to separate a Code and Description. For example, entering: 

 “RBC?Found rebar with cap” 

results in a point with Code = “RBC” and a Description = “Found rebar with cap”. 

If you enter a new Code, it will be added to the current Code list. Optionally you can automatically add a matching CAD 
Layer.  

The complete project Code list can be maintained from the Main Project: Codes menu. 

Point / Line 

Click on  or  to toggle between storing a point or a line. Once points (vertices) are stored into a line 
feature the Line Control panel will be shown on the map screen: 

 

  Switch to the Drawing manager to switch between active lines. 

  Close the current line to make a closed polygon. 
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  Break the current line, the next stored point will be on a new line. 

  Delete the last Point or Line segment. 

If you are collecting one line or points, you can also switch to another existing line by clicking it on the Map. 

Quick code panel 

To enable the Quick code panel, click on  then | Code and enable Use quick codes: 

  

You can also set the number of Quick code pages which hold 9-codes per page. Click the back button to return to the 
survey screen. 

Below the Point Code box, there is an expandable Quick Code panel area. Click, hold and drag the slider down: 

  

to reveal the Quick code panel: 

  

You can swipe the panel left and right to access multiple pages of codes. Click and hold on a button to change or delete the 
associated Code. 

When you click on a Quick code button the code is applied, a measurement is immediately made using the currently 
selected method (Topographic, Quick or Corner). If Confirm before saving is enabled the measurement confirmation screen 
will be shown. The point number is automatically incremented after a Quick code measurement, leaving the controller 
ready to take another measurement. 

Sharing CODES and Quick Code buttons assignments 

From the Project: Codes function, click the  3-dot button (three dots upper right corner) and Share. This makes a .XML 
file and the file holds all of the current code library AND the Quick Code assignments. The share button also links to all of 
the system sharing options (like GMAIL or MESSAGES).  

On the receiving end, you can use the same  3-dot button and Import from Code Library or you can manually pick the 
shared file when you make a new job. 

The Code Library contains the Quick Code assignments in addition to the CODES. 

Survey mode 
Three Survey modes are selectable using the Survey mode button: 
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  Topographic, usually a 5-second average 

  Quick survey, a 1-epoch measurement 

  Corner survey, only available for receivers with an e-bubble (i80,iG8,i50) 

There are two additional dedicated survey types available from the main Survey menu: 

 Control survey useful for measuring important control points. Utilizes multiple dumps with multiple averages. Will 
abort if predetermined tolerances are not met. 

 Verified survey useful for measuring verified results in heavy canopy where bad fixes are expected. Uses multiple 
dumps, multiple averages, potentially spread over multiple occupations. Post-measurement control of 
used measurement averages with variable tolerances.  

Start measurement 
Click the Start measurement button to take a measurement as determined by the Survey mode.  

 Start measurement 

At the end of the measurement, if Confirm before saving is enabled a screen that confirms and allows additional attributes 
to be entered will be shown. 

Information panel 
At the bottom of the map screen there is a small semi-circle with an up facing arrow: 

 

Click and drag up on this panel to show the Information panel: 

 

You can click on the small corner triangles  to choose the value shown in each panel. The available values are: 

 

If you need additional map space, click on the down arrow: 
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to collapse the information panel. 

Offset survey (hidden point survey) 

  

Available in Map Survey and Point survey. Allows the measurement of a location that cannot be directly occupied. 

These 5 methods allow measuring a hidden point by occupying one or two points, with a variety of offset and direction 
methods: 

  

Each method is described below. 

Most of the offset methods allow you to take a temporary reference point. Clicking the  GNSS acquire button will 
display the GNSS measure dialog: 

  

which allows you to choose an Averaging period and an Antenna height, while showing the current GNSS status (FIX, Float, 
DGPS, Autonomous) and horizontal and vertical estimated measurement error. 

Offset Distances can be manually entered or measured with a rangefinder . 

Elevations of offset points can be entered by: 

 direct entry of the target point elevation “5602.352”. 

 delta elevation from the reference point “-2.342” at the target point. 

 Vertical angle applied from the reference point towards the target point. 

 Zenith angle applied from the reference point towards the target point. 

 Slope 1:N (ratio) applied from the reference point. 

 Slope % applied from the reference point. 
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Point survey: Distance + Azimuth 

  

Measure a hidden point which is a known distance and known azimuth/bearing from the measured point. 

Pick a Reference point by: 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Then specify: 

 Horizontal distance optionally use a laser  rangefinder. 

 Elevation by direct entry, delta elevation from the reference point, Vertical angle: applied from the reference 
point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

 Bearing/Azimuth the direction to offset. 

After specifying the offset parameters, click on Result. A new point dialog with the next available point number selected as 
the Name will be displayed, click Save to accept the point and add it to the Point list. 

Click Result to reach the new point dialog with the computed offset location: 
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed offset point into the project Point list. 

Point survey: Alignment Offset 
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The Alignment offset method allows you to specify a line between two points. The Reference point determines which end 
of the line chainage starts at and can be either the Start point or the End point of the line. An offset right or offset left with 
a specified or offset elevation is then applied. (See the Turned angle distance for an arbitrary offset angle.) 

You can use these methods to specify the Start and End points. 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Then specify: 

 Horizontal station:  this is the distance from the Start point or End point along the line to an intermediate station. 

(Optionally use a laser  rangefinder to set this distance.) 

 Elevation by direct entry, delta elevation from the reference point, Vertical angle: applied from the reference 
point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

 Offset Left or Right 

 Horizontal distance the distance to offset left or right. 

After specifying the offset parameters, click on Result. A new point dialog with the next available point number selected as 
the Name will be displayed, click Save to accept the point and add it to the Point list. 

Note: the Start and End points do not need to be named points or in the Point list. They can be temporary measured 
points, as needed. 

  

Start point: 1001 

End point: 1002 

Horizontal Station: 247.77’ 

Offset Right 

Offset distance: 69.16’ 

New Point name: 3 

New Point description: Offset Point 
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Click Result to reach the new point dialog with the computed offset location: 

  

The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed offset point into the project Point list. 

Point survey: Distance-Distance Intersection  

  

Distance-distance intersection allows the user to select two points, with a distance from each, to specify a 3rd hidden point. 
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You can use these methods to specify Reference point 1 and 2: 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured points. 

Each Reference point has an offset (typically a hand-taped) Horizontal distance. You can optionally use a laser  
rangefinder to measure the Horizontal distance for each position. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

Two projected elevations are derived, one from each Reference point. The average of the two derived elevations will be 
used for the stored point. 

Click Result to reach the new point dialog with the computed offset location: 

  

The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed intersection point into the project Point list. 

Press the Result button to complete the intersection computation, a prevue of the two possible solutions will be shown: 

 

click one of the Target points to select, the selected intersection will be highlighted red. 
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Click the  Green OK button. 

  

The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed intersection point into the project Point list.  

Point Survey: Turned angle + distance (with skew) 
This hidden point procedure allows you to offset a new point, at a distance and azimuth/bearing from a measured point. 

  

You can use these methods to specify the Start and End points of the alignment line: 



 106  LandStar 8 User Manual 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Note: these do not need to be named points nor be in the Point list. They can be temporary, measured points. 

Choose which end of the line (Start Point or End Point) to offset from. 

The Offset direction can be Left or Right of the line, with respect to the direction (Start to End) of the line.  
The offset angle can either be Perpendicular (90 degrees) or Ahead or Behind at a skew angle: 

  
Perpendicular is equivalent to a 90 degree Ahead or Behind angle: 

 
The skew angle is with respect to the direction of the line. 

Offset distance is the distance from the endpoint. You can optionally use a laser  rangefinder to measure the Offset 
distance. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

Click Result to enter the new point dialog with the computed offset coordinates: 

  

The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed offset point into the project Point list. 
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Point survey: ΔX + ΔY + ΔZ 

  
Store a hidden point by picking a Reference point, then offset from the point (in the projected coordinate system space) by 
fixed values. 

You can use these methods to specify the Reference point: 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured points. 

The X and Y offset (typically a hand-taped) Horizontal distance is manually entered. You can optionally use a laser  
rangefinder to measure the X and Y distances. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

Click results to reach the new point dialog. 
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally 
press Save to add the computed offset point into the project Point list.  

Details: Survey (tab) > Point (text) Survey 
Available from the Survey (tab) > Point survey button: 

  >  

The Point survey function is very similar to the Map Survey function (see [ Details: Survey (tab) > Map Survey ] on Page 95). 
However, Point survey has no background map: 

  

Tools available for use with the Point survey - Tool bar are: 

  

The Map Survey Tool can be Selected to quickly switch to the Point Survey (with background map) function. 

Details: Survey (tab): Visual survey 
Available from the Survey (tab) > Visual survey button: 

  >  

This survey tool will capture 2 to 4 cm accurate N, E, Z positions for features that can be seen, but not physically occupied. 
A series of pictures are recorded, processed and then any number of features can be extracted. The processing and feature 
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extraction can be completed in the field or performed later. The vision tasks can be queried for features as needed even 
after the fieldwork has been completed. 

Features further than 15 meters can be captured, however accuracy is best if the distance from the receiver camera to the 
object is less than 15-meters. The path of photo taking greatly contributes to the accuracy of the results. If features can be 
seen in oblique photos, just like an optical survey resection, the results will have a stronger solution. 

A vision enabled receiver like the i93 is required to use Visual survey. 

Click the Visual survey  button from the main Survey menu to get started. 

  

 or Back returns to the Main Project Survey menu tab. 

The current GNSS receiver status is shown on the top receiver information bar . See [ Status ] on 
Page 95 for additional information about the Status bar. 

   

shows the task name that the next Visual survey result set will be stored under. You can change the default name to better 
represent the feature. 

   

The Survey type selects between Visual Survey which is processed on the data collector and 3D Modeling which stores 
pictures in anticipation of processing in the cloud or in external software. Most users will use Visual Survey. 

It is important that the Instrument height  be entered correctly as an accurate IMU initialization is needed to stich 
the acquired images together. See [ Antenna Height ] on Page 96. 

Click the Record button , then a 3-second countdown will begin: 

  

When the countdown completes, begin moving the receiver along the path that you want to record: 
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2-pictures per second are acquired. A minimum of 8 pictures are required to process a task. There is a 60-second maximum 
per task limit. A 5-second minimum recording time is enforced because the processing software may throw out pictures 
that are repeated or algorithmically determined to be defective. Features that you want to capture need to be common to 
at least 3 pictures, so it is best to start before the first feature you want to store and continue past the last feature of 
interest. There needs to be some high contrast features in each of the pictures, so images like sand on a beach won’t 
normally process. 

Hold the receiver pole upright while moving. If the tilt exceeds 30-degrees recording will terminate. Try not to catch the 
pole tip on the ground as you move, it will trip the receiver and recording will terminate. Try to move in a steady flow while 
acquiring pictures. 

At the completion of acquisition, click the Stop recoding  button. Visual survey will save the images to the new visual 
task, then ask: 

  

Click Later if you want to process and select points from the images later, click Now to begin processing immediately. 
Processing will take 2 to 3 time the collection period depending on the speed of the field controller. 

  

When image processing completes: 

  

Click Yes to extract features now. If you click No, you can return to the Image list at any time to extract additional features. 

The Measure dialog will be shown: 
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It is usually best to select the 3rd or higher image (on the top band), zoom into the image (by pinching), place the crosshairs 
on the feature you want to save: 

  

Then click the Select button : 

  

The coordinates, with the estimated horizontal error: 2D Q will be shown. If the measurement is acceptable, click on Save 

 to add the measurement to the project Point list: 

  

Edit the Name, optionally assign a Code and Description, then click OK. 
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Sometimes, you might pick a point to measure and receive a Measure failed message when you click the Select button: 

  >   >   

When this happens, select another image that contains the same point. An orange line will indicate the plane of the point 
you are attempting to measure to assist in zooming in to the same spot on the new image. Click Select and the measure 
should be successfully captured. This procedure binds coordinates to the first image and makes additional locations on that 
image easier to capture. 

All visual measurements will be shown on all the photos where they are visible: 

   

Visual survey Images list 

  

The  button on the Visual survey function is the same as clicking the button from the main menu Project (tab) and 
displays the Images list. All the Project’s Visual survey tasks are listed. 

Click the Delete button  then check the tasks to delete to cleanup unneeded tasks. 
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You can reopen Visual survey tasks to measure additional points in them.  

Tasks that have not been processed will be listed as Unmeasurable. Click on the task, the click Local Process 

 to prepare the task for point selection and make the task Measurable. 

Processing takes about two to three times as long as the recording time. A 15-second image task will take about 30 to 45-
seconds to process. 

Details: Survey (tab): Control survey 
Available from the Survey (tab), Control survey button: 

  

The Control survey tool automates acquiring multiple groups-of-averages, automatically resetting the GNSS engine 
between groups, and performing statistical combination of the measured epochs.  

The intended use of the Control survey tool is to acquire very reliable coordinates under open canopy where the receiver is 
expected to never encounter a bad fix. The Verified survey is better suited for locations where bad fixes or the inability to 
fix may be encountered. 

The Control survey function differs from the Verified survey function: 

• Control survey is intended for use in open canopy where there will never be a ‘bad FIX’. 

• Control survey does not allow post collection group selection. If a bad-FIX is encountered, the entire control point 
must be recollected. 

• Verified survey is intended for use in heavy-canopy where bad FIXs are expected. 

• Verified survey will automatically pause if the constellation quality degrades or a bad-FIX is encountered. Control 
survey will stop and abort if the tolerance conditions are not met. 

It is not possible to add additional measurement groups to a Control survey, it is easy to add additional measurement 
groups to the Verified survey. 

Control survey operation 

Click the  button on the main survey menu: 
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When you first enter the Control survey, first click the Options  button, the settings will be shown: 

  

Number of passing measurements to acquire. Each group is separated by a GNSS engine reset and the Wait after fixed 
time. 

Each group will include Point per measurement group points. 

Each point will include Number of epochs per point epochs. (An average of averages is collected.) 

Groups with a horizontal range greater than Group horizontal range tolerance will be remeasured automatically. 

Groups with a vertical range greater than Group vertical range tolerance will not be remeasured automatically. 

If the receiver reports a Hrms value higher than the Epoch maximum Hrms, collection will wait for a lower Hrms. 

If the receiver reports a Vrms value higher than the Epoch maximum Vrms, collection will wait for a lower Vrms. 

Wait after fixed is the time that collection waits after the receiver acquires a fixed solution after the receiver is reset.  

Max PDOP is the maximum Position Dilution-of-Precision allowed before collection is paused. 

Between each measurement group, the GNSS engine is reset. This forces the receiver to completely reacquire a new 
position. After the receiver reacquires satellite tracking, resolves ambiguities, receives corrections, and computes a FIXED 
solution, group collection waits an additional Wait after fixed time before starting to acquire epochs. This is intended to 
allow the receiver to further stabilize to a more accurate value. 

Percent of pass is a confidence interval specification for the statistical reliability of the final result. 

After configuring the Control survey specific settings, enter (or accept the default) Point name and Code:  

  
Double-check the Instrument height: 

  
The IMU is always disabled during a Control survey. 

At the bottom of the map screen there is a small semi-circle with an up facing arrow: 
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Click and drag up on this panel to show the Information panel: 

  

See [ Information panel ] on Page 98 for details on how to customize this panel. 

Finally click the Begin survey  button to start acquiring measurement epochs. The Control survey will start following the 
rules established in settings. Information on the progress of the Control survey is updated continuously: 

    
At the conclusion of the Control survey a detailed report on the measurements is saved to the job folder: 
 /storage/emulated/0/CHCNAV/LS7_Projects/_jobname_/Control report/pointname_yyyymmddhhmmss/ 

Two files are created. An .HTML report and a .CSV detailed result data file. 
The completion dialog will be shown after the reports are saved: 

  
Click Open report to view the report: 

  
The report includes a list of every measurement with deviations from the final averaged coordinate in both projected 
(N,E,Z) and geographic (L,L,H) coordinates. 
The final computed position is added to the Point list with a unique point icon: 

  

Details: Survey (tab): Verified survey 
Available from the Survey (tab), Verified survey button: 
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The Verified survey tool automates acquiring multiple groups-of-averages, automatically resetting the GNSS engine 
between groups, performing statistical and graphical analysis of the results to reject bad-FIX and average good-FIXED 
measurements.  

The intended use of the Verified survey tool is to acquire very reliable coordinates under extremely heavy canopy where 
the receiver is expected to encounter many bad fixes. 

The Verified survey function differs from the Control survey function: 

Control survey is intended for use in open canopy where there will never be a ‘bad FIX’. 

Control survey does not allow post collection group selection. If a bad-FIX is encountered, the entire control point 
must be recollected. 

Verified survey is intended for use in heavy canopy where many bad FIXs are expected. 

Verified survey will automatically pause if the constellation quality degrades or a bad-FIX is encountered. Control 
survey will stop and abort if the tolerance conditions are not met. 

Verified survey makes it easy to add additional groups later, perhaps over several days. 

Verified survey allows inspection and post inclusion/rejection of groups. 

  

Verified survey generates real-time horizontal and vertical plots that show acquisition progress.  

    

Plots are also available for post analysis of the included measurement groups. 

   

Verified survey operation 

Click the  button on the main survey menu: 
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The Verified survey screen has a group summary area: 

  

The drag bar at the bottom of the summary area can be moved up and down as needed to view the entire summary. 

The Group shows current group / initial number of groups. The current group will be larger than the initial number of 
groups if you decide to collect additional measurements after the initial collection. 

Points is the current number of points / target point count, for the current group. 

Hrms Vrms are the current horizontal and vertical estimated errors reported by the receiver. 

PDOP is the current Position Dilution-of-Precision reported by the receiver. 

DIFF age is the correction latency (the number of seconds since a valid correction was received by the receiver) reported by 
the receiver. Typically, it will be less than 3-seconds. 

H σ is the standard deviation of all the included horizontal epochs taken for the current point name. 

V σ is the standard deviation of all the included vertical epochs taken for the current point name. 

H Range is the horizontal range of included measurements taken for the current point name: 

  

V Range is the vertical range of included measurements taken for the current point name: 
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When you first enter the Verified survey, first click the  Options button, Survey settings will be shown: 

  

Nominal Number of measurement groups to acquire. Each group is separated by a GNSS engine reset and the Wait after 
fixed time. 

Each group will include Point per measurement group epochs. 

If the receiver reports a Hrms value higher than the Epoch maximum Hrms, collection will wait for a lower Hrms. 

If the receiver reports a Vrms value higher than the Epoch maximum Vrms, collection will wait for a lower Vrms. 

DIFF age is the maximum correction latency allowed before collection is paused. Typically, GNSS measurements with higher 
differential age have lower accuracy. 

Max PDOP is the maximum Position Dilution-of-Precision allowed before collection is paused. 

Between each measurement group, the GNSS engine is reset. This forces the receiver to completely reacquire a new 
position. After the receiver reacquires satellite tracking, resolves ambiguities, receives corrections, and computes a FIXED 
solution, group collection waits an additional Wait after fixed time before starting to acquire epochs. This is intended to 
allow the receiver to further stabilize to a more accurate value. 

Note: Show E-Bubble: enables the E-Bubble on the display screen. This is only applicable to receivers with an E-Bubble or 
an IMU like the i50, i80, i70. I90, i93, i73, i83, iG8, iG9. The E-bubble is not related to the IMU which is forced inactive for 
Verified survey. 

After configuring the Verified survey specific settings, enter (or accept the default) Point name and Code:  

 
Double-check the Instrument height: 
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The receiver IMU is always disabled for Verified survey, it is important to carefully level the receiver. 

Finally click the  Begin survey button to start acquiring measurement epochs. The Verified survey will start following the 
rules established in settings: 

 

Click the  button while points are collected to display scatter plots for the horizontal and vertical measurements: 

 

At the conclusion of the last automatic group, click the Edit last point  button to display the results of the Verified 
survey: 
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Select the 2nd tab Average to view the results of each collected group: 

  
Drag the top section right and left to reveal the report columns for the measurement groups: 

  

Enable and disable group contributions to the average by checking and unchecking the H and V . 
Use the H Res and V Res values to find bad FIXes and remove them from the final computed point.  

Sort the groups by clicking on the sort icon  at the top of each column. 
The bottom portion of the Average tab has three panels.  
Switch between the panels by swiping left and right: 

 <>  <>  

These panels reflect only the included  measurement groups, they automatically update as groups are included and 
excluded in the group table.  

Adding additional measurement groups to a Verified survey 
After a Verified survey operation successfully stores a result into the Point list, you can add additional measurement 
groups. 
Reoccupy the mark, then return to the Verified survey screen and either type in the same Point name or click on an existing 

Verified survey point then click on  Begin. LandStar will verify that you want to add to the existing point: 

 
If you have already collected the Number of measurement groups specified in the Verified survey options but would like to 
automatically collect several additional observation groups, return to Options and set the Number of measurement groups 
to the new desired total.  
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When you click on  Begin automatic group collection will continue until the new desired number of groups has been 
reached. 

Verified survey screen details 

  

Back 

Clicking on the Back button  returns to the Main Survey menu. 

Status 
See [ Instrument status ] on Page 49 for detailed information on the status and information screens. 

Point Names 

Verified survey points groups are collected and organized by Point Name. The Point Name box:  

holds the name for the group that will be collected when the Start measurement  button is pressed.  

Unlike other survey modes, the Name does not automatically increment, this facilitates collecting additional groups into an 
existing averaged point. 

Antenna Height  

Clicking  opens the Antenna height menu. See [ Antenna Height ] on Page 96 for additional information. 

Point Code 

Clicking in the Code area  allows you to use a keyboard to enter a point Code. Codes can include 
numbers, letters, spaces and these symbols “@#$_&-+”; other symbols are not allowed. As you type a Code, matching 
Codes will be displayed in a picklist. 

Clicking the down arrow  displays a list of known values from the current Code list.  

You can use the question mark “?” to separate a Code and Description. For example, entering: 

 “RBC?Found rebar with cap” 

results in a point with Code = “RBC” and a Description = “Found rebar with cap”. 

If you enter a new Code, it will be added to the current Code list. Optionally you can automatically add a matching CAD 
Layer.  
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The complete project Code list can be maintained from the Main Project: Codes menu. 

Real-time plot 

   
While groups are being collected it is possible to display real-time result plots. These plots show all of the enabled 
measurement epochs. (You can disable groups in the Edit Point, Average tab.)  

When showing the map screen, clicking the  button will switch to the combined horizontal and vertical scatter plots: 

  

clicking the  button will switch to the vertical timeline plot: 

  

then clicking the  will return to the point display map: 

  
On these plots, the blue ellipse and background are 1-sigma, and the green ellipse and background are 2-sigma indicators. 

Start / stop measurements 
Click the Start measurement button to begin acquiring epochs for the next group.  

  Begin measurements 

After measurements have started, the button changes to: 

  Stop measurements 

Clicking Stop measurements aborts the current measurement group after a confirmation. 

Information panel 
See [ Information panel ] on Page 98 for additional information on the Information panel: 
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Details: Survey (tab): Point Stakeout 
‘Staking out a point’: using assisted navigation to move to a point’s known coordinates so the location can be marked by a 
stake, flagging, paint, whiskers, or other monument. Point stakeout provides a horizontal position and the deviation 
(cut/fill) to a target elevation. After setting a monument, typically the ‘set’ location is stored as an ‘as staked’ position for 
verification. 

Offset staking allows you to stake a point that is offset from the selected point. There are several methods to specify an 
offset in LandStar. 

There are several ways to begin the stakeout process. From the Survey (tab), Point stakeout button: 

   

Then manually click in the Point to stake box and select a point to stake. The Stake point menu has many of the same 
features and buttons as the Point survey menu. 

  

Clicking on the Back button  returns to the Main Survey menu. 

Clicking icons on the top receiver information bar  displays status information about the currently 
connected receiver. See [ Status ] on Page 95 for information on the receiver information bar links. 

The Point to stake box  displays the Name, Code and Description of the point that is currently being 
staked. If the Name, Code and Description are too long to be shown in the box, click and hold inside the box to expand 
them:  

  

Clicking on the  button displays the Point list or Point to stake list allowing an alternate target point selection. 

Clicking  opens the Antenna height menu. See [ Antenna Height ] on Page 96 for details on entering and selecting 
the Antenna height. 
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The Name box  displays the Name that will be assigned to the measurement that will be collected when 

the Begin measurement  button is pressed. The default staked Name is controlled by Settings: Stakeout (tab): Point 
name prefix.  

The Code box  lists the Code that will be associated with the new measurement. Clicking  displays the 

full Code list. Clicking the  opens the keyboard and allows you to type in the first few characters of the desired Code. 

Clicking the  button allows picking the code from the MRU (Most Recently Used) list. 

The Target Information panel can be swiped left and right: 

  <>  

The left panel shows the distance forward/reverse and left/right based on the direction the Android device is facing. The 
right panel shows the North/South and East/West distance. 

The Staking control buttons  include: 

  Cancel stakeout operation. 

  North reference: 

 

  toggles the Navigation compass on and off: 

 

The compass shows the current direction of travel, the target and a North reference. 

  Collapse the Staking control buttons. 

A simple Scale bar  is shown in the upper-right corner of the map. 

The Stake next, Auto-nearest, and Stake last controls  allow switching to the previous , next 

 points from the Point list or Points to stake list. The Auto nearest toggle, when depressed, will 
automatically switch to continuously staking the nearest point to the current position. 

The Information panel can be expanded to display real time coordinate 
information. See [ Information panel ] on Page 98 for details. 

Storing the results of the Stakeout 

Click on  Start measurement button to measure a point at the current location.  
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The stored point will include the stakeout offsets and cut and fill value from design (Staked) point to the measured point. 

Auto description for staked points 
When you stake a point, the description of the new staked point can be automatically populated, or it can be left blank for 
the operator to manually fill out. 

To control the Auto description, go to Software settings > GNSS > Stakeout (tab) > Auto description > 

  

Click on the > button: 

  

Move the  slider to the right to enable Automatic descriptions: 

  

Highlight an Item line, then use the  Up and  Down buttons to change the order of items. 

Highlight an Item line, then use the entry box at the bottom to modify the Prefix, click the  Update button to commit 
change.  

The  On/Off checkbox enables / disables the highlighted item. 
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Visual Stakeout 

If the current device is a visual receiver like the CHC i89 and i93, an AR (Augmented Reality) button will be shown on 
the map screen. Click on this button to enter the AR mode.  

Once activated the AR button will change color:  to indicate it is enabled. 

Your data collector must be connected to the receiver by 5 GHz Wi-Fi (not Bluetooth or 2.4 GHz Wi-Fi) for the Visual survey 
and Stakeout functions to work. 

  

In Options  on the Stakeout tab, under miscellaneous there are Distance to switch to Visual Stakeout (Near) and 
Distance to switch to Visual Stakeout (Far) settings. Setting the Near distance to 8 to 25 feet is reasonable. Setting the Far 
distance between 50 and 300 feet or more is reasonable. Your settings may depend on site terrain and personal 
preferences. 

If you are further than the Far distance, LandStar will show the map screen with optional map backgrounds. If you are 
between the Near and Far distance, LandStar will show the front facing camera. Once you reach the Near distance from the 
stakeout point, the bottom facing camera will be shown. As you move closer to the point being staked, the view will 
automatically zoom in to better show the target point on the ground. 

: 

    
 Map screen   Front Facing camera view  Bottom facing camera view 

A virtual pole is overlayed on the image (usually on top of the data collector bracket and your hand) to assist visualizing 
where the pole point is. The number of blue arrows is proportional to the distance to the target.  
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The distance, cut fill along with the ΔX, ΔY or forward/left/right (depending on the panel settings on the map screen) are 
updated continuously: 

  

When the pole tip is within the staking tolerance, a green target will be shown centered under the pole tip: 

  

Click on  Start measurement button to measure a new point at the staked location.  

Click on  Close (top right corner) to return to standard non-visual Point stakeout. 

Click on the  Back button (top left corner) to return directly to the Main menu. 

Additional methods to begin staking out a point 
There are many other ways to initiate a point stakeout operation. 

You can begin Point stakeout from the Point list. 



 128  LandStar 8 User Manual 

  

Slide the point you want to stake to the right, then click the Stake button . The Stakeout point function begins 
immediately with the selected point as a target. Next and Last buttons will move through the list where stakeout was 
started. 

You can build a Points to stake list: 

  

The Points to stake list is on the right-hand tab of the Point list.  

Points can be directly  Import and  Exported to the Points to Stake list. 

Once staked, the stake icon  will disappear and the point won’t be available for staking from this list.  

This staked status can be reset using the  Reset stakeout state option at the top of the menu. 

To import points, click  Import: 
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Points to stake: sets the destination for imported points. 
Point type: where to import a file to (Points, Control points, Points to stake). 
Format: normally choose the “USA FULL: PN,N,E,Z,C,D” format with .CSV extension, which includes the Name, Code and 
Description for each point. This format best matches the standard Export function. 

Points to stake > Export file dialog: 

  

Oftentimes the same points will need to be staked multiple times: pre grading, post grading, post compacting, post paving, 
post sealing. There may be a time savings by saving a Points to stake list using the Export button which allows future 
import. 

You can specify the Path and Filename and file Suffix (extension). 

The normal order for the USA matches the USA FULL Import format (above): 

  Name, North(N), East(E), Elevation, Code, Desc 

Click the Export button to write the Point to stake list. 

From the CAD view you can directly stakeout a point or object end, mid or intersection point: 
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From CAD view, (1) click on a point/object to select it. Then (2) click on Stakeout. 

Offset Staking a Point 
LandStar supplies several methods to offset-stake a point: 

Distance + Azimuth: offset a distance in a specified grid direction. 

Alignment Offset: offset at right angle (left or right) from a point, using a second point as alignment. 

Turned angle + distance: offset at arbitrary angle (skew ahead, skew back), using a second point as alignment. 

Δ X + Δ Y + Δ Z: grid offsets from the reference point. 

To begin Point stakeout with an offset, enter the Point stakeout menu. 

If the  Offset stakeout tool is not available in the Tool tray, click on Setup button , then on the Tools tab 
highlight and Select the Offset stakeout tool. Consider dragging it to the top of the tool tray if you plan to use it often. Click 
Back to return to the Point stakeout menu. 

Click the Offset stakeout button, then select the Method: 
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  Distance + Azimuth         Alignment Offset                       Turned angle + Distance           Delta X, Y, Z 

Use one of these methods to specify the Reference point: 

  pick an existing point or object (with snap) from the CAD view. 

  take a GNSS measurement. 

  choose an existing point from the Point list. 

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured or Any 
snapped points. 

Distances are entered directly, or you can optionally use a laser  rangefinder to measure them. 

Elevations can be entered directly or as a Δ Delta elevation from the reference point, by Vertical angle, Zenith angle, Slope 
(1:N) ratio or Slope (%) percentage: 

  

Details: Survey (tab): Line/Arc stakeout 
Available from the Survey (tab), Line/Arc stakeout button: 
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Line/Arc stakeout allows the selection of a line, arc, polyline, object to stake. The line can then be staked to the nearest 
point-on-line, endpoints, node-points, random and even stations along the staked object. Offsets can be added by Left, 
Right, Ahead, and Behind. Visual staking is supported for receivers with internal cameras (like the i89 and i93.) 

A variety of Tool buttons can be customized on the left edge of the survey screen to allow for quick access to additional 
functions and settings. 

  

To enter a Line/Arc stakeout without a selected line, there are a variety of selection methods. 

Click on  to select a line from the Line / Arcs list . 

Click within the Line name box:  to enter a Named Line/Arc. This will auto fill a pick-box with 
matching line/arcs. 

Click directly on a displayed line on the map to select it: 

  

Once you select a line to stake, additional Line / Arc stakeout functions and information will be shown: 
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The Status bar is described [ Status ] on Page 95. 

The Staked line box  shows the name of the target line/arc for the current staking operation. 

The Instrument height box  shows the current HI and can be clicked to modify. See [ Antenna Height ] on Page 96 
for additional information. 

The Augmented reality  button will enable and start the Visual line stakeout operation. 

  turns the IMU Tilt correction on and off. 

  stores a measurement at the current location. 

When in the Station and Offset staking  mode, the  arrow keys move the target station forward and 

backwards along the current line using the Station interval. Click the button to advance the target to the nearest 
station to your current location.  

When in the If you are in the Node staking  mode, the  arrow keys move the target station forward 
and backwards through the Node list. Midpoints of line segments are included as nodes in addition to the endpoints of 

each segment. Click the button to advance the target to the nearest node to your current location. The Node list 

 button displays a list of all nodes on the currently staked line. 

When actively staking a line or arc, the Line staking menu will appear: 

  

  cancels the current line stakeout. 

  chooses the North reference for map and offset distances. 
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  toggles the Staking compass on and off: 

   
ON Dist   Tolerance  Off 

Clicking  reverses the direction of the current line, arc or polyline. 

When a target is active, select between four status display by swiping left and right: 

Distance, target station, forward/back, left/right, cut/fill, current elevation: 

  

Distance, target station, north/south, east/west, cut/fill, current elevation. 

  

Distance, target station, offset (-left), cut/fill, current elevation: 

  
Distance, target station, distance from start, distance to end, cut/fill: 

  

Activating Visual stakeout results in the currently selected status display being shown overlayed on the real-time image. 

The Station  shows the current station along the selected line/arc/polyline. Click it to directly enter a 
new target station. If you enter a non-even-station-interval value, clicking Next and Last will apply the station interval to the 
current value. 

The Line Stake method button shows the current staking method. Click it to change the current line staking method: 

  Station and Offset Right/Left/Ahead/Behind. 

  To line with Offset Right or Left. Random or nearest point on a line. 

  Node (segment end and mid-points) with optional offset Right/Left/Ahead/Behind. 

Line / arc stakeout settings 

Station and Offset  
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Select the method from the 3 radio-buttons at the top. 

Station & Offset runs through the line, arc or poly-line segment at specified Station intervals. 

Start station is the chainage to apply to the beginning of the line. It typically is set to 0. 

The Station interval is the chainage to move ahead or back along the selected alignment. 

Offset can be Left or Right at a 90° (Perpendicular) or skewed Ahead or Behind the target point at an arbitrary angle 
referenced to the staked line. 

The Offset distance can be entered using unit overrides. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

To line  
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Select the method from the 3 radio-buttons at the top. 

To line continuously adjusts the target location to the nearest point on the selected line, arc or polyline to the current 
position. 

Start station is the chainage to apply to the beginning of the line. It typically is set to 0. 

Offset can be Left or Right at a 90° angle referenced to the staked line. 

The Offset distance can be entered using unit overrides. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

Node 

 

  

Select the method from the 3 radio-buttons at the top. 
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Node runs through the line, arc or poly-line segment endpoints and midpoints. 

Start station is the chainage to apply to the beginning of the line. It typically is set to 0. 

Offset can be Left or Right at a 90° (Perpendicular) or skewed Ahead or Behind the target point at an arbitrary angle 
referenced to the staked line. 

The Offset distance can be entered using unit overrides. 

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the 
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point. 

Details: Survey (tab): Surface stakeout 
Available from the Survey (tab), Surface stakeout button: 

   

Surface stakeout accepts a surface to stake, then displays the cut or fill required to move the receiver up or down to the 
design surface. The delta is updated continuously as the receiver moves around. Surfaces can be defined by a single point; 
by three or more points (technically two-points would work, however an unintentional tilted-plane will result); importing a 
CASS triangulation file, a 3D DXF File or a LandXML file. 

You can either use the Project > Surfaces tool to predefine a named surface, or you can define the surface when Surface 
stakeout is initiated. 

When you enter surface stakeout, if no surface has been previously selected, you will be prompted to Open / import an 
existing surface file or create a New surface. Clicking New will bring up the New surface dialog where you can Name the 
surface and choose one, three or more points to define a surface. 

From the Surface stakeout list: 

  

Click Open to open an existing surface: 

  

Click New: 
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then selecting a single point:  

  

For a Surface named TargetSurface: 

  

Will show the surface stakeout map screen 

  

The Status bar is described [ Status ] on Page 95. 

The Staked surface box  shows the name of the 
target surface for the current staking operation. Click in 

the Name box  to manually enter a 
new surface name. 

The Instrument height box  shows the current 
HI and can be clicked to modify. See [ Antenna Height ] 
on Page 96 for additional information. 

The Surface stake status box: 

  

Shows the current elevation, the design elevation and 
the cut or fill. Fill will have a green background, Cut will 
have a red background. 

Click on the  Panel button, in the Tool tray, to display 
a large cut/fill panel: 

  

See [ Panel (surface stakeout) ] on Page 47 for additional 
information.   

Click on  Begin measurement to store a new 
measurement. Points stored from the Surface stakeout 
menu are collected in a surface staked list and can be 
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exported using the  Export Surface staked report 
button. Two files are written to a user selected folder: 

 .csv containing: Name, Northing, Easting, 

Design elevation, Elevation, DeltaH, 

Date_time 

 .txt containing: Name, Northing, Easting, 

Design elevation, Elevation, DeltaH, 

Date_time 

Click the Options  button, then select the Surface 
stakeout (tab) to change the stakeout settings: 

  

Voice (Sound) prompt enables a ding-ding-ding sound 
when the cut/fill delta is less than the Tolerance. 

Tolerance determines when the sound is active. 

Display cut/fill in fixed solution only disables cut/fill 
display when the receiver is not fixed. This prevents 
float, DGPS and Autonomous height measurements from 
being erroneously treated as valid heights. 

 

Details: Survey (tab): Area survey 
Available from the Survey (tab), Area survey button: 

   

Area survey allows the collection of polygons representing the edges of a region. During collection either 2D or 3D area and 
2D or 3D perimeter length are displayed. Once a region is complete, it will be displayed with 2D/3D area and perimeter. 
The areas can be exported to a PDF report showing the area   and DXF drawing file. 

When you enter the Area survey method, an area and length information bubble is shown at the top of the screen: 

  

a toolbar with an Undo and Accept region button is added to the map screen: 

  

and a Region list tool is added to the Tool tray: 

  

Click the Start measurement button  to take a first point measurement using the averaging time determined by the 

Survey mode  Topographic or  Quick survey. 
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Continue taking measurements at the corners of the region until the last side is pending. On a rectangular building this will 
be after the 4th measurement: 

  

As each corner is acquired and as you dynamically move, the information panel will update with the Area and Length.  

The Next point  display shows the point count of the next vertices. 

You can click on the  or to switch between 2D and 3D. 

The Undo button  will remove the previous vertices. 

After storing the final vertices click the Accept region button to complete the current region. The Area properties dialog 
will be shown: 
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The Type is always set to 3D polyline. 

You can set the Name as desired. 

If you leave Code blank, then the Border color, Line width, Fill color and fill Transparency will control the default (blank) 
code and all regions will share the default selections.  

If you specify a Code then the Border color, Line width, Fill color and fill Transparency are applied to all regions with the 
same Code. 

Note that the default Transparency is 100% or NO FILL. 

The checkboxes  determine which text labels appear in the center of the region.  

The Text line is rendered under the last line of area/perimeter text. 

Once you complete a region, it is not possible to edit or add points to the region. 

You can edit these properties by clicking on the region boundary line, then clicking the Properties  button in the Tool 
tray. 
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Clicking the Region list  button in the Tool tray displays the Regions list: 

  

You can Delete or Export selected regions from this list. Slide a region to the right and click on the  button to enter the 
CAD view and center the selected region on in view. 

If you export a region or a group of regions, two files will be created. A .DXF with all selected regions as closed polyline: 

   

and a .PDF with one region per page: 

    

Details: Survey (tab): CAD View 
Available from the Survey (tab), CAD view button and from the Tool tray of many survey methods: 
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  >  

CAD View switches to a CAD style interface with a rich set of drawing, editing and measuring functions. Also available from 
the Tool tray and called by viewing shortcuts throughout the LandStar program. 

  

The  Current position cursor shows the current GNSS or prism position on the map. You can change this icon’s style and 

color from Settings : Miscellaneous: GNSS position symbol and color. 

The CAD view Tool tray is fixed and cannot be edited. The arrow points in the direction the PDA is pointed, not the receiver. 

The imported CAD Hide/Show button  toggles the visibility of CAD objects that are imported by reference. The DXF 

import button  allows you to search the device for .DXF and .DWG CAD file types to import. You can list the attached 

files from Layers > Map files (tab) using the Layers button , see [ Map files (tab) ] on Page 83 for additional information. 

The  Hide / Show button toggles all point and line work display on and off. This allows quick inspection of your current 
position over a background map or drawing.  

The Full view  button zooms out to show all drawing elements.  

  regens and reindexes the drawing which may result in faster updates. 

  pans the map to place the current GNSS or prism location at the center of the display. Toggles ON and 
OFF when clicked. 

  Toggles Follow (rotate) ON and OFF. When ON the CAD drawing is rotated to match the direction of the 
PDA. This function uses the internal compass of the PDA. 

Action bar 

At the bottom of the screen is an Action bar. If there is no point, line or feature selection: 

  

If a point, line or feature is selected (by clicking or with the  Snap tool) then the Action bar changes: 

  



 144  LandStar 8 User Manual 

Action bar: Data 

Clicking on  Data: 

   

  Delete: select one or more objects or a rectangular area to delete. 

  Export DXF: export the entire CAD drawing to a .DXF file. 

  Layers: display the layer manager. 

  Off other layers: click an object, it’s layer will remain visible, all other layers will be hidden.  

  Layer off: select any object, its layer will be hidden. 

  Save point: click a DXF object; all points on the same layer will be saved to the point list.  

  Explode: all blocks loaded as DXF layers will be exploded. 

Action bar: Draw 

Before clicking  Draw on the Action bar, click and hold the  Snap tool: 

  

and make sure the snaps are set to allow point selection. Then when you click on  Draw: 

   

and choose a drawing action, you will be able to select the desired features. 

  Create a new Point. Click on an object endpoint, intersection as determined by Snap to create a new 
point. 

  Create a Line segment. Click on the first and second point or a pair of snappable features to create a 
single segment 3D line. 
When a line is created, the Line dialog will be shown: 
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Enable Display line dimensions and the new line will have Length and Bearing annotations added at the 
center: 

  
The text annotations are not connected to the line, they are separate static text fields. 

  Create a Polyline. Click on several (more than one) points or a series of snappable features to create a 
polyline. 

  3-point Arc. Click on three points or snappable features to define an Arc. 

  Center + radius Circle. Click on the center point, then enter a radius to draw a circle. 

  2-point Circle. Click on two points to draw a circle. 

  3-point Circle. Click on three points to draw a circle. 

  Layout – plot deed. Select a starting point, then enter a series of metes-and-bounds descriptions to 
describe a traverse (typically around the perimeter of a parcel.) This function includes an advanced 
curve calculator and allows non-tangent arc descriptions. See [ Details: Tools (tab): Plot Deed ] on Page 
201 for a detailed example. 

  Click to add Text (starting at the lower-left text corner) at any clickable point or snappable feature. The 
size of the text is proportional to the scale. If you zoom in and draw text, the text size will be small. If 
you zoom out and draw text, the text size will be large. 
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Action bar: Measure 

Clicking on  Measure: 

   

Allows measurements between clickable features and objects. 

  Inverse returns the distance and bearing between two points or a point and the { endpoint, midpoint, 

nearest point } on an object, like a line. Click and hold the  Snap tool to configure the object snaps 
to help choosing points. 

  Multi-inverse returns the distance and bearing between a series of points or clickable features. The 
results are presented in a table that lists the total length and the incremental traverse bearings and 
distances. 

  Angle computes the included and excluded angle between three points or clickable point features. 

  Area computes the included area enclosed by a series of points or clickable point features. After the 
last point is added, the total perimeter and enclosed area is displayed. Optionally, the selected region 
can be added to the Area list with a Name, Code and attributes which will be displayed on the map. 

To edit the region, click on it, then select  Properties. Alternatively go to Area survey, click on the 
Region list button. Area regions can be exported using Project > Export > Other formats (tab) and 
choosing Format = Area report. 

Details: Survey (tab): Site calibration 
Available from the Survey (tab), Site calibration: 

   

Site calibration allows modification of the underlying coordinate system so that Measurements (GNSS points) best match 
record (Known point) data. Horizontal and vertical calibrations can be combined or handled separately. Site calibration 
makes the GPS receiver use local coordinates. 

Site calibration makes the GPS receiver display and use local coordinates instead of the default projected coordinates 
which are typically State Plane Coordinates. This allows following an existing survey honoring measured distances and 
bearings. 

 If there is only one point to calibrate on, it may be better to use Project > Single point localization to 
establish local coordinates, at ground. A single point localization can have a Geodetic (True North), match the 
underlying State Plane Coordinate system (the Projected system) or have an arbitrary rotation. See [ Details: 
Project (tab) > Singe point localization ] on Page 68. 

Prior to performing a site calibration, you may want to enter points for the Known point (Local) positions. If you only have 
meets and bounds (distance and bearing calls); use the Tools > Plot deed tool to convert distance and bearings to Known 
point (Local) coordinates. Then you can associate some GNSS measurements with these Known points to build a 
Calibration. 

A localization consists of a list of Point pairs. Each pair associates a GNSS position with the Local Known Point Coordinate. If 
the Known points are well represented by the GNSS locations, then a calibration with low residuals can be computed and 
activated. 

Points don’t need to be entered prior to performing the calibration, they can be entered while building a new calibration. 
GNSS measurements don’t need to be stored prior to performing a calibration, they can be occupied while building the 
new calibration.  

It is also possible to import calibrations from other field tools (.loc files) directly. 
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Click on Site calibration from the Survey menu to enter this menu: 

  

If a calibration has already been defined, it will be recalled and displayed. If this is a new project, the empty calibration 
screen shown above will be shown. 

Click Add to enter the first GNSS point – Known point pair: 

  

The GNSS location is entered at the top, the Known point (Local) is entered at the bottom. Both values can be recalled from 

the Point list or hand entered. The GNSS point can be measured  using the current position of the connected GNSS 
receiver.  
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Clicking Save & Continue will save the current point pair and allow entry of another point pair. When you have entered the 
final point pair, click on Save to return to the Site calibration menu: 

  

Each of the point pairs will be displayed with the GNSS point number, the Known point number, the Horizontal residual and 
the Vertical residual. Use the checkboxes to control each point pair’s contribution to the Horizonal and Vertical solutions. 

Slide a Point pair line to the right to Edit and Delete the pair: 

  

LandStar allows three types of Vertical adjustments: 

  

 Inclined plane used when the polygon connecting all the calibration points fully encloses the entire project. DO NOT 
use the Inclined plane with fewer than 4 vertical control points. DO NOT use Inclined plane without a 
GEOID if the project is large enough to have significant GEOID separation changes over the project. 

Constant Adjustment adjusts the vertical measurement plane (Ellipsoid if no GEOID is loaded, Orthometric if a GEOID is 
loaded) up or down to best fit the vertical calibration points. 

 Surface Fitting fits a Quadratic surface fitting with nodes at the entered calibration points. Typically used when many 
elevation calibration points are available spread over the entire project. Like the Inclined plane method, 
this is best used when there are calibration points that enclose the project. 

Note that it generally is better to always include a GEOID file in your coordinate system and then allow the vertical 
calibration method to work with the GEOID adjusted, orthometric heights.  

Click the  button at the top-right to: 

  Toggle between the Guide mode which provides more prompts for calibration point entry and the 
Simple mode. 

  Export the current calibration configuration to a file. This can be used to share a calibration with 
another job or another crew. 

  Import a complete calibration system. Carlson .LOC files are supported. Two points will be added to the 
project for each imported calibration point with the imported point names. The primary point (like 
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10002) will have the Lat/Lon/Ellipsoid Height from the localization file, the secondary point (like 
10002_1) will have the local coordinates (Northing, Easting, Orthometric height). 

Click the Graph view button  to display a preview of th: 

    
 Known points   GNSS points 

The current calibration scale factor is shown at the bottom.  

  

This value depends on the underlying projection (typically a SPC Zone in the USA), Grid scale factor (location dependent), 
the Height above Ellipsoid and the precision of the known points. A Scale Factor lower than 0.999 or higher than 1.001 is an 
indication that something may be wrong. 

Click  Results to view a summary of the resulting transformation: 

  

When you are satisfied with the calibration, click on Accept, then OK the calibration: 
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The resulting Horizontal adjustment will be fully described on the Project > Coordinate system > Horizontal adjustment 
(tab): 

  

The computed Vertical adjustment will be fully described on the Project > Coordinate system > Vertical adjustment (tab): 

  

Clicking the  button allows you to share, Lock, Export and Load the complete system: 
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Create QR code displays a QR code that another user can scan to share the coordinate system: 

  

Scan QR code activates a QR code scanner which will read the complete coordinate system. 

You can add password protection to the Coordinate system. Choose Lock: 

  
then enter a password and click on OK.  

Once locked, the coordinate system parameters are hidden: 

  

Export writes a Trimble DC type file which can be shared or Loaded as needed. 

Details: Survey (tab): Base shift and CORS shift 
Available from the Survey (tab), Base shift or CORS shift: 
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  >  

And 

  >  

Base shift and CORS shift are nearly identical functions. Base shift works for a single base while CORS shift works for all 
future bases and is targeted towards CORS network corrections where the BaseID may change over time, receiver 
initializations and traveled distance. 

Base shift 
Suppose that you return to a project on the second day, and it is not possible to deploy a Base at the same location as the 
first day. You can set it up at a new, random location using an autonomous position. 

However, when checking in (using Point stakeout) on a previously surveyed point 1001, there is a substantial difference 
between the Rover’s current reading and the previous reading: 

  

Base shift is a simple way to fix this issue. 

From the Survey (tab) click on Base shift, then click on the 

 Calculate button: 

  

With the receiver occupying point 1001, click the  
Measure button, then Start acquiring a GNSS position: 

  



LandStar 8 User Manual 153  

Click the Point list  button and choose Known point 
1001: 

  

Click OK to accept this point pair. 

The Base shift menu will be shown with the required base 
offset to match the previous measurement: 

  

Click on the  Accept button. 

Confirm the base shift by clicking YES: 

  

The new base location and any measurements that you 
have already made with the new base will automatically be 
shifted: 

  

If you click on YES then the Point list will be displayed, 
otherwise you will return to the Survey tab of the main 
menu. 

Now, with the Base shift active, if you stakeout the check 
point 1001: 

  

the offset will be minimal. 

If you have multiple rovers on the project, you can share 

the Base shift using QR codes. Click the  button near the 
top right corner of the Base shift menu: 

  

Click Create QR code to build a barcode that can be Scan 
QR code by other rovers. 
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Removing Base shift 
You can remove the Base shift by setting the recorded shift to 0,0,0.  

From the main menu Project (tab) > Point list slide the 

shifted base to the right, then click on  Edit pencil: 

  

The Edit Point listing will show the N shift, E shift and H shift 
for the base: 

  

Manually change the N, E, and H shifts to 0.0, then click 
Save. 

 

CORS shift 
CORS shift is nearly identical to Base shift however the shift is applied to all subsequent measurements made with any 
online server. 

Because CORS Network connections don’t generate individual bases in the Point list, a new Virtual CORS base is built and 
applies to all subsequent CORS based measurements: 

  

this CORS base will be shown in the point list: 

  

and can be edited in the same fashion as the Base shift. 
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Details: Survey (tab): Sideslope stakeout 
Automates staking a vertical profile perpendicular along a centerline (line or polyline). The profile can have multiple profile 
strings (segments with varying slope and width) and is mirrored on both sides of the centerline. The centerline might also 
be used to grade a slope against a building foundation. 

To begin, first define a polyline in CAD view (not the Lines/Arcs manager on the Project tab). An existing polyline from a DXF 
design file can be used. 

Start the Sideslope stakeout operation from the Survey 
(tab), Sideslope stakeout: 

   

Landstar will prompt you to select the polyline: 

  

Click on the polyline to stake. Select the Sideslope profile to 
use: 

  

If the correct profile does not exist: 

  

Click on New: 

  

Name the new Sideslope profile, enter a Horizontal and 
Vertical Offset if needed, then click Save&Continue. Enter 
the first string segment of the profile: 

  

Select Up/Down/Horizontal(flat), the desired Slope (if not 
Horizontal) and the applied Width or Height. Click 
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Save&Continue to enter another String: 

  

Enter the String’s parameters, then click Save to complete 
String segment entry and visualize the Sideslope profile: 

  

Click Back to return to Sideslope stakeout: 

  

The navigation bubble shows: 

  

 To top distance up to match the top of the 
string profile. 

 

 Radial Cut distance to the profile elevation in the 
radial direction. 

 Outward horizontal distance out at the current 
elevation to intersect the profile target 
elevation. 

 Station the current centerline Station. 

 Up/Down distance to move Up or Down to meet 
the target profile height. 

 Offset Offset distance Left or Right from the 
centerline+offset. 

Click  and  to toggle between Profile view: 

  

And Plan view: 

  

Click  Stop Centerline staking and select a new 
Centerline and Profile to stake. 
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Click  Left/Right to toggle the profile from the Left and 
Right centerline+offsets sides. 

Click  Text display to control the items shown on the 
Profile view: 

  

The Sideslope target box: 

  

Changes the staking target between: 

 Slope: the nearest point on the Sideslope 
profile. 

 -N-: the N’th inflection point on the 
Sideslope profile. 1 is at the centerline 
offset by the Horizontal and Vertical 
Offsets. 

Use the  Start measurement button to store a staked 
point at any time and place. If Auto Descriptions [ See Auto 
description for staked points on Page 125] are enabled then 
the point description will include the station, offset and 
cut/fill to the profile line. 

 

Details: Survey (tab): Foundation stakeout 
Foundation stakeout automates the design and staking of sloped pit walls around a foundation base. At a distance offset 
from the foundation base, a sloping surface is defined which intersects with the undisturbed ground surface. The top edge 
of pit, wall slopes and building bottom can then be staked and excavated. 

To begin, first build a surface that encompasses the entire working area, the surface should extend past the expected top 
edge of pit. Then build a closed polygon for the foundation exterior, typically this will be imported from a CAD drawing. 

For the example below, the original ground surface has been generated from undisturbed, pre-excavation ground shots: 

  

The example exterior foundation polygon is a 12 x 30 foot foundation wall, approximately 4 feet below existing grade. 

From the Survey (tab) click on Foundation stakeout: 
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The current project will be shown: 

  

Click on the Select a foundation prompt, or the  
Foundation select button: 

  

The, likely empty, list of existing foundation definitions will 
be shown, click on New to create a new foundation 

definition: 

  

Name the new foundation description. Click on the 
foundation polyline (orange line), then select Left or Right 
so that the black offset line is on the outside of the orange 
foundation polyline. The Left/Right selection will depend on 
the design direction of the polyline. 

Enter the default Offset and Slope for the excavated walls. 
Optionally adjust the foundation Elevation if needed. The 
Offset and Slope can be individually configured for each of 
the line segments in the next step.  

The green diagonal lines are the inflection lines for the pit’s 
wall sides.  

Click Next: 
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If the Surface to use for the undisturbed ground level is 
specified, the top of excavation limit will be computed and 
shown. Click on each of the foundation polyline segments 
to highlight the segment red, then edit the Slope from that 
individual segment if needed. 

Each segment can have a unique offset and slope: 

  

Click on Save, the Foundation is now available to stake: 

  

Slide the Foundation to the right to edit it.  

 Check the Foundation then click OK to begin staking.  

Click on a Foundation element for staking directions and 
information for that element. The selected design element 
will be highlighted in red: 

  
 Staking the top-of-excavation limit. 

  
 Staking inflection lines at the pit corners. 
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 Staking the foundation base + offset line. 

Clicking the  Store measurement button will store a 
point. The description will follow the Auto description rules 
set in settings. See [ Auto description for staked points ] on 
Page 125 for information on Auto descriptions. 

 

Details: Survey (tab): Continuous survey 
Available from the Survey (tab), Continuous survey: 

   

Continuous survey allows automatic collection of measurements based on traveled distance or incremental time. 
Measurements can be triggered by Time, 2D distance traveled, 3D distance traveled or 2D delta and height delta.  

The Continuous survey method shares the same map-based collection tools as Map survey. See [ Details: Survey (tab) > 
Map Survey ] on Page 95 for a detailed description of the many survey method screen elements: 
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When you first enter Continuous survey, first click the Options  button, these Survey method settings for Continuous 
survey will be shown: 

  

The Survey method will automatically default to Continuous survey. Typically, you will only want to Store fixed solutions 
only, however it is possible to disable the Accuracy check to allow FLOAT and DGPS solutions to be stored.  

The Auto increment name interval should usually be 1 which increments the Point name by 1 after every measurement. If a 
conflict with an existing point is encountered, LandStar will advance to the next available point number. 

Four delta methods are available: 

  

Time will store a measurement after the Time interval delay: 

  

Distance 2D will store a measurement after the horizontal position changes by more than the specified distance: 

  

Distance 3D will store a measurement after the horizontal + vertical (3D slope distance) position changes by more than the 
specified distance: 

  

Distance 2D or delta H will store a measurement after the horizontal position or vertical height changes by more than the 
specified distance: 
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Click the  Start measurement button to immediately store the first measurement and start checking for movement or 
time to trigger additional measurements. 

The Start measurement icon will change to  Stop measuring when measuring is active. It is not possible to leave the 
Continuous survey screen without stopping measurements. The Back buttons will not operate until measurement 
collection is stopped. 

Details: Survey (tab) Cross-section survey 
Available from the Survey, Cross-section survey button: 

   

Cross-section survey allows you to quickly survey points at evenly or randomly spaced cross sections along a centerline 
alignment: 

   

This measurement collection tool displays your location 
relative to cross-sections enabling you to quickly navigate 
to the left-offset, centerline and right-offset points at each 
station. Extra measurements on and off the cross-section 
lines may also be stored.  

In addition to the stored points, station and offset 
information is available for all measurements collected 
using the Cross-section survey, including points stored at 
random stations: 

  

along with a DXF file that details every cross-section. 

Getting Started with Cross-section 
Surveying 
First identify the centerline alignment you want to survey. It 
is possible to survey between two points, but it may be 
easier to visualize the centerline if you use the CAD view to 
add a line between the endpoints. You can also use a 
polyline, arc, circle, or alignment as the centerline. 

From the Survey page, click on Cross-section survey, then 
click on the alignment selector: 
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The project list of Lines/Arcs will be shown, it may be 
empty: 

  

Click on Add, then pick a centerline source: 

  

If you have already defined a line, click on From map, then 
click on the correct line, then click on OK: 

  

Enter a name for the line, or accept the default name: 

  
then click OK. 

If you have selected a line, you will have an opportunity to 
edit and approve the Start and End points: 

  

Click on Save, you will return to the Line/Arc list.  

Select the new line by clicking in the right-hand circle, then 
click Next: 
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You can now click the option button: 

  

Select the Cross-section survey (tab): 

  

To set the station interval and left and right cross-section 
width. 

Use horizontal transition points:  add a cross-section at 
each centerline node. 

Station interval: the distance along the centerline to place 
cross-sections. 

Along offset tolerance of cross-section: RED prompting 
when the station exceeds. 

Left length of cross-section: width (offset left) on left side 
of centerline. 

Right length of cross-section: width (offset right) on right 
side of centerline. 

Midpoint tolerance of cross section: left-right tolerance for 
the middle point on centerline. 

Real time station as point name: build the point name from 
the actual station “K0+000.048” 

Target station as point name: built the point name from the 
ideal target station “K0+000.000” 

Either Real time station as point name, Target station as 
point name or standard station incrementing can be 
selected. 

Click the back button to return to the Cross-section survey 
screen. 

  

 You can directly enter the station to stake or 
use the previous station < and next station > buttons at the 
screen bottom to move forward and backwards along the 
centerline by the entered Station interval. Clicking the 
Nearest button will add a cross section on the centerline at 
the station nearest your current position without regard to 
the selected Station interval.  

Your current position will be shown as a blue circle  
with a black navigation line the nearest point on the 
selected cross section. The actual station (along the 
centerline) and the offset will be shown: 

 

 

The left and right offsets are shown as an orange target 

line. Typically, you will use the  Start measurement to 
store the left, right and the centerline points. If the 
centerline station has not yet been measured, you will be 
prompted: 

  

You may measure as many points as necessary at each 
cross-section. 
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The  button selects the stored point type: Topographic 
(typically 5-second average), Quick (typically 1-second) or 
Corner. 

The  button allows you to measure a remote (hidden 
point) using offsets. 

Once you have measured each cross-section line, you can 

use the  Cross-section export button to write a DXF file 
that has a cross-section detail showing each measurement, 
at each station: 

  

and a .TXT file: 

  

detailing every stored cross-section. 

 

 





LandStar 8 User Manual 167  

Details: Config (tab): Instruments profile 
Instrument profiles 

  

combines the Bluetooth/Wi-Fi Connection information: 

  

with one of the Instrument configurations: 

  or  

to form a complete instrument definition. 

If the Instruments profile function is not shown, look under the  function. 

Instrument profiles can be quickly selected and applied using the  Instrument select button at the top of most 
menus. 

Depending on the application, a named Instrument profile may be more convenient than separate connection and profile 
operations. This is especially true when you have a Rover that is used both as NTRIP Network Rover and a UHF Rover. 

From the Config tab of the main menu, click on Instruments 
profile:  

  >  

The existing, possibly empty, list of Instrument profiles is 
shown: 

  

Click New to create a new Instrument profile: 

  

Select the correct instrument type. For this example, we 
will configure an NTRIP Rover using the PDA internet 
connection: 
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Configure the connection information, the instrument 
should be on and ready to pair by Bluetooth or Wi-Fi. This 
dialog is the same as [ Details: Config (tab): Connect to 
instruments ] on Page 169.  

When the configuration is complete, click Next. 

  

Select the Rover type (NTRIP shown above). This is the 
same as [ Details: Config (tab): GNSS rover ] on Page 171. 

Click Next: 

  

Enter the network configuration information. Click Next 
when complete: 

  

Complete any additional configuration items. 

Click  Save to save the Instrument profile or 

click  Save & Accept to save the profile and 
immediately apply it to the receiver. 

Once profiles have been defined, from the Config tab of the 
main menu, click on Instruments profile:  

  >  

This list of Instrument profiles will be shown: 
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Select  check the desired profile, then click 

 to apply the profile to the instrument and 
begin operation. 

You may also use the  Instrument select button to 
activate Instrument profiles. See [ Instrument select ] on 
Page 49 for additional information. 

 

Details: Config (tab): Connect to instruments 
LandStar supports a very large list of RTK Instruments, Generic NMEA receivers, the Internal GPS receiver in the PDA and a 
position Simulator. 

This is partial list of devices: 

 CHC M5, X900+, X91+, X6, iBase, E90, E91, M6, i50, i73+, i73, i70, i83, i80, i89, i90, i93 

 JY i80, Z3, X91+ 

 Champion Pro 

 Prince iBase, i90VR, i90, i80, i70T, i80Air, i80Pro, i50, i30, i30 IMU Tx, X91 

 ELMIZ elNav, M3, i70, i70Pro 

 Horizon Kronos C3 

 ComNav G9GNSS, G7GNSS 

 TopoMap T10, T20, T20 plus 

 iGage iG3S, iG4, iG5, iG8, iG8a, iG9, iG9a, iGV 

 eGPS M5, eGPSM6, eGPSM7, eGPS20T, eGPS20TL 

 Datronix D1, D20 

 GeoGenie NX, PRO 

LandStar connects to GNSS receivers, Total stations and Peripherals (Laser Rangefinder, Pipeline detectors, Echosounders) 
by Bluetooth. Most modern GNSS receivers also support a Wi-Fi connection.  

Visual receivers like the CHC i89 and i93 require a highspeed Wi-Fi connection to utilize the cameras. 

From the Config tab of the main menu, click on Connect to 
instruments:  

  >  
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Brand 

Select the Brand of receiver you are connecting to: 

  

The list of available Types will update, select the correct 
type: 

  

RTK is correct for most external receivers, LandStar will 
automatically negotiate the difference between CHC RTK 
and SMARTGNSS receivers. Internal Android device location 
will use the GPS receiver built into the tablet. Others 
(NMEA0183) expect GGA, GST, GSV, GSA at any interval. 
Performance will improve with GGA at 1 HZ or faster.  

Choosing Simulation allows entry of the spoofed position: 

  

The simulated position can be loaded from the Point 

list or  CAD. 

When simulation mode is selected, this warning will be 
displayed on all main menus: 

  

Model 

Each Brand will have list of Models: 

  

Select the Model that matches your device. 

Connection type 

Choose the correct Connection type: 

  

Wi-Fi is required when using a Visual Stakeout or Visual 
Survey receiver like the i93. Bluetooth may be preferable 
for simplicity. If a Bluetooth PIN code is required, LandStar 
will ask for its entry. Some PDA devices may require 
bonding from the operating system’s Bluetooth menu. 

Antenna type 

When you select a Model, LandStar will automatically select 

an Antenna type. Click the  button to override the 
default selection.  
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Slide an antenna definition to the right and click on edit to 
modify the standard definitions. 

It is also possible to manually enter a new custom Antenna 
definition, click on Add to make and edit a new entry. 
Antennas are defined in LandStar with the following 
convention. 

  

Corresponding to an antenna definition: 

  

Radius = ½ Diameter = 0.4436 / 2 = 0.222 

To phase center (SHMP to L1PC) = 0.3740 – 
0.2753 = 0.099 

To the bottom (SHMP to ARP) = 0.275 

Target device: Bluetooth 

If the Connection type is Bluetooth, when you enter the 
Connect instrument menu, LandStar will automatically 
perform a Bluetooth search. If the automatic search is 

unsuccessful, click on  Then use the device 
operating system’s Bluetooth menu to look for the receiver 
and to pair with it. When you return to LandStar, the new 
device will be available. 

Target device: Wi-Fi 

If the Connection type is Wi-Fi, click on the current Wi-Fi 
connection: 

  

then use the device operating system to connect to the 
GNSS receiver. The default password for most CHCNav 
receivers is “12345678” if a password is requested. 

Connect 

Once all of the connection settings have been made, click 

on the  button. 

  

If the connection is successful, LandStar will return directly 
to the main menu and voice “Successfully connected”. 

If the connection is not successful, make sure the receiver is 
turned on. Only one controller can connect by Bluetooth to 
a receiver at a time. You may need to go to the operating 
system Bluetooth menu and ‘Forget’ the device and add it 
again. 

 

Details: Config (tab): GNSS rover 
GNSS rover configures the connected device as a Rover and includes the UHF Radio / Internal modem / PDA connection 
settings to provide RTK corrections.  

From the Config tab of the main menu, click on 

  >  
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The list of known configurations will be shown. You can 
check a known configuration, then click Accept and the 
receiver will be configured. 

Slide an entry to the right 

  

then click on  Edit to modify an existing configuration. It 
is also possible to Delete, Load from Cloud, Share a 
configuration. If you receive a shared connection profile, 
put the .hcwm file in the system folder: 
 /storage/emulated/0/CHCNAV/Config/workMode/ 

and it will appear in the Profile list the next time you click 
on GNSS Rover. 

There are 5 primary configuration types: 

  

NTRIP is a network server that requires a Username and 
Password. APIS is the CHC cloud service for sharing 
corrections between network connected receivers. Radio 
uses the device’s internal UHF radio. TCP is a network 
server that does not require a Username or Password, it is 
also known as DIP: Direct Internet Protocol. PPP is a 
satellite correction service like RTX, PPP activation is 
configured elsewhere. 

Radio 

  

Set the Name to a description of the radio profile. The 
Name is arbitrary. It is recommended to include the 
Protocol and Frequency in the profile name. 

The Radio configuration includes the Protocol, Channel 
bandwidth (Step value), over-the-air Baud rate, radio 
Channel, Frequency (set the Channel programming in the 
receiver), Sensitivity (normally high for Rovers), the FCC 
callsign, and FEC (may not be available for all radio 
protocols.) 
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NTRIP 

  

Set the Name to a meaningful description of the network. 
The Name is arbitrary. 

Internet access can be: 

  

If the GNSS receiver has an activated cellular SIM card 
inside the receiver, then Receiver network can be selected. 
Otherwise, use the internet connection of the PDA network 
(the PDA is the Android device that LandStar is running on.) 

Domain/IP is the network address of the server. It can be 
entered as a name like “turn.utah.gov” or as a dotted IP 
address “165.245.87.9” 

Port is the internet port that hosts the server. Typically, it is 
2101, however other ports like 8000 are also in use. 

It is possible to enter a list of Servers and pick the 

Domain/IP and Port from the list. Click on  
Select a server to view and edit the server list. Each entry in 
the list has these data items: 

  

Mountpoint selects the type of correction to receive from 

the server. Click  Get Mountpoint to 

download the server’s unique list. Then use the  

  

drop down list to select the best Mountpoint. 

Username and Password are both case sensitive. 

When all the settings have been entered, click on Save to 
save the profile or Save & Accept to Save the profile and 
immediately apply it to the connected receiver. 

TCP 

  

Set the Name to a description of the network. The Name is 
arbitrary. 

Internet access can be: 

  

If the GNSS receiver has an activated cellular SIM card, then 
Receiver network can be selected. Otherwise, use the 
internet connection of the PDA network (the PDA is the 
Android device that LandStar is running on.) 

Domain/IP is the network address of the server. It can be 
entered as a name like “turn.utah.gov” or as a dotted IP 
address “165.245.87.9” 

Port is the internet port that hosts the server. There is no 
standard port for TCP/DIP connections. 

It is possible to enter a list of Servers and pick the 

Domain/IP and Port from the list. Click on  
Select a server to view and edit the server list. Each entry in 
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the list has these data items: 

  

When all the settings have been entered, click on Save to 
save the profile or Save & Accept to Save the profile and 
immediately apply it to the connected receiver. 

 

Details: Config (tab): GNSS base 
GNSS base configures the currently connected device as a Base configuring Internal UHF Radio / External Radio / Receiver 
Cell Network profile settings and does the Base setup putting a coordinate in the receiver. 

First connect to the Base receiver using Config (tab) > Connect to instruments. It is important to have the actual device 
connected so that LandStar can interrogate the device and offer the correct radio and communication options.  

Hint: Make sure you are connected to the Base and not the Rover when configuring the Base. 

From the main menu, Config (tab) click on GNSS base: 

  >  

If you have never configured a Base, an empty Base profile 
list will be shown: 

  

Click on  New to create a new Base profile. 
Choose a correction message transmission method: 

  

Details on each of these methods follow. 

Internal radio 

Internal radio uses the radio built into the Base receiver to 
transmit corrections. LandStar will retrieve the current UHF 
Radio settings from the Base and use them as defaults. 
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Name the Base profile with a meaningful complete name. It 
will have greater future value if it is easy to pick from the 
list. Decimal points and spaces are not allowed in the 
profile name. 

Set the Differential format to the highest protocol shared 
by the Base and Rover.  

  

If both receivers have Trimble OEM boards, sCMRx is 
appropriate. If you have two CHC receivers like the i93 
CHC516 protocol may be best. Otherwise, favor RTCM3.2. 
None of the other protocols support all satellite systems 
and signal tracking, they should not be used. 

The radio Protocol and Step value (channel bandwidth) 
should be set as desired, however SATEL_3AS is typically 
the only supported protocol that supports 9600 baud over-
the-air in 12.5 KHz channel bandwidth which is a 
requirement of most USA FCC licenses.  

  

Typically, the Baud rate is forced by the Protocol and Step 
value (channel bandwidth). Higher Baud rates are better 
and 9600 is the minimum that will dependably support full 
constellation correction streams like RTCM3.2. 

Selecting a radio Channel will determine the Frequency. In 
the USA, end users are not allowed to edit the Frequency, 
they must choose a Channel from the list of pre-entered 
licensed frequencies. 

Sensitivity is best set to Low. 

Click the  button to the right of Call Sign to check your 
FCC Call Sign. 

  

The FCC information is configured by your dealer and is 
stored in the receiver. Status should be ON, 15 is the 
minimum Interval in minutes, the Message should be set to 
your FCC ID using upper case letters. See the receiver’s 
User Manual for instructions on setting the FCC 
information. 

FEC (Forward Error Correction) is best turned OFF as it adds 
30% additional overhead to every correction message. 

Set the Elevation mask to a reasonable value like 5 
(degrees). 

Turn ON Start at known position unless you want to pick or 
enter a known location. Turn OFF Start at known position to 
automatically read an autonomous base position for every 
setup.  

Clicking Save will save the Base profile and return to the 
Profile list. Clicking Save & Accept will save the Base profile 
and begin the Base setup procedure. See [ Base setup 
procedure ] on Page 177 to continue setup. 



 176  LandStar 8 User Manual 

External radio 

External radio sends correction messages out the receivers 
RS232 Serial Port. 

  

Name the Base profile with a meaningful complete name. It 
will have greater future value if it is easy to pick from the 
list. 

If both receivers have Trimble OEM boards, sCMRx is 
appropriate. If you have two CHC receivers like the i93 
CHC516 protocol may be best. Otherwise, favor RTCM3.2. 
None of the other protocols support all satellite systems 
and signal tracking and they should not be used. 

Set the Baud rate to the highest speed supported by your 
external radio. This typically will be 115,200 baud. Slower 
speeds can significantly increase the radio latency and 
reduce the carry capacity of the radio. The RS232 protocol 
is fixed at 8-data bits, No parity, 2 Stop bits. 

Set the Elevation mask to a reasonable value like 5 
(degrees). 

Turn ON Start at known position unless you want to pick or 
enter a known location. Turn OFF Start at known position to 
automatically read an autonomous base position for every 
setup.  

Clicking Save will save the Base profile and return to the 
Profile list. Clicking Save & Accept will save the Base profile 
and begin the Base setup procedure. See [ Base setup 
procedure ] on Page 177 to continue setup. 

 

Receiver Cell Network 

A Base configured as Receiver cell network pushes the 
correction stream through the internal Cell modem to a 
specified Domain/IP Address and Port. The protocol is Raw 
Telnet. There is no security. The Base does not need a 

Static, Public IP V4 address because the corrections are 
pushed to a remote static address. 

  

Use the  APN button to check the receiver’s APN 
(Access Point Name). In the USA, if you change the APN, 
you must cycle the modem or receiver’s power to reset the 
cellular network. 

If both receivers have Trimble OEM boards, sCMRx is 
appropriate. If you have two CHC receivers like the i93 
CHC516 protocol may be best. Otherwise, favor RTCM3.2. 
None of the other protocols support all satellite systems 
and signal tracking and they should not be used. 

The Domain/IP and Port must be correct. 

Set the Elevation mask to a reasonable value like 5 
(degrees). 

Turn ON Start at known position unless you want to pick or 
enter a known location. Turn OFF Start at known position to 
automatically read an autonomous base position for every 
setup.  

Clicking Save will save the Base profile and return to the 
Profile list. Clicking Save & Accept will save the Base profile 
and begin the Base setup procedure. See [ Base setup 
procedure ] on Page 177 to continue setup. 

Receiver cell network and external radio 

Receiver cell network and external radio is a combination of 
Cell network and External radio sending corrections 
simultaneously over both links. 
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Base setup procedure 
After you have defined an appropriate Base profile in the 
Profile list: 

  

Select the desired Profile and click Accept. 

  

If Start at known position is OFF, then LandStar will do a 
short average and start the Base with an autonomous 
position. 

If Start at known position is ON, then the Start on a known 
position dialog will be shown: 

  

Always enable Store the point into the Point list unless the 
point already exists in the project’s Point list. 

Double check the Antenna type and the Antenna height. 
Consult your receiver’s User Manual to determine the Slant 
Height Measurement Point if you choose Type = Slant H. 

The Base Coordinates can be entered and displayed in 
several formats.  

If starting from a NGS OPUS solution, favor a Geodetic 
(Latitude, Longitude, Ellipsoid Height) position: 

  

 

The best measurement entry format is: 
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If working in US Feet or International Feet be sure to enter 
an “M” after the Ellipsoid Height, as shown above, 
Elevations are always in Meters on an NGS OPUS solution. 

You can manually type in the point Name and Coordinates; 

use the  Point list button to recall a point from the 

project Point list; use the  Start Measurement button to 

read the current GPS location or pick a point from  CAD. 

Set the Description to a meaningful note, finally click OK. 
LandStar will configure the Base and corrections will begin 
to be transmitted. 

 

Details: Config (tab): GNSS static observation recording 
Receivers can store static observation data for processing in desktop tools like CGO2, online tools like NGS OPUS and be 
used for UAV post-processing. 

GNSS static recording allows control of the receiver’s recording settings. 

From the main menu Config (tab): 

  >  
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Set Start logging to ON, if set to OFF it is not possible to configure any of the logging parameters. 

Set Data format to HCN. 

If you would like the receiver to automatically begin recording when it is turned on and is tracking satellites, set 
Automatically log when the receiver is turned on to ON. 

Choose an appropriate logging Interval. 1-second is usually great for all applications. When using OPUS, the interval must 
be 30-seconds or less and divide into 30 seconds evenly: 1, 2, 5, 10, 15, 30 are all acceptable. 

Elevation mask sets the minimum satellite height about the horizon to record data. 0 (zero) is a good choice for all static 
applications and is recommended by NGS for CORS station recording. 

Logging duration sets the length of recording files. 1440 minutes equals 24-hours and will produce a new file every 24-
hours. The file begins when the receiver is turned on, not at midnight. 

Station name is included in the resulting HCN and RINEX files. 

Antenna height is usually the distance from the receiver’s ARP (the bottom of the receiver) to the GM (Ground Mark).  

Antenna height measurement method can be Vertical, Slant H or Antenna phase center. For NGS OPUS and most other 
application Vertical is the best choice. 

RINEX will write a RINEX 2 or a RINEX 3.0x file, in addition to the HCN file. It is possible to convert an HCN file into either 
RINEX 2.11, RINEX 3.02, 3.03, 3.04, 3.05 or 4.00. It is not possible to convert a RINEX 2.11 file into any other format. There 
also may be a rate limitation when RINEX is enabled. 

Details: Config (tab): Instrument info 
The Instrument info tool provides extensive information about the currently connected receiver. 

From the main menu Config (tab) click on Instrument info: 

  >  

The Instrument info, Quality, Sky plot, Satellites, and GNSS Base tabs are duplicates of the [ Status ] screens described on 
Page 95. 

Details: Config (tab): Activate instrument 
Receivers can be activated with a permanent code, a temporary code that expires after an evaluation period or be 
geofenced with different options based on location. Activate instrument allows the user to enter a new activation code. 

From the main menu Config (tab): 

  >  

If you have a new Activation code, record the current code then enter the new code, click Activate. 
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Details: Config (tab): Update 
Receivers have firmware sets for the main board, the OEM GNSS engine, the cellular modem, and the UHF radio. It may be 
possible to automatically update the receiver using online resources. 

From the main menu Config (tab): 

  >  

  

Details: Config (tab): Advanced 
Advanced functions include: 

NMEA output for the Bluetooth channel, the RS232 Serial port, and a special Raw TELNET port (1212) accessible via the 
Wi-Fi port. 

Receiver Elevation mask setting. 

Position output frequency. 

OEM GNSS engine reset. 

APN for the cellular modem. 

NFC/Wi-Fi function that allows easier connection to some receivers by Wi-Fi or Bluetooth. 

From the main menu Config (tab): 

  >  
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NMEA Output 

Clicking NMEA Output: 

  

Then choosing Serial port: 

  

Elevation mask setting 

  

Press Get to retrieve the current Elevation mask setting 
from the connected receiver. Modify, then click set to send 
to the receiver. 

Position output frequency 

  

Press Get to retrieve the current Position output frequency 
from the connected receiver. Modify, then click set to send 
to the receiver. This is the coordinate update rate from the 
OEM GNSS board and may not be supported for all 
equipment. 

Reset GNSS Board 

  

Click YES to clear the GNSS board’s ephemeris and then 
reset the GNSS Board. This forces a full reacquisition of 
signals and position.  

A reset may be beneficial when verifying solutions under 
heavy canopy and this sequence is automatically applied 
during the Verified and Control survey methods. 

Cellular modem APN (Access Point Name) 

This option allows you to change the cellular modem APN 
(Access Point Name), Dialing number string, SIM Username 
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and SIM Password: 

  

In the USA, normally the Dial number is *99# and both the 
Username and Password are blank. 

In many markets (like the US) it is necessary to power off 
the modem, wait 40 seconds then turn the modem back on 
after changing the Access Point Name (APN). Enable the 
Cycle power… option to automatically turn off the cellular 
modem, wait 40-seconds, then turn the modem back on 
again. 

 

Details: Config (tab): NFC / Wi-Fi 
Some receivers include NFC transponders. It may be possible to read the Bluetooth ID, MAC and PIN and the Wi-Fi SSID, 
MAC and password via NFC. It may also be possible to modify the Wi-Fi settings with this function. 

From the main menu Config (tab): 

  >  

LandStar prompts to hold the NFC reader on the PDA next to the NFC icon on the receiver: 

  

If possible, the NFC transaction will download the Bluetooth ID, PIN and MAC; and the Wi-Fi SSID, Password and MAC. 

On some devices it is also possible to modify the Wi-Fi SSID and Password. 
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Details: Tools (tab): Map adjustment 
Map adjustment allows vector maps (DXF, DWG, SHP, KML and KMZ, WFSDB files) to be georeferenced with multiple affine 
points. This adjustment tool will not work with raster images like .TIF, .PNG or .JPG raster files. 

From the main menu Tools (tab), click on Map adjustment: 

  >  

Use the drop-down box to choose an imported vector file: 

  

Add control points to associate Map points on the vector map with Known points, in the survey: 
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Once three or more control points have been entered, residuals will be shown: 

  

Finally, click Next to complete the Map adjustment.  
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Details: Tools (tab): Volume computation 
 

LandStar will compute the Volume, surface area and cut/fill 
balance of two surfaces or a surface and a reference 
elevation, then and create a Volume report: 

  

From the Main menu, click on 

  >  

A list of existing Volume calculations will be displayed: 

  

Click on New to create a new calculation: 

  

Enter a unique Name for the Volume calculation. The 
calculation will be kept with the job. It won’t be possible to 
edit the definition, however it is possible to change the 
Units and then view the results again as needed. 

The Cut swell factor accounts for the increase in volume 
when compacted undisturbed soil is excavated and swells 
to fluff (air pockets) in the loose soil.  

The Original surface (Base), typically the pile bottom or pit 
edge, can be defined by several methods: 

  

 Reference elevation A single elevation that is used as the 
Original surface. 

 Reference point The elevation of the single point 
specifies an Original surface elevation. 

 Reference level 3-Points used to manually define an 
Original surface plane. 

 Surfaces difference Manually define two surfaces: Original 
surface and Final surface. This provides 
the greatest computation control. 

 Stockpile/Pit Automatically computes an outside 
boundary of the specified surface which 
is used as the Original surface, then 
computes Cut/Fill from the remaining 
points in the surface. Ignores the 
volume between the boundary and the 
inside points. 
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For example, let’s compute the pile volume for a gravel pile. 

  

Points 101 through 113 define the perimeter and points 
200 through 225 are randomly collected over the pile 
surface. The pile is about 55 feet wide and rises 3.5 feet in 
height at the center. 

First, we define two Surfaces: 

  

PileBottom includes 13-points around the edge of the 
gravel pile [ See Details: Project (tab) > Surfaces on Page 90 
for additional information on adding Surfaces. ] All includes 
all the points, both the edge and center. Setting up the 
Volume computation: 

  

Pile Bottom: 

  

All surface: 

   
Choose Calculation direction = Original to final, finally click 
on Calculate to compute the differential volume, build a 
differential surface. Click Export Report to write a PDF. 
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Results tabulation: 

  

Surface visualization: 

  

Exported PDF: 

  

Click on  then switch to , use one-finger to tilt and 
rotate the image, two-fingers to move it: 
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Details: Tools (tab): Area computation 
Area accepts an ordered list of points and computes the area enclosed by them. The points can be selected from the Point 
list, from the Map or entered as a range of points. 

From the main menu Tools (tab), click on Area: 

  >  

  

Enter coordinate 

It is possible to hand enter points, one at a time, or in 
conjunction with other selection methods to build the area 
point list: 

  

Select from library (Point list) 

Select from library displays the Point list with checkboxes. 
Points are selected in the order they are checked: 

  

Select from map 

Select from map shows the CAD screen: 
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Then click on points, one at a time, in order, to select the 
area’s perimeter: 

  

Click on OK to complete the perimeter selection: 

  

Range of points 

Range of points accepts a comma separated list, or hyphen 
separated range of points to include in the Area list: 

  

Because LandStar Point names can include the hyphen 
character, you must space separate the range hyphen from 
the point names: 

  11 - 18  NOT: 11-18 

Comma separate point Names “11,13,15,17” 

Once an ordered set of points for the Area list has been 
selected, click on OK: 

  

The area summary results will be shown: 

  

Modify the distance units: 

  

And the area units: 

  

as needed. 
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Details: Tools (tab): Inverse 
The Inverse tool computes distance and bearing between two points or a series of points (Traverse style). 

Consider the corners and quarters around this section: 

  

From the main menu Tools (tab), click on Inverse: 

  >  

Invsering from 11 to 12: 

  
The distance is shown in both USFeet and Chains.Links with 
State Plane Grid Bearing N 1 20 14 W. 

Click the  Move up button, and point 12 will move to 
the top line: 

  

Then enter 16 as the B point and LandStar will compute the 
East Quarter to West Quarter distance: 

  

It is also possible to Inverse in the CAD View, see [ Action 
bar: Measure ] on Page 146. 

Details: Tools (tab): Angle conversion (DMS.s  D.ddd  GON) 
The Angle conversion tool is useful for converting Degrees Minutes Seconds to decimal degrees, decimal minutes, decimal 
seconds, radians and Gons and vice-versa. 

From the main menu Tools (tab) click on Angle Conversion: 
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  >  

Select Degree, Minute, Second, Radian or Gon as the primary secondary unit. Then enter an angle in DMS at the top or the 
secondary unit at the bottom. As any value is modified, all other values are recomputed: 

  

Details: Tools (tab): Parameter calculation, 3 or 7- parameter 
Parameter calculation accepts matched sets of GNSS points (with underlying Lat/Lon/Height data) and Known points 
(projected values). After selecting a transformation style, verifying residuals, and computing best-fit translation coefficients, 
the translation can be entered into the current project’s coordinate system. 

From the main menu Tools (tab), click on Parameter 
calculation: 

  >  

The Parameter calculation dialog is shown: 
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Select the transformation type: 

  

Then click on Add to create GNSS Point – Known Point 
pairs: 

  

At least one control point pair is required for 3-parameters 
calculation, at least three control point pairs are required 
for 7-parameters calculations. 

  

Click on Calculate: 

  

If the translation is acceptable, click on YES. If LandStar is 
not happy with the residuals, a warning message will be 
displayed: 

  

Click YES to continue anyway. The transformation will be 
installed into the project’s coordinate system. The 
adjustment can be viewed from the main menu Project 
(tab) > Coordinate system > Datum transformation (tab): 
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Details: Tools (tab): Point to line distance 
Computes the nearest point on a line to a specified point. Returns the Station, the Offset distance left or right, the nearest 
point can be saved to the Point list or directly staked out. 

From the main menu Tools (tab) click on Point to line distance: 

  >  

Consider this section 16 with all corners and quarters 
found: 

  

How far off the line from the southwest corner 17 to the 
northwest corner 15 is the west quarter 16? 

  

Enter A: 17, B: 15, C: 16, then click Calculate: 

  

The intersection point is computed with the Description: 
  “16 to line 17”-15 STA 2666.941 USft R 5.443 
USft 

Click Save to save the computed point to the Point list. Click 
Stakeout to stake it out directly. 

 

Details: Tools (tab): Offset distance 
Offset from an origin point at a Grid bearing, a specified horizontal and vertical distance. Compute a new point and add it 
to the Point list or stake it out directly. 

From the main menu Tools (tab) click on Offset distance: 
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  >  

Consider this section 16 with all corners and quarters 
found: 

  

Place a point at the midpoint between the south quarter 18 
and the east quarter 12. 

  

Enter point 18 as the Origin (A). The Horizontal distance 
should be ½ the distance from point 18 to point 12. Enter 
“18,12/2”: 

  

when the cursor moves from the window it will compute 
the Distance: 

  

Now enter the Bearing as the computed bearing from the 
south quarter 18 to the east quarter 12 “18,12”: 

  

when the cursor moves from the window it will compute 
the Bearing: 

  

Set the Vertical distance to 0. Click the Calculate button: 

  

Click Save to save the computed point to the Point list. Click 
Stakeout to stake it out directly. 

Viewing the CAD map: 

  

The calculated point COGO_2 is in the desired location. 
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Details: Tools (tab): Deflection 
Compute the angle of a point offset from the endpoint of a line to the line. 

From the main menu Tools (tab) click on Deflection: 

  >  

Consider this section 16 with all corners and quarters found: 

  

What is the angle of the line from the northwest corner 15 to the north quarter 14 from the line between the southwest 
corner 17 to the northwest corner 15? 

  

The quarter is 44 minutes north of the perpendicular of 17 – 15. 

Details: Tools (tab): Rotation 
Rotate a point around another point, a specified angle. Create a point at the new location. 

From the main menu Tools (tab) click on Rotation: 

  >  
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Consider this section 16 with all corners and quarters 
found: 

  

Rotate point 16 around point 17 one half the bearing 
between 17 and 18. 

Set A to the southwest corner 17, B to the west quarter 16: 

  

Enter the rotation angle as ½ the angle from the southwest 
corner 17 to the south quarter. Enter “17,18/2”: 

  

Tab  out of the entry box and the effective rotation 
angle will be computed: 

  

Click Calculate: 

  

Click Save to save the computed point to the Point list. Click 
Stakeout to stake it out directly. 

Checking the computed position on the map: 

  
COGO_3 is in the expected location. 

 

Details: Tools (tab): Intersection 
Intersection accepts point pairs defining two lines, the intersection of the lines between these points are computed. If 
there is no direct intersection, the lines are extended.  

From the main menu Tools (tab), click Intersection: 

  >  

Compute the mid-section intersection of the north-south 
and east-west quarter lines: 
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Enter A - 16, B - 12 (east west quarter line); C - 14, D - 18 
(north-south quarter line): 

  

Click Calculate: 

  

Then Save: 

  

Finally check the stored point.  

Compare the projected northwest section corner 
determined by the extension of the lines from the 
southwest corner to the west quarter, and the northeast 
corner to the north quarter: 

  

Enter A -16, B - 17; C - 13, D - 14: 

  

Click Calculate: 
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then Save. Check the stored point: 

  

 

Details: Tools (tab): Bisect angle 
Place a point on the line bisecting an existing angle, specifying the offset from the center vertices. 

  >  

Consider a power line with a series of poles (4, 5, 6, 7, 9) 
making a right turn: 

  

Set an anchor 24’ behind point 7 on the line that bisects 6, 
7, 8. 

From the main menu Tools (tab) click on Bisect angle. Enter 
A - 6, B - 7, C - 8. Since we want the anchor outside of the 
included angle, enter “-24” as the projected segment 

length: 
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Click Calculate: 

  

Click Save. Verify the projected point in the CAD view: 

  

 

Details: Tools (tab): Divide line 
Divide line will divide the distance between two points into even segment lengths (By distance) or a whole number of 
segments (By segments). Point protection can automatically Skip points that already exist at the same location as the 
calculated points. 

  >  

Given two existing points 1 and 2, divide the line between 
them into 14-equal length segments. 

   

From the main menu Tools (tab) click on Divide line. Set the 
Start point to 1 and the End point to 2, choose By segments 
and enter 13 as the Number of segments. Choose P1 as The 

first point name. Check Skip points that already exist at the 
same location, even though there are no points between 1 
and 2 to overwrite: 
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Click Calc & Save, then view the results in the CAD view. 

  

 

Details: Tools (tab): Point average 
Choose several existing points to average. Show the residuals for each added point and allow adding and removing points 
from the average before storing a new Point average. 

From the main menu Tools (tab) click on Point average 

  >  

The Point average screen is shown: 

  

Click on Add: 

  

Click Select from library, then check all the points to 
average: 
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Click on OK: 

  

The ranges for N, E and Z are quite high.  

Click on the  H Res sort order button to sort the 
horizontal residuals from largest to smallest: 

  
Uncheck the H and V checkboxes for the top three highest 
residuals. The Range drops to reasonable values for N, E 
and Z. 

Slide the bottom panel right and left to view the stats: 

  

Horizontal scatter plot:  

  

Vertical range plot: 

  

Click OK when the point selection is acceptable: 

  

Enter a Point name, choose a Code if desired, enter a 
Description and click on Save to store into the Point list, or 
click on Stakeout to immediately stake the computed point. 

 

Details: Tools (tab): Plot Deed 
Plot deeds from legal descriptions. Directly enter a Metes and Bounds survey or a Bearing- Distance traverse using lines and 
curves (arcs). Includes a Curve Calculator and provisions for arc tangent bearings or cord bearings. 

There are two ways to enter Plot deed: 
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1) From the main menu Tools (tab) click on Plot deed: 

  >  

2) From the CAD view click on Draw, Layout: 

  >  >  >  

Select the Layout mode: 

  

Points and lines may be easier for visualizing a complex 
description. Enable elevation to keep a site elevation, 
disable Elevation to place the description at a design 
elevation of 0.0. This will cause issues when using a robot, 
so it may be best to hold an approximate site elevation. 

Specify a starting point: 

  

Click on any existing point, or enter a new point from the 
Project > Point list > Add prior to entering the Deed Plot 

function: 

  

to start at an assumed project position like 10,000, 10,000. 

From the first point, specify the first call as a Line or an Arc: 
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by choosing the Drawing target: 

  

Deed plot line entry 

Select Drawing line: 

  

Enter the Bearing, typically using Quadrant bearing 
notation see [ Entering Azimuths/Bearings ] on Page 14 or 
with the Bearing button: 

  >  
The Bearing selector also includes +/- 90° option for turning 
right-angle corners. 

Enter the Distance: 

  

Override the default project horizonal units for a 
description with mixed units like Chains or Links. See [ 
Entering distances ] on Page 14 for examples. 

Specify an Elevation: 

  

  

The new line will be plotted on the CAD screen in red: 

  

If the new segment looks correct, press the  Add button. 

Continue entering description calls until the boundary or 
layout is complete. 

Deed plot curve (arc) entry 

Select Drawing Arc: 

  

Enter the tangent Bearing: 

  

If the description specifies a non-tangent Chord bearing, 

click on the  Bearing selector: 

  >  
To change to Chord bearing entry: 

  

The Bearing selector also includes +/- 90° option for turning 
right-angle corners. 

Enter the arc Angle: 
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The Curve calculator will help convert the curve values 
found in the description to an Angle + Radius: 

  

If there is a Curve radius, enter it first, then follow with the 
Arc length or Chord length. Only one is needed to compute 
the arc Angle. Click OK to save the Radius and computed 
arc Angle. 

The new curve (arc) will be plotted on the CAD screen in 
red: 

  

If the new segment looks correct, press the  Add button. 

Continue entering description calls until the boundary or 
layout is complete. 

 

Plotting deed descriptions, a complicated example 
The Deed plot function is best described with a complicated example: 

A part of the Southeast Quarter of Section 23, Township 6 North, Range 1 East, Salt Lake Base and 
Meridian, U.S. Survey: Beginning at the East quarter corner of this Section 23, thence South 89°36' 25" 
West 1446.81 feet along the quarter section line, thence South 6°59' 51" East 565.86 feet, thence South 
4°54'27" West 66.0 feet; thence Easterly along a curve to the left with a radius of 206.57 ft., an arc 
distance of 110 feet, a chord bearing of N. 79° 39' 08" E and a chord length of 108.70 feet to the True 
point of Beginning. 

 
Thence Easterly along a curve to the left with a radius of 206.57 feet, an arc distance of 50.3 feet, a 
chord bearing of N. 57° 20' 25" E and a chord length of 50.13 feet; thence Northeasterly along a curve to 
the left with a radius of 2683.29 feet, an arc distance of 100 feet, a chord bearing of N. 49° 23' 04" E 
and a chord length of 99.99 feet; thence South 46°54' 35" East 225.64 feet to the Northerly line of Snow 
Basic Road; thence South 43° 05' 25" west 92.25 feet; thence Southerly along a curve to the left with a 
radius of 164.61 feet, an arc distance of 263.10 feet, a chord bearing of S. 02° 41' 56" E and a chord 
length of 235.98 feet, along said South line to the center of an existing road, thence two courses along 
the center of said road as follows: South 41° 30' 42" West 58.98 feet and South 11° 46' 15" West 211.33 
feet; thence North 86° 17' 37" West 152.24 feet; thence North 0° 17' 53" East 606.33 feet to the place of 
beginning. 

This description has a Point-of-Beginning (Initial Point or POB) at the East Quarter of Section 23, then 4 calls to the True-
Point-of-Beginning (TPOB) followed by 9 calls that close back to the True-Point-of-Beginning.  



LandStar 8 User Manual 205  

Plotted over an orthophoto, this is the complete description: 

  

It is usually best to plot the initial calls leading to the True-Point-of-Beginning as one connected polyline. Then build a 

second polyline, starting at the end of the initial calls; around the closed parcel. At the final course LandStar includes a  
Close button which will add a (hopefully) small segment representing the closure-error needed to complete the polyline 
into a polygon area.  

Because description calls are typically only specified to the nearest arc-second, there will always be a small closure error 
which represents the loss of precision. A closing segment of excessive length is an indication of an entry blunder or a ‘bad’ 
description. 

Summarizing the calls from the description above into a table: 

 

The quadrant bearing shortcut entries see [ Entering Azimuths/Bearings ] on Page 14 and distance entries required for 
curve entry are bolded. 

Starting at an assumed position 10,000, 10,000. Step-by-step instructions for entering this description follow: 
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From the Tools menu, click on Plot deed: 

  

Pick Point 1 by clicking on it: 

  

Enter Course #1: Line S 89:36:25 W (389.3625) 1446.81, 
set the To point as 101: 

  

Click the  Add button, enter Course #2: Line S 06:59:51 E 
(206.5951) 565.86: 
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Click the  Add button, enter Course #3: Line S 04:54:27 
W (304.5427) 66.00: 

  

Click the  Add button, switch to Drawing Arc with Chord 
bearings: 

  

Enter Course #4: Arc: 206.57 110.00 N 57:20:25 E 
(157.2025); use the Curve calculator to compute an arc-
Angle from the given Radius and Arc Length: 

  

Click OK, then: 

  

Click the  Add button, then click the  Stop button to 
end the initial calls at Point 104: 

  

Click on Point 104 then edit its properties, change the 
Description to TPOB: 
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Click Save to accept the change. 

At the bottom of the CAD view, click on  Draw, then  
Layout: 

  

Again, choose to Save Points and lines: 

  

Start entering Course #1 of the parcel boundary: Arc 
206.57 50.30 N 57:20:25 E (157.2025). Choose Arc 

then click on the  Curve Calculator 

  

Enter the Radius 206.57 and the Arc Lenth 50.3: 

  

Click the  Add button, enter Course #2: Arc 2683.29 
100.00 N 49:23:04 E (149.2304): 
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Click the  Add button, enter Course #3: Line S 46:54:35 E 
(246.5435) 225.64: 

  

Click the  Add button, enter Course #4: Line S 43:05:25 
W (343.0525) 92.25: 

  

Click the  Add button, enter Course #5: Arc 164.61 
263.10 S 02:41:56 E (202.4156): 

  

  

Click the  Add button, enter Course #6: Line S 41:30:42 
W (341.3042) 58.98: 
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Click the  Add button, enter Course #7: Line S 11:46:15 
W (311.4615) 211.33: 

  

Click the  Add button, enter Course #8: Line N 86:17:37 
W (486.1737) 152.24: 

  

Click the  Add button, enter Course #9: Line N 00:17:53 E 
(100.1753) 606.33: 

  

Click the  Add button, finally click on the  Close button 
to draw an ‘extra’ line segment from the final Point 209 to 
the initial parcel Point 104. The length of this extra line 
represents the description’s closing error: 

  

With a polyline and point set that fully describes the 
property boundary, it is now possible to perform a Site 
calibration on a few points, or to move, rotate, scale the 
computed description to grid coordinates. 

 

Details: Tools (tab): Transformation 
Translate, rotate, scale points and objects based on a multi-point alignment or manually entered delta-offset, rotation and 
scaling values. 

From the main menu Tools (tab) click on Transformation: 

  >  

Choose the Transformation mode: If a fixed translation distance is known or can be computed as the distance as a vector 
between two points, Manual entry is applicable. If you have several points, perhaps a parcel boundary based at 10,000, 
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10,000 which you would like to align with a few found GNSS points, then Align matching points will probably be better 
suited. 

Align: 

  

Manual: 

  

Align matching points 
Click the Add button, then enter coordinate translation 
pairs with the Source on the top and the Target on the 
bottom. The Target coordinates can be directly measured 

by clicking the  Start measurement button: 
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Clicking OK will return to the Transformation point list, 
clicking OK & Next saves the current pair and readies for 
new pair entry. 

LandStar will compute a best-fit transformation between all 
the transformation pairs. If less than 4-vertical control 
points are enabled, LandStar will use a Vertical Constant 
adjustment method. If more than 4-vertical control points 
are enabled an inclined plane adjustment is utilized. If you 
use an inclined plane, you should try to have point-pairs 
that surround all of the points in use. If you don’t really care 
much about elevation, only leave one vertical point-pair 
selected. 

Large residuals highlighted in red are an indication that the 
pairs are not well matched and an indication of blunder: 

  

However, some applications like fitting a record 80 chain x 
80 chain section to measured section corners; may be 

expected to have higher residuals and be acceptable: 

  

Point pairs can be held for Horizontal and/or Vertical by 

using the  method checkboxes. When transformation 
pair entry is complete, click Next to view the resulting 
transformation: 

  

A reasonable rotation angle, a scale factor that 
approximates the Grid-to-Ground scale factor, and a 
Translate Z equal to the average project elevation are an 
indication of a well-formed transformation. Click Next to 
continue, then choose Library list or Objects from map to 
select points/objects to move. If points have connecting 
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lines to move, choose Select object from map: 

  

Then click Next.  

Highlight the points and objects to transform: 

  

If the selected area has points or objects that you don’t 
want to include, click on them after the selection and they 
will deselect. 

Click OK after selecting an area or points to transform. 
Choose to Overwrite or Save as new points with an optional 
name Prefix: 

  

Click Next: 

  

Once transformed, surveyed type points are converted to 
calculated COGO points. A summary count of transformed 
Points and Lines is shown. Click OK to return to the Tools 
menu. 

 

Manual Entry 
Select Manual entry as the Transformation mode, then 
enter a base point for the Rotation and Scale. Enter the 

Rotation directly or click the  Rotation calculator 
button to Calculate the rotation based on an existing Old 
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azimuth and desired New azimuth to align to: 

  

Click  to align the rotation with two existing or entered 
points: 

  

If the Rotation is manually entered, preserve as much 
angular accuracy as possible to ensure that distant points 
align accurately. 

Click Next to set the Scale value: 

  

Click Next to set the North, East and Elevation deltas, click 

the large  Delta computer to compute the Translate 
deltas from two points: 
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Click   to compute the delta between two existing 
points: 

  

Click Accept when the deltas are correct. 

Click Next to continue, then choose Library list or Objects 
from map to select points/objects to move:  

  

If points have connecting lines to move, choose Select 
object from map: 

  

Then highlight the points and objects to transform. 

Click OK after selecting the area or points to transform. 
Choose to Overwrite or Save as new points with an optional 
name Prefix: 

  

Finally click Next. A summary count of transformed Points 
and Lines is shown: 

  

Click OK to return to the Tools menu. 
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Details: Tools (tab): Area subdivision 
Subdivide an existing closed polygon into two parcels. Supports: parallel by two-points, perpendicular by two-points and 
hinge-point. 

If you are starting with points with no polygon, use the CAD function Draw > Polyline to click through the enclosing 
boundary corner points, then close the polygon with the Close option. 

From the main menu Tools (tab) click on Area subdivision 

  >  

The CAD view will be shown, pan/zoom to view the 
enclosed parcel, then click on the polyline to select the 
polygon: 

  
The enclosed total parcel area will be computed and 
shown. 

Click Next: 

  

Choose the Method: 

Parallel by 2 points: select two points and an adjustable 
trim line will move parallel to the line through the two 
points. 

Perpendicular by 2-points: select two points and an 
adjustable trim line perpendicular to the line through 
the two points will be shown. 

Hinge point: select a single point and then adjust a trim 
line through the point. 
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Then click Next: 

  

The selected parcel will be cut in half (two equal sub 
parcels) constrained by the selected Method. Click inside 
the sub parcel that you would like to specify the size of 
(parcel 2 above), then click Next. 

  

The resulting sub parcel size can be specified by direct 
Value input or Percentage of total Area type. Enter the 
desired value, click on Calculate to display the result. When 
satisfied with the subdivision, click Next. 

The resulting split point will be computed: 

  

It is possible to directly Stakeout the point or Add it to the 
project Point list. 

 

Details: Tools (tab): Calculator 
A simple Calculator for simple computations.  

From the main menu Tools (tab) click on Calculator 

  >  
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Notes: 

  root (not square root) 
 144 √ 2 = 12.0 

  power  
 4 ^ 3 = 64. 

   toggles between Degrees and Radians 

Details: Tools (tab): Ruler 
Displays a ruler that shows centimeters only. 

  >  

  

Notes: 

  Calibrate the Ruler by setting the length of 5 cm. 
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Building GIS Datasets in LandStar 
GIS attributes can be assigned to Codes, and then the Codes are associated with Points at the time of collection. When a 
Point is stored with a Code that has GIS attributes, the user will be prompted to enter values for the GIS attributes. 

After GIS data is collected, a standard Shapefile (.SHP, .SHX, .DBF, .PRJ file set) can be exported for use in other mapping 
products. 

Begin by setting up a Code with associated GIS attributes. 
From the main menu Project > Codes > New: 

  

The Code name is FH with a Drawing type of Point. The text 
Description is Fire Hydrant, which is only used as a prompt, 
it is not included in the data set. A Symbol with a display 
size and Color can also be specified. The Layer is used for 
CAD drawings and DXF output, it typically will match the 
Code Name. 

Measurements that are collected with this Code will be 
grouped into a shapefile named FH_Point.  

Click on GIS Attributes: 

  

then click the  New attributes button: 

  

Set the attribute Name to TagNumber (GIS attributes 
should not have spaces in the names for compatibility with 
external tools.) 

The attribute can have these field Types: 

  

The fire hydrant tags all begin with H-, so we can set the 
Type to Text, and set the Default value to H- to simplify the 
operator’s data entry. 

Enabling Required: 

  

forces the operator to enter a TagNumber before they can 
continue storing the measurement. 

Next enter a Text attribute named Color. We only expect to 
find Red or Yellow fire hydrants, but include an Other just in 
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case. 

  

Also include an integer NumPorts (the number of holes that 
water comes out of) and three attributes to hold the sizes 
of the ports in inches: 

  

Every Code in a Project can have a separate unique Feature 
list. 

Now, when in any Survey function, the operator can select 
the Code FH: 

  

then click the  Start measurement button, wait for the 
measurement to complete: 

  

when the measurement is ready to be stored, the user 
must enter the information associated with the FH Code: 

  

The  From previous button duplicates the 

attributes from the previous point. The  From 
point button allows attribute duplication from an existing 
point with the same code. 

After the operator enters all information, and optionally 
adds Multimedia (Pictures, Videos, Sound recordings) they 
click Save to return to the Survey screen, ready to collect 
the next measurement. 

A shape file set can be Exported from the Project at any 
time.  
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From the main menu > Project > Export menu, select the 
Other format tab: 

  

Set the Format to SHP, choose Coordinate format from: 

  

Adjust the Filters, then click Next: 

  

Navigate to the destination folder for the Shapefile set. 
LandStar will made a new folder named: 
 Projectname_YYYY-MM-DD-HH-MM-SS 

In the new folder: 
 

 

there will be a .SHP, SHX, .PRJ file for each used Code in the 
project. All the points without associated codes will be 
combined into the Empty Code_Point.xxx files. 

In addition to the defined attributes, each file holds extra 
columns. For this example: 
 PT_NAME  Point Name 
 PT_CODE  Point Code 
 PT_REMARK  Point Description 
 PT_LATITUD  Latitude in DD.dddddd 
 PT_LONGITU  Longitude in DDD.dddddd 
 PT_ALTITUD  Ellipsoid Height in meters 
 MEDIA   photo, video, sound three 
comma separated filenames 
 TagNumber  operator assigned fire hydrant 
tag number 
 Color   operator selected color 
 NumPorts  operator entered number of 
ports 
 Port1Size  operator entered port sizes 
 Port2Size 
 Port3Size 
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How to: Install, Update and Provision LandStar 
There are two methods to download the latest version of LandStar: 

1. Install the CHCNav Installation Manager from the Google Play Store. See [ Downloading and Deployment] on Page 
6 for step-by-step instructions. 

2. Directly download the latest version from the iGage website: www.iGage.com 

Direct download from iGage.com 
To directly download the latest iGage verified version, click 
on this link: 
 https://igage.com/out/LandStarDistribution/LatestVers
ion/index.htm 
then download the .apk file in the directory listing. 

You may also open a browser on the Android device and 
navigate to www.iGage.com: 

  

Find the link to Out on the top tool bar and click on it: 

  

Click the link LandStarDistribution: 

  

Click the link LatestVersion: 

  

The .apk file in this folder will be the latest version. Click on 
it. 

The file will begin to download: 

  

After the file downloads: 

  
Click on Open. 

If this message is displayed: 

  

Click on Settings: 

  

Slide the Allow from this source to the right. 

  

Click Install. Then wait while LandStar is installed and 
deployed. 

  

Finally, when the install completes: 

  

Click on Open. Allow all requested permissions: 

  

https://igage.com/out/LandStarDistribution/LatestVersion/index.htm
https://igage.com/out/LandStarDistribution/LatestVersion/index.htm
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Wait while LandStar initializes: 

  

The initial splash screen may take over a minute to 
complete.  

Choose the menu structure: 

  
While the Simple style is simple, it does not match any of 
the descriptions in this User Manual. It might be best to use 
the Classic style while learning to navigate LandStar. Click 
the Do not confirm next time checkbox, then click OK. 

When prompted to download localization package files: 

  

Click on Yes. 

  

Click on the appropriate country. 

  

Confirm the package download, click Yes: 

  
It will take several minutes to download the package. The 
package contains special projection zones, GEOIDS, local 
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settings. 

  

After the download and installation is complete, a  
green checkmark will display next to the package. Click 
Close (at the bottom) to continue. 

  

Click the Projects button,  

  

Click the New button at the bottom to create a new 
project: 

  

Enter a Name for the first project, then click the  
Coordinate system more button: 

  

Click on  Pre defined: 

  

Set Region = United States (or your local), Area = 
NAD83(2011), then drag up / down to find the appropriate 
zone for your project. Additional information on Coordinate 
systems can be found here [ Details: Project (tab) > 
Coordinate system ] on Page 64. 

NOTE: If you are in a special state or county zone, 
click on: 
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then choose a specific special area: 

  

With the correct zone selected: 

  

Click Next.  

Drag over to the right-column Vert. adjustment and select a 
Geoid file: 

  

Change the Coordinate system Name to include a reference 
to the selected Geoid: 

  

Click OK. 
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Click on Project settings > then Units >: 

  

At a minimum, consider setting Azimuth display mode = 
Bearing, Horizontal and Vertical distance = iFeet/USFeet, 
Area unit = Acres, Volume unit = Cubic Yards, and Station = 
K0+00.00. 

Click  Back, then spend a few minutes looking through 
the Decimals settings and GNSS settings. Additional 
information on Settings can be found here [ Software 
settings ] on Page 28. Configure as you would like the new 

job defaults to be, then click on:  Save as 
default so future jobs will share these settings. 

Finally, click  Back, then OK. A new project is available to 
work on. 

Activate LandStar using the licensing instructions found 
here [ LandStar 8 Licensing ] on Page 7. 

 

How to: Moving data to the data collector 
The easiest way to move data to the Android data collector may be to email it to the account associated with the device. 

In this example, we have a comma separated value text file SectionExterior.csv: 

  

  
which has been sent to the Android device as a file attachment.  
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Open the email in the Android device’s mail client: 

  

Click on the  Download button to download the file into 
the Download folder on the Android device. When the file 
has been received there may be a completion notice: 

  

In LandStar, on the Main menu Project (tab), click on 
Points: 

  >  

The current Points list will be shown: 

  

Click on the  Import button at the bottom: 

  

Click on OK: 

Use the File selector to move to the Download folder, 
located under Internal storage: 

  

Highlight the SectionExterior.csv file, then click Open, the 
import result will be shown: 
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Click OK, the imported points will be available in the Point 
list as INPUT type points: 

  

 

How to: GNSS Network Rover Internal Cell Modem 
Step-by-step i93 Visual RTK receiver configuration as Network Rover using the GNSS receiver’s internal Cell Modem, with a 
Wi-Fi connection from the Android device to the receiver. 

The GNSS receiver connects directly to the cellular network and brokers corrections from the CORS server directly. Results 
are then passed to the data collector via Wi-Fi. The internet connection of the receiver may optionally be shared with the 
data collector. 

Internal Cell Modem Method 

=> =>    => <=Wi-Fi=>   
CORS receiver    Server in Cloud        Cell Tower               GNSS receiver                        Android PDA 

Insert SIM card 

Turn off the receiver. 

Insert a cellular SIM card in the receiver: 

  
Use a nano-SIM, gold contacts down, diagonal slot inserts first on left. 

Turn the receiver ON. Wait for the receiver to fully boot. 
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From the Main menu, click on the Config (tab) then 
Insturment profile: 

  >  

The existing, possibly empty, list of Instrument profiles will 
be shown: 

  
Click on New to create a new profile: 

  
Click on GNSS Rover: 

Configure the receiver: 

  

Enter a unique profile Name. Select the Brand, Type and 
Model. Antenna type will automatically fill to the correct 
antenna based on the Model. 

If the receiver is a Visual receiver, choose Connection type 
= Wi-Fi otherwise Bluetooth may be used. 

If the Android device is not currently connected to the 
GNSS, click on the Target Wi-Fi device: 

  
When the i93 device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect. 

If the receiver is not listed or has been ON for more 
than 10-minutes without a Wi-Fi connection, click the 
receiver’s left button twice to turn the receiver Wi-Fi 
back on. 

After a few seconds, the PDA will connect to the head: 
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then: 

  

Don’t worry if a message noting that there is no internet 
connection is displayed: 

  

Do not tap the ‘Tap for options’, let this Android warning 
box expire automatically. 

Click the  Back button to return to LandStar from the 
Internet menu. The Target should now be the Rover 
receiver: 

  
Click Next: 

The device type dialog is shown: 

  
Select NTRIP, then click Next: 

If the CORS server is a TCP server (also known as 
TCPIP, DIP: Direct Internet Protocol, or Point-to-
Point) use the TCP service profile. See [ TCP ] on 
Page 173 for additional information. 

Configure the Network settings: 

  

Set the Network = Receiver network to use the cellular 
modem in the i93 receiver. 

Enter the Domain/IP for the network, either a domain 
name or a dotted IPV4 address can be entered.  

Set the NTRIP Port (usually 2101.) 
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Click  APN to set the Access Point name and SIM card 
connection values.: 

  

Set the Access point name. The SIM card provider will 
supply you with this value. Some common values may be: 
 ATT     Broadband 
 Verizon    VZWINTERNET 
 T-Mobile   fast.t-mobile.com 
 Data Activation Center dac.com.attz 
 US Cellular   internet 
 Union Wireless  SMART.COM 

Dial number = *99# is correct for most markets. SIM card 

Username and Password are typically left blank. 

In the USA, if the APN is changed, the Cell modem power 
must be cycled OFF then back ON to reset the local tower. 
Enable the Cycle power… option, then click on Set.  

  

Wait 40 seconds for the Cell modem to restart, LandStar 
will countdown to zero and return to the Data link 
parameter settings: 

  

Click on  Get Mountpoint to download the 
mount table from the configured server. 

Wait (it should take 2 to 15 seconds) for the mount table to 
be downloaded: 

  

The mount table will be displayed: 

  

Select the desired mountpoint (typically a VRS RTCM32 or 
RTCM33 mountpoint will be best). 
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Enter the Username and Password for the NTRIP server: 

  

Retransmit correction data will transmit the network 
corrections to the internal UHF radio, Wi-Fi, Bluetooth or 
via the Serial port. Retransmit is typically disabled. 
Additional information on Retransmit can be found in the 
next section [ Retransmit correction data ] below on Page 
233. 

Click Next: 

  

Click Save & Accept to save this new profile and configure 
the receiver. After a moment, the receiver will be 
configured. 

  

If the network Username and Password are valid then: 

  
will be shown. Click No to return to the main menu.  

See [ Status ] on Page 95 for additional information on the 
Status bar. 

This Instrument profile can be selected in the future by 
clicking the Instrument select button: 

  

Then selecting the desired profile from the GNSS Rover list: 

  

And clicking the Accept button. 

 

Retransmit correction data 
When a Rover uses a NTRIP or TCPIP network correction source, it is possible to retransmit the correction stream from the 
Rover to other nearby Rovers which effectively shares a network subscription. 
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Many CORS network server agreements specifically prohibit sharing; however, it can be a simple method to utilize a 
receiver as a network repeater on top of a hill where there is good cell reception, then push corrections down into a valley 
to a working Rover via a UHF link. 

Be sure to connect a UHF antenna to the receiver so the radio range will be maximized. 

 

To retransmit via the internal UHF radio in the Rover, enable Retransmit correction data: 

  

Set the To = Radio, choose a Protocol, radio Channel bandwidth, over-the-air Baud rate and the frequency Channel to use. 
Click Save & Accept to connect the Rover to the network and begin retransmitting. 

How To: GNSS Network Rover PDA Modem 
Step-by-step instructions for configuring the i93 Visual RTK receiver configuration as a Network Rover using the data 
connection of the PDA (the Android data collector.)  

Because the Wi-Fi connection of the Data Collector will be used to connect to Visual receivers (like the i89 and i93) to 
utilize the highspeed cameras, the data collector needs to have a cellular connection.  

This method is also known as DCI (Data Collector Internet). 

The data collector connects directly to the cellular network and brokers corrections from the CORS server sending them via 
Bluetooth or Wi-Fi to the GNSS receiver.  

PDA (DCI) Modem Method 

=> =>    <=>   <= Wi-Fi=>  
CORS receiver      Server in Cloud         Cell Tower        PDA / Cell Phone                  GNSS Receiver 

 

Turn the receiver ON. Wait for the receiver to fully boot. 
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From the Main menu, click on the Config (tab) then 
Instrument profile: 

  >  

The existing, possibly empty, list of Instrument profiles will 
be shown: 

  
Click on New to create a new profile: 

  
Click on GNSS Rover: 

Configure the device connection: 

  

Enter a unique profile Name. Select the Brand, Type and 
Model. Antenna type will automatically fill to the correct 
antenna based on the Model. 

If the receiver is a Visual receiver, choose Connection type 
= Wi-Fi otherwise Bluetooth may be used. 

If the Android device is not currently connected to the 
GNSS receiver, click on the Target Wi-Fi device: 

  
When the device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect.  

If the receiver is not listed or has been ON for more 
than 10-minutes without a Wi-Fi connection, click the 
receiver’s left button twice to turn the receiver Wi-Fi 
back on. 

After a few seconds, the PDA will connect to the head: 
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then: 

  

Don’t worry if a message noting that there is no internet 
connection is displayed: 

  

Do not tap the ‘Tap for options’, let this Android warning 
box expire automatically. 

Click the  Back button to return to LandStar from the OS 
Internet menu: 

  
Click Next: 

The correction type selection will be shown: 

  
Select NTRIP, then click Next: 
 

If the CORS server is a TCP server (also known as 
TCPIP, DIP: Direct Internet Protocol, or Point-to-
Point) use the TCP service profile. See [ TCP ] on 
Page 173 for additional information. 

 

  

Set the Network = PDA network to use the cellular 
connection of the Android device. 

Enter the Domain/IP for the network, either a domain 
name or a dotted IPV4 address can be entered.  

Set the NTRIP Port (usually 2101.) 
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Click on  Get Mountpoint to download the 
mount table from the network server. 

It should take 2 to 15 seconds for the mount table to be 
downloaded from the network server: 

  

The mount table will be displayed: 

  

Select the desired mountpoint (typically a VRS RTCM32 or 
RTCM33 mountpoint will be best). 

Enter the Username and Password for the NTRIP server: 

  
Click Next: 

Configure the advanced Rover settings: 

  

Click Save & Accept to save this new profile and configure 
the receiver. After a moment, the receiver will be 
configured. 

  

If the network Username and Password are valid then: 

  
will be shown.  

Click No to return to the main menu.  

See [ Status ] on Page 95 for additional information on the 
Status bar. 

This Instrument profile can be selected in the future by 
clicking the Instrument select button: 

  

Then selecting the desired profile from the GNSS Rover list: 

  

And clicking the Accept button. 
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How to: GNSS Internal UHF Base 
Step-by-step RTK receiver configuration as a UHF Base using the internal UHF radio and a Bluetooth connection to the 
receiver from the Android device. 

Because the base does not utilize any Visual features, a high-speed Wi-Fi connection is not necessary, the Bluetooth 
connection may be utilized. 

 

In the USA an FCC license is required for UHF Base mode. 

 

Be sure to connect a UHF antenna to the receiver prior to operating as a base. 

 

 

Configure a reusable Instrument profile for the Base 

UHF Base profiles allow a Base receiver to transmit corrections to one or more Rover receivers via UHF radios.  

Setup the Base on a stable tripod, attach external power if longer term operation is expected. Turn on the receiver. 

From the Main menu, click on the Config (tab) then 
Instrument profile: 

  >  

The existing, possibly empty, list of Instrument profiles will 
be shown: 

  
Click on New to create a new instrument profile: 

  
Click on GNSS base: 

  
Match the Brand, Type and Model to your receiver. For the 
i93: Brand = CHC, Type = RTK, Model = i93. The Antenna 
type should automatically match the correct antenna for 
integrated receivers. 

Since a Base won’t need high speed data transfer for 
camera images, a Bluetooth connection will be fine. Set 
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Connection type = Bluetooth. If the receiver is not available 

in the Target list, click  Search to find nearby 
devices.  

When the correct receiver with Bluetooth name = GNSS-

serialnumber is listed, select it  then click Next: 

Select Internal Radio: 

  
then click Next. 

The Base settings dialog will be shown: 

  

If all the Rover receivers on the job will be recent CHC 
receivers (currently i83, i89, i93, iBase) that support the 
CHC516 format, select Differential format = CHC516; 
otherwise select Differential format = RTCM3.2: 
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Typically, Protocol = SATEL_3AS, Channel bandwidth = 12.5 
KHz, Baud = 9600 and FEC = OFF is best for operation in the 
US. 

Set the Transmitting power = 1 W for small sites, 2 W or 5 
W (if available on your receiver) will provide better radio 
coverage for large sites. 

The Channel setting selects the Frequency. 

The FCC Call Sign must be broadcast every 15 minutes for 
legal operation in the US: 

  

Since we are making a general profile, set Start at known 
position = Enabled. If the profile is used at an unknown 
location, the GNSS Measurement button can be used to 
read the current GPS position if needed. If you would like to 
always use an autonomous position, set Start at known 
position = Disabled. 

Always set Start logging = Enabled for Base setups, the 
observation files can be submitted to OPUS to obtain or 
verify the true Base position. Set Data format = HCN and/or 
RINEX = RINEX3.0x to generate suitable files for NGS OPUS. 
Interval = 1 Hz is best for processing UAV data against. 
Logging duration = 1440 minutes (24 Hours) is reasonable. 
Setting the Station name = device_serianumber or a short 
Point name helps identify Base and Rover data. 

The default Antenna height is best entered as the Vertical 
height from the Ground Mark (GM) to the bottom of the 
receiver threads. Slant heights can be confusing as there is 
a possibility of multiple Slant Height Measurement Points 
(SHMP): 

 Measurement line on Receiver Band. 

 Top or Bottom of Receiver Band. 

 Tape hook on offset plate attached under the Receiver. 

When all the settings are correct, click on Save & Accept. 
The Base Start dialog will be shown: 

  

Set Add the point to the Point list to Enabled if the receiver 
will be read or the location will be snapped from the CAD 
drawing. 

If you know the Base location coordinates, you can enter 
them directly in Northing, Easting, Orthometric Elevation or 
Latitude, Longitude, Ellipsoid Height format. See [ Entering / 
Viewing Geographic and Projected Coordinates ] on Page 
15 for information on coordinate entry and reference 
frames. 

If the Base location is available in the Point list, click  to 
recall the point coordinates. Be sure to read the section [ 
Start from Point list or Previous position ] on Page 241 for 
important information on using Base positions in the 
Project Point list. 

If the Base location is available in the CAD layers, click  
to snap the Base position point from the CAD drawing. 

To read the current GNSS receiver position (read GPS) click 

 Measure GNSS to use the current autonomous GPS 
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position: 

  

Make sure the Antenna height is correct. Then click on 
Start. A receiver not fixed warning may be shown: 

  

Click Continue.  

A warning about the Hrms / Vrms may be displayed: 

  

Click Continue. The measurement results will be entered. 

When the coordinates are correct, click OK: 

  

After the Base is configured, the Instrument profile list will 
be shown with the new profile: 

  

This Instrument profile can be selected in the future by 
clicking the Instrument select button: 

  

Then selecting the desired profile from the GNSS Base list: 

  

When the Android data collector is connected to a Base 
receiver, this message: 

  

will be displayed to warn you that you are NOT connected 
to a Rover and you should not use the current connection 
to store coordinates. 

After 10-seconds, the corrections TxRx LED: 

  
should begin to blink amber once each second. 

 

Start from Point list or Previous position 
 

Click on the  Point list button to retrieve a position from 
the Point list. By default, previous base positions will not be 
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available in the list: 

  

Click on the  3-Dot button (upper-right corner): 

  

Click on Show GNSS base points. Every previously used Base 
point, including CORS network bases will now be shown in 
the list: 

  

Select the previous Base position, or a previously surveyed 
or computed point, then click on OK. 

If the entered position is significantly offset (more than 100 
meters or 328 feet) from the receiver’s actual position, an 
error message will be displayed: 

  

It is not possible to continue with the base setup with a bad 
position. Receivers are unable to numerically generate 
corrections if the position is wrong. 

This is a common error that occurs when: 

Design coordinates are in a different projection than 
the LandStar project coordinate system. 

Design coordinates are at a 0 elevation, as shown 
above. 

The wrong point is chosen from the Point list as a 
known starting coordinate. 

A negative longitude is entered as a positive longitude. 

Easting and Northing are exchanged when hand-
entering a projected position. 

If you want to start the base with a position that does not 

closely match the actual position, use the  Measure 
button to start the base with an autonomous GPS position. 
Then use the Project: Single point localization to perform a 
Site calibration and make the receiver match the desired 
coordinates. More details can be found here [ Details: 
Project (tab) > Singe point localization ] on Page 68. 

If the Base position is acceptable, LandStar will set up the 
Base and correction broadcast will begin. 

After 10-seconds, the corrections TxRx LED: 

  
should begin to blink amber once each second as 
corrections are sent to the radio. 

 

How to: GNSS Internal UHF Rover 
Step-by-step i93 Visual RTK receiver configuration as UHF Rover using the internal UHF radio. The highspeed Wi-Fi 
connection between the receiver and the Android data collector is used so that Visual survey functions are avialable. 
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Be sure to connect a UHF antenna to the receiver so the radio range will be maximized. 

 
 

From the Main menu, click on the Config (tab) then 
Instrument profile: 

  >  

The existing, possibly empty, list of Instrument profiles will 
be shown: 

  
Click on New to create a new instrument profile: 

  
Click on GNSS Rover. 

  
Set the Brand = CHC, Type = RTK, Model = i93. If you are 
going to use the Visual stakeout or Visual survey 
functionality of the i93, you must set the Connection type = 
Wi-Fi.  

Antenna type should automatically fill to the correct 
antenna based on the Model. 

The current Wi-Fi connection of the PDA (the Android data 
collector) will be shown as the Target. Click the current 
connection (IGAGE above) to view the Android device’s 
Internet connection menu: 

  
When the i93 device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect.  

If the receiver is not in the list or the receiver has been 
ON for more than 10-minutes without a Wi-Fi 
connection, click the receiver’s left button twice to 
turn the Wi-Fi back on. (Most CHC receivers disable the 
Wi-Fi to save power after 10-minutes of non-use.) 
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After a few seconds, the Android device will connect to the 
receover: 

  
then: 

  
Don’t worry if a message noting that there is no internet 
connection is displayed: 

  

Do not tap the ‘Tap for options’, let this Android warning 
box expire automatically. 

Click the  Back button to return back to LandStar from 
the Internet menu. 

Note that the Target Wi-Fi connection is now the GNSS 
receiver: 

  
Click Next: 

  
Select Radio, then click Next. 

Configure the receiver radio parameters: 

  

Set the radio Protocol, Channel bandwidth, Baud, 
Frequency and FEC to exactly match the Base receiver 
settings.  

The message type is automatically determined and 
matched by the receiver.  

Set the Sensitivity = High which will maximize the radio 
range on some devices. 

As the Rover will be receiving corrections, not transmitting, 
disable the FCC Call Sign. 

Leave Retransmit correction data = Disabled. 

Click Next. 
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Additional Rover parameters: 

  

Set the Elevation mask to a reasonable value, usually 
between 5 and 15 degrees. Set the Position output 
frequency to the desired display update rate.  

Click Save & Accept: 

Wait while the receiver is configured: 

  

It will take a few moments to configure the device.  

Once corrections are being received, LandStar may note: 

  

The TxRx LED: 

  
should blink once each second if corrections are received. If 
the receiver is FIXED, the LED will blink green; if the receiver 
is not fixed, the LED will blink amber. 

 

 


